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Legal Notices

Warranty
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

http://h20230.www2.hp.com/selfsolve/manuals
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Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Welcome to This Guide

Welcome to the HP Performance Center Administrator’s Guide. This guide 
describes how to use the Performance Center Administration Site to monitor 
and supervise load testing by multiple users.

Performance Center is HP’s Web-enabled global load testing tool, which is 
specially designed to streamline the testing process and increase the test 
efficiency for multiple concurrent load tests across multiple geographic 
locations.

Performance Center consists of two modules:

➤ User Site. Used for conducting and monitoring load tests.

➤ Administration Site. Used for overall resource management, technical 
supervision, and for managing user and project access rights throughout 
Performance Center.

This guide covers the Administration Site. For information about the User 
Site, see the HP Performance Center User’s Guide.

This chapter includes:

 ➤  How This Guide Is Organized on page 12

 ➤  Who Should Read This Guide on page 13

 ➤  Performance Center Online Documentation on page 13

 ➤  Additional Online Resources on page 14
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How This Guide Is Organized

This guide contains the following parts:

 Part I Introduction

Introduces you to the Performance Center Administration site.

 Part II Performance Center Resources

Includes information about managing the Performance Center system user 
and other Performance Center resources, including host machines and 
servers.

 Part III Site Management

Includes information about managing test runs, timeslot reservations, and 
events.

 Part IV System Configuration

Describes the System Configuration pages of the Performance Center 
Administration Site, where you configure and view license key information, 
general settings, HP Diagnostics, server configuration information, server 
authentication, and email alerts.

 Part V Performance Center Reports

Describes how to work with Performance Center reports to get an overall 
analysis of Performance Center site users, system resource usage, load test 
runs, and autostart load tests.

 Part VI User and Project Management

Describes the User Management module, which is used for managing user 
information, user roles and privileges, project information, and 
project-user-role assignments.
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 Part VII Troubleshooting

Provides troubleshooting tips and information for Performance Center 
problems

 Part VIII Appendixes

Includes instructions for configuring the Performance Center system user 
manually, as well as Performance Center troubleshooting information.

Who Should Read This Guide

This guide is for the following users of Performance Center:

➤ Performance Engineers

➤ Performance Center Administrator

This document assumes that you are moderately knowledgeable about 
enterprise application development and highly skilled in enterprise system 
and database administration.

Performance Center Online Documentation

HP Performance Center includes the following online documentation:

Readme provides last-minute news and information about Performance 
Center. You access the Readme from the Start menu.

What’s New gives a brief description of the new features in this release of 
Performance Center, including links to video walkthroughs. Select 
Miscellaneous > What’s New in the User site.

Books Online/Printer-Friendly Documentation includes printable versions 
(PDF) of the Performance Center guides. Select Start > Programs > HP 
Performance Center > Documentation and select the relevant book.

HP Performance Center Online Help is available by clicking the Help button 
at the top of the Performance Center site page or in a dialog box.
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Additional Online Resources

Troubleshooting and Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. The URL for this Web site is http://h20230.www2.hp.com/
troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. The URL for this Web site is 
www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. The URL for this Web site is www.hp.com/go/software.

http://h20230.www2.hp.com/troubleshooting.jsp
http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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1
Introducing the Administration Site

The Performance Center Administration site is the Web site for 
administrating load tests. 

The customer defines, runs, and analyzes load tests from the Performance 
Center User Site. For details, see the HP Performance Center User’s Guide. 

For details on installing the User site and Administration site, see the HP 
Performance Center System Configuration and Installation Guide. 

For details on setting up and configuring HP Diagnostics, see the HP 
Diagnostics Installation and Configuration Guide.

This chapter includes:

 ➤  About the Administration Site on page 17

 ➤  Logging On and Off on page 18

 ➤  Moving Around the Site on page 21

 ➤  Refreshing the Page on page 24

About the Administration Site

The Performance Center Administration site is used for administering the 
Performance Center system and managing load test resources. The 
administrator performs functions such as assigning user roles and privileges, 
creating and administering projects, and managing resource usage.

From the Administration site, you can:

➤ Manage Performance Center servers, monitor the server status, edit server 
information, and check server performance
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➤ Manage Performance Center hosts, controlling how hosts are allocated to 
test runs

➤ Manage timeslots, view user reservations, and monitor availability of time 
and resources

➤ Manage test runs, view all the tests in the system, and see which ones are 
running at any time

➤ Manage any events that occur during test runs

➤ Manage your license information

➤ Manage user requests

➤ Manage general system configuration information

➤ View and supply specific System Configuration information

➤ Analyze Performance Center reports

➤ Manage users and user privileges

Logging On and Off

You log on to the Administration site from the URL of the directory on 
which you installed Performance Center.

Important: If this is the first time you are logging on to the system, you need 
to perform some initial system configuration. In this case, the Performance 
Center system user must have administrative privileges.

To log on to the Administration site:

 1  In your Web browser, enter the following URL:

where server_name is the name or IP address of the HP Performance Center 
Administration Site server.

http://<server_name>/admin 
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 2 If this is the first time you are entering the system, you are redirected to the 
System Configuration page to provide database and file server information.

 a In the Database area, enter the following details about your database:

➤ DB host. The machine on which the database resides.

If the Performance Center database is an MS-SQL database with a 
non-default instance name, enter the DB host name in one of the 
following ways: 

or  

➤ DB type. The type of database installed on the server—either 
SQLServer or Oracle.

➤ DB instance (Oracle only). If you are using Oracle, in the DB instance 
box that opens, enter the service name defined in your tnsnames.ora 
file.

➤ OS (Oracle only). If you are using Oracle, select the operating system.

➤ User. The user name to connect to the database.

<server name>, <instance port>

<server name>\<instance name>
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➤ Password. The password to connect to the database.

 b In the File Server area, in the Name box, enter the name of the machine 
that contains the File Server installation where system files such as scripts 
are stored. 

 c After you supply the necessary information, click Save.

Note: If Performance Center detects an existing database, a message is 
displayed asking you if you want to use the existing database as part of your 
configuration. For information about configuring your system when 
upgrading from an earlier version of Performance Center, refer to the 
section about upgrading Performance Center in the HP Performance Center 
System Configuration and Installation Guide.

A log listing details of the system configuration process is displayed in the 
lower-left corner of the page. 

If the configuration is successful, click the Log to Site button. The 
Performance Center Administration Site Login page opens. 

If the configuration is not successful, the log provides a detailed message to 
help you correct the problem. After correcting the problem, repeat the save 
process.

 3 Log on to the Administration Site with a user that has Performance Center 
administration privileges. 

If this is the first time you are logging on to Performance Center, use the 
default user name Admin and the default password Admin. After you have 
logged on, you will be able to modify your user name and password for the 
future.

 4 Click Login. The Administration Site opens.
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Note: If this is the first time you are logging on to the system, you are 
redirected to the Server Configuration page and asked for additional details 
to complete your system configuration. For more details, see “Viewing and 
Editing Server Configuration Information” on page 167.

To log off:

Click the Logout button in the upper-right corner of the Administration site 
window.

Moving Around the Site

To move to a page, click the page name in the left navigation menu. The 
available pages are:

Resources

➤ Hosts. Displays the allocation and availability of Performance Center 
host machines. You can add and remove hosts from the system, define 
each host’s testing function, prioritize host allocation, and monitor host 
state. For details, see Chapter 2, “Managing Hosts.”

➤ MI Listeners. Displays an editable list of MI Listeners that enable you to 
run Vusers over a firewall. For details, see Chapter 3, “Managing MI 
Listeners.”

➤ Host Locations. Displays an editable list of host locations and whether 
they are within or over the firewall. For details, see “Managing Host 
Locations” on page 67.

➤ Host Pools. Displays groups of hosts that you defined in order to control 
which hosts may be accessed by which projects. For details, see 
Chapter 4, “Managing Host Pools.”

➤ Servers. Displays information about the Performance Center server 
machines. You can monitor server status, edit server information, and 
check server performance. For details, see Chapter 5, “Managing Servers.”
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Site Management

➤ Test Runs. Displays the state of test runs. For details, see Chapter 7, 
“Managing Test Runs.”

➤ Timeslots. Displays timeslot reservations and availability. For details, see 
Chapter 8, “Managing Timeslots.”

➤ Event Log. Displays reported events and errors. For details, see 
Chapter 10, “Managing Events.”

System Configuration

➤ License. Displays license information. For details, see Chapter 12, 
“Configuring and Viewing License Information.”

➤ General Settings. Displays general system configuration information. For 
details, see Chapter 13, “Configuring General Settings.”

➤ Diagnostics. Displays a list of mediator machines upon which you can 
run ERP/CRM Diagnostics and information about the J2EE/.NET 
Diagnostics server environment. You can add additional mediators or 
configure the J2EE/.NET Diagnostics server environment from this page. 
For details, see Chapter 15, “Configuring Diagnostics.”

➤ Server Configuration. Displays where key components of Performance 
Center are located. For details, see Chapter 14, “Configuring Server 
Information.”

➤ Authentication Server. Displays the authentication configuration details 
for logging on to Performance Center. For details, see Chapter 16, 
“Configuring Server Authentication.”

➤ Alerts Configuration. Displays the alert conditions and email preferences. 
For details, see Chapter 17, “Configuring Alerts.”
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Reports

➤ Site Users. Displays individual user information.

➤ Resource Usage. Displays system resource usage information.

➤ Test Run Information. Displays general information about the test run.

➤ Autostart Viewer. Displays information about autostart load tests.

For details, see Chapter 18, “Understanding Performance Center Reports.”

User Management

➤ Personal Information. Displays the personal information of the currently 
logged on user. For details, see “Managing Your Personal Information” on 
page 239.

➤ Users. Displays a list of users and user information. For details, see 
“Managing User Information” on page 240.

➤ Roles. Displays a list of user roles and the permissions included in each 
role. For details, see Chapter 26, “Defining User Roles.”

➤ Privilege Management. Displays a list of Performance Center containers 
and user-role assignments in these containers. For details, see 
Chapter 27, “Managing User Privileges.”

➤ Projects. Displays a list of Performance Center projects and project 
information. For details, see Chapter 28, “Managing Performance Center 
Projects.”
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Refreshing the Page

You can refresh and alter the auto-refresh frequency for the Resources and 
Site Management pages in the Administration Site.

To refresh the page:

➤ Click the Refresh Now button in the upper-right corner of the page. The 
information on the page is updated.

To modify the default refresh rate: 

 1 Click the Refresh Frequency button in the upper-right corner of the page. 
The Refresh Frequency dialog box opens.

 2 Select an auto-refresh frequency from the list and click OK. By default, the 
page is refreshed every 90 seconds.

To close the Refresh Frequency dialog box without altering the refresh rate, 
click Close.
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2
Managing Hosts

Host machines are used for test runs. Managing the host machines involves 
adding and removing hosts from the system, defining each host’s testing 
function, prioritizing host allocation, monitoring host conditions, and 
identifying the host location.

This chapter includes:

 ➤  About Managing Performance Center Hosts on page 28

 ➤  Understanding the Hosts Page on page 28

 ➤  Adding Hosts on page 35

 ➤  Editing Host Details on page 44

 ➤  Managing Host Details on page 45

 ➤  Editing Over Firewall Agent Configuration Settings on page 54

 ➤  Rebooting Hosts on page 58

 ➤  Uploading and Installing Patches on page 59

 ➤  Understanding Host Allocation on page 63

 ➤  Handling Resource Failure on page 64

 ➤  Checking Hosts on page 65

 ➤  Managing Host Locations on page 67

 ➤  Removing Hosts on page 69

 ➤  Using Hosts to Run Vusers over a Firewall on page 69
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About Managing Performance Center Hosts

The Administrator manages the information stored in the system about the 
hosts. Performance Center uses the information to allocate hosts to load test 
runs. This involves defining the purpose of each host, controlling which 
projects can use which hosts, prioritizing the use of certain hosts over 
others, monitoring host performance, checking the condition of the hosts, 
and following up on any operation problems.

Performance Center gives a user the ability to create a load test from the 
User site. When you design a load test, you specify how many hosts it 
requires and reserve the necessary number of hosts for a specific time 
period. 

Since the availability of hosts is limited, Performance Center allocates 
specific time periods called timeslots. Reserving a timeslot, actually reserves 
the required hosts for the specified timeslot. When the user tries to reserve a 
timeslot, Performance Center allocates hosts according to parameters that 
you control from the Hosts page in the Administration site.

Understanding the Hosts Page

The Hosts page displays information about the host machines in the 
Performance Center system, and enables you to reboot hosts, modify host 
details, install patches, add and delete hosts, and check host connectivity. 

To access the Hosts page:

➤ On the Performance Center left menu, select Resources > Hosts. The Hosts 
page opens.

The Hosts page is comprised of the following areas:

➤ Filter area. Enables you to set the number of hosts displayed, and filter 
the Hosts table according to pool, location, name, and run status criteria. 
For more information, see “Filter Area” on page 29.

➤ Hosts table. Displays information about the hosts in the Performance 
Center system, and enables you to perform actions on the hosts. For 
more information, see “Hosts Table” on page 30.
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➤ Details for Host area. Displays more details about the hosts and enables 
you to edit host details. For more information, see “Editing Host Details” 
on page 44.

Filter Area
The Filter area of the Hosts page enables you to customize the host 
information displayed. You can set the number of hosts displayed on the 
page, and filter the host display.

Setting the Number of Hosts Displayed

You can set the number of hosts that are displayed on the page. You can 
choose to display 10, 20, 50, 100, or all hosts on a page.

To set the number of hosts displayed:

 1 In the Filter by section, in the Per Page list, select the number of hosts to 
display per page.

 2 Click Filter. The display updates according to the option you choose.

Filtering the Hosts Display

You can use the filter lists to display a specified subset of the hosts, 
according to pool, location, name, and run status criteria.

To filter the display:

 1 From one or more of the filter lists, select the desired filtering options. 

➤ In the Pool list, pool names that are marked with an asterisk (*) are 
merged pools. For more information about merged pools, see “Assigning 
Merged Pools to Projects” on page 80.

➤ The Run Status options are:

➤ All Statuses. Displays all hosts regardless of status.

➤ Idle. Displays hosts in the following states: Finished, Run Failure, Failed 
Collating Results, Failed Creating Analysis Data, Deleting Temporary 
Results, Temporary Results Deleted. A short time after the run, it also 
displays hosts in the Collating Results, Creating Analysis Data, Before 
Collating Results, and Before Creating Analysis Data state.
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➤ Run. Displays hosts in the following states: Ready, Running, Stopping. 
Immediately after the run, it also displays hosts in the Collating 
Results, Creating Analysis Data, Before Collating Results, and Before 
Creating Analysis Data state. 

 2 Click Filter. The display updates according to the options you choose.

Note: Filter settings are saved per user. The next time the same user enters 
the Hosts page, the page displays results based on the most recent filter.

Hosts Table
The Hosts table displays the host details. You can sort the table by any of the 
columns. For instructions on sorting the table, see “Sorting the Hosts Table” 
on page 33.

The Host table displays the following information about the hosts:

➤ Status light. An indicator of the current system performance of the host, 
represented by a color. For more details about the host status indicator, see 
“Understanding Host Status” on page 33.

➤ Name. The host name that you assign when you add a new host. You can 
click the name to open the Host Details page for the host. For details, see 
“Managing Host Details” on page 45.

➤ Purpose. The function the host performs in a test run. You define a host as a 
Controller, Load Generator, Controller + Load Generator, or Data Processor. 
The purpose of the machine is indicated by a series of icons, as described in 
the following table.

Icon Purpose Description

Controller The Controller host manages the load test. Each 
test requires one host as a Controller. 

Load Generator Load generator hosts run the Vusers in a load test. 
There can be any number of load generators in a 
given test. 
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➤ Pool. The host pool to which the host is assigned. Host pools allow you to 
control which hosts are allocated to which projects. When allocating hosts 
for a test, the system allocates hosts with the pool specified for the project in 
the project profile. For more information about host pools, see Chapter 4, 
“Managing Host Pools.”

➤ Location. Location of the host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

➤ State. The state of the host. An indicator is displayed next to the host name, 
according to its current state. For more details about the host status 
indicator, see “Understanding Host Status” on page 33.

➤ Run Name. The name of the load test that is currently running on the host.

Controller + 
Load Generator 

Enables you to use the host as a Controller and a 
load generator. You can use the Controller as a 
load generator, and assign Vusers to run on the 
Controller. In general, this is not recommended 
practice and is only appropriate for load tests that 
have a very small number of Vusers.

Data Processor The data processor is used for publishing 
information to the Dashboard. Although it is 
possible to configure a machine as a Controller 
and a data processor, it is not recommended.

Over Firewall Used alongside the load generator icon to indicate 
that the load generator is located over a firewall. 

 SSL Used alongside the load generator icon to indicate 
that the load generator uses SSL to communicate 
with the Controller during run time. 

Icon Purpose Description
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➤ Run Status. The status of the load test that is currently running on the host. 
This field applies only to hosts that are in the Running state. Click the 
Running link to display information for the current run. The Last Run 
Information page contains data only if there is an active run.

➤ Run Time. The start time of the load test that is currently running on the 
host.

➤ Project. The name of the project that is currently running in the load test on 
the host.

➤ User. The name of the user that is currently running the load test on the 
host.

Below the Hosts table, you can perform the following actions:

➤ Reboot. Enables you to remotely reboot host machines from the 
Administration site. For more information, see “Rebooting Hosts” on 
page 58.

➤ Install Patch. Enables you to remotely install patches on hosts. For more 
information, see “Uploading and Installing Patches” on page 59.

➤ Check Hosts. Enables you to check the connections between various host 
machines within your system. For more information, see “Checking Hosts” 
on page 65.
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➤ Delete. Enables you to remove hosts from the Hosts list. For more 
information, see “Removing Hosts” on page 69.

➤ Add Host. Enables you to add hosts to the Hosts list. For more information, 
see “Adding Hosts” on page 35.

To perform actions on all the Performance Center hosts, select all hosts by 
selecting the check box at the top of the check box column. To clear all 
check boxes at once, clear the check box at the top of the check box 
column.

Sorting the Hosts Table

You can sort the hosts according to the values in any column.

To sort the hosts:

Click the column heading of your choice. A downward facing arrow is 
displayed next to the column heading. The hosts are sorted in descending 
order of the values in that column.

When you click the heading again, the arrow reverses direction, and the 
hosts are sorted in ascending order of the values in that column.

Note: Sorting settings are saved per user. The next time the same user enters 
the Hosts page, the page displays the results based on the most recent sort 
order.

Understanding Host Status
Host status is an indicator of the current system performance of the host, 
represented by a color. A combination of the State and the SiteScope 
measurement determines the indicator color. A color other than green is a 
warning that the system performance is less than optimal and warrants 
investigation. 
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System performance is assessed according to four parameters: CPU usage, 
memory usage, disk space, and running services. There is a threshold for 
each parameter. If a Performance Center service stops for any reason, the 
machine state turns red (Error). 

The following table lists the possible states and the associated indicator 
color.

Indicator Host State SiteScope Status

Operational Host is operational.

Operational Some measurements are out of range, but the 
host is still operational.

Operational Indicates that at least one of the performance 
parameters is outside of its threshold, and the 
host is not recommended for running tests on.

Resource Failure Host is not operational. If the host is in the 
Resource Failure state, you should try to fix the 
problem, then change the condition back to 
Operational. If the system detects that the host 
is still not working, the condition reverts to 
Resource Failure.

Unavailable The user manually changed the host status to 
Unavailable.

Maintenance An installation is taking place.

Rebooting Host reboot is taking place. Displays the time 
(MM:SS) since the rebooting process started.

Transferring 
X%

A patch is being transferred from the File server 
to the host. The percentage shows the progress 
of the patch transfer.

Installing X% A patch installation is taking place. The 
percentage shows the progress of the patch 
installation.
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Adding Hosts

You can add hosts on the Hosts page. When you add a host and enter its 
details, the system uses these values to allocate hosts for test runs. For details 
about host allocation, see “Understanding Host Allocation” on page 63.

Important: Before attempting to add a host, ensure that the Performance 
Center system user credentials on the new host machine are the same as  
those of the Performance Center system user on the rest of the Performance 
Center system. If the system user exists on the host with a different 
password, Performance Center will not add the host to the system.
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To add a new host:

 1 In the Hosts page, click Add Host. The Add New Host dialog box opens. 

 2 In the Name box, type the unique name of the host machine.

 3 In the OS Type box, select the operating system of the host. This can be 
either Windows 2000/2003/XP or UNIX. If you select a UNIX operating 
system, you must provide the UNIX configuration information as described 
in “Configuring Remote UNIX Machines” on page 41.

 4 In the Location list, select the host’s location. When you select the location, 
if it is over a firewall, the MI Listener list becomes visible. For more 
information about host locations, see “Managing Host Locations” on 
page 67.
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 5 If you selected a location over a firewall, you need to select an MI Listener 
that will enable data collection.

➤ To automatically find the MI Listener connected to this load generator, 
click the Find MI Listener button next to the MI Listener list. The 
appropriate MI Listener is automatically selected in the list.

➤ If no MI Listener was found, it means that the Load Generator 
Performance Center Agent has not been correctly configured to operate 
over a firewall. 

In this case, you need to manually select an MI Listener from the MI 
Listener list and then configure the Performance Center Agent on the 
load generator machine to operate over a firewall. For more information 
about configuring the Performance Center Agent to operate over a 
firewall, refer to the section about firewalls in the HP Performance Center 
System Configuration and Installation Guide.

Note: For more information about configuring hosts to run over a firewall, 
see “Using Hosts to Run Vusers over a Firewall” on page 69. 

 6 If the host is a standalone installation of the Load Generator, under 
Installation, select Standalone Load Generator.

Note: If you selected UNIX as the operating system in the OS Type box, the 
Standalone Load Generator option is disabled.

 7 Under Purpose, select one or more purposes to assign to the host. That is: 

➤ Load Generator

➤ Controller

➤ Data Processor

For more information about host purposes, see “Assigning a Purpose to a 
Host” on page 40.
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Notes:

➤ If the host is located over the firewall or is a UNIX machine, the only 
purpose it can be assigned is Load Generator.

➤ If you selected Standalone Load Generator as the installation option, 
Load Generator is automatically selected as the purpose for the host and 
the other options are disabled.

➤ If you selected the Standalone Load Generator option for a regular 
installation of a Performance Center host (not a standalone installation) 
and you saved the host, you cannot then change the purpose of the host. 
To assign a different purpose, you would need to remove the host and 
add it again with a different purpose.

 8 In the Priority box, enter a priority number.

You assign a priority to each host. The system allocates hosts with higher 
priority in preference to those with lower priority. There are a number of 
criteria to consider when assigning priority. The main considerations are 
whether the host a dedicated machine or a shared resource and the type of 
hardware installed on the machine.

 9 In the Host Pool list, select a host pool to which to assign the host. A host 
can be assigned to a single pool only. For more information on host pools, 
see “Adding New Pools” on page 84.

 10 In the State list, select the appropriate description of the host state (possible 
states are Operational, Unavailable, Resource Failure, or Maintenance).

 11 In the Comments box, type any relevant information about the host.
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 12 If the host is assigned as a load generator (step 7), you can configure the 
load generator to communicate with the Controller via SSL (Secure Socket 
Layer) by selecting Use SSL communication between this Load Generator 
and the Controller.

Note: 

➤ When this option is selected, the load generator uses SSL to 
communicate with the Controller during run time only. For non 
run-time functionality (including collating results), the load generator 
does not use SSL as the communication protocol.

➤ You can also select this option when the load generator is located over a 
firewall.

 13 To enable SiteScope monitoring of the host, select Enable SiteScope 
Monitoring. 

Note: 

➤ SiteScope must be installed on a server in the Performance Center 
environment. You can install SiteScope on the same machine as the 
Controller, or on a dedicated server.

➤ Disk performance counters are disabled by default in standard Windows 
2000 installations. To monitor disk drives using the SiteScope Disk 
monitor on machines running Windows 2000, you must enable these 
disk counters. Run the diskperf -y command line on each Windows 2000 
machine you want to monitor disk space, then reboot the machine. 
Select the disk drives to monitor from the machine’s Resource Status tab.
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 14 If you selected a UNIX operating system, the Add Hosts dialog box includes 
a Configuration for Unix section. Provide the UNIX configuration 
information as described in “Configuring Remote UNIX Machines” on 
page 41.

 15 Save the new host.

➤ If you are adding a standalone load generator host, ensure that you have  
selected Standalone Load Generator before you click Save.

➤ Click Save to add the host. 

➤ If you are prompted for the configuration user credentials, enter them 
and click OK. 

Note: 

➤ For more information about the configuration user prompt, see “Remote 
Performance Center Server and Host Administration” on page 118.

➤ When supplying the credentials of a domain system user, you must enter 
the fully qualified domain name.

Assigning a Purpose to a Host
The purpose is the function that you assign to each host. A host can be 
allocated any of the following purposes:

➤ Controller. The Controller host manages the load test. Each test requires one 
host as a Controller.

➤ Load Generator. The Load Generator hosts run the Vusers in a load test. 
There can be any number of load generators in a given test.

➤ Data Processor. The Data Processor host is used for publishing information 
to the Dashboard.
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Notes:

➤ To provide greater flexibility (especially where resources are scarce), you 
can allocate a host with dual purposes as a Controller and Load 
Generator. In general, this is not recommended practice and is only 
appropriate for load tests that have a very small number of Vusers. When 
allocating machines, the system tries to use single function machines 
before dual purpose Load Generator and Controller machines.

➤ Although it is possible to set a machine as a Controller and a Data 
Processor, it is recommended to set up a separate Data Processor 
machine.

➤ A machine that is located over the firewall or is a UNIX machine can 
only be assigned the purpose of Load Generator. 

Configuring Remote UNIX Machines
You configure the remote machine according to the platform your machine 
is running on. If you selected a UNIX operating system, the Configuration 
for UNIX section is displayed in the Add Hosts dialog box. Depending on 
whether you enabled SiteScope monitoring, different Unix configuration 
fields are displayed.

SiteScope Monitoring Not Enabled

If you did not enable SiteScope Monitoring, the following fields are 
displayed under the Configuration for UNIX section:

Type the user name and password of the UNIX host machine.
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SiteScope Monitoring Enabled

If you enabled SiteScope Monitoring, the following fields are displayed 
under the Configuration for UNIX section: 

Provide the following information to configure the remote UNIX machine 
enabled for SiteScope viewing:

➤ User Name. Type the user name of the UNIX host machine.

➤ Password. Type the user password of the UNIX host machine.

➤ OS. Select the operating system running on the remote server. The following 
versions of UNIX are supported: AIX, HP/UX, HP/UX 64-bit, Linux, and Sun 
Solaris.

➤ Connection Method. Select the method of connecting to the host machine. 
The supported methods are: 

➤ Telnet. Log in to the remote server using Telnet.

➤ Rlogin. Log in to the remote server using the Rlogin protocol.

➤ HTTP. Connect to an HTTP server on the remote server and run the 
command using a CGI. For this method, the Login and Password are 
optional and are used for authorizing the log on to the remote machine if 
required.

➤ Prompt. Type the prompt to be displayed when the system is ready to 
handle a command - the default is #.
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➤ Login Prompt. Type the prompt to be displayed when the system is waiting 
for the login to be entered - the default is "login:".

➤ Password Prompt. Type the prompt to be displayed when the system is 
waiting for the password to be entered - the default is "password:".

➤ Secondary Prompt. Type the prompt to be displayed if the telnet connection 
to the remote server causes the remote server to prompt for more 
information about the connection. Separate multiple prompt strings by 
commas (,). For example, for Telnet connections to some remote servers, the 
remote server may ask what terminal type should be emulated for the 
connection. In this case you might need to type Terminal type? as the 
secondary prompt. The response to the secondary prompt is entered in the 
Secondary Response field below.

➤ Secondary Response. Type the responses to secondary prompts required to 
establish connections with this remote server. Separate multiple responses 
with commas (,). 

➤ Init Shell Environment. Type any shell commands to be executed at the 
beginning of the session. Separate multiple commands with a semicolon (;). 
This option allows you to specify shell commands to be executed on the 
remote machine directly after a Telnet or SSH session has been initiated. 
These commands can be used to customize the shell for each SiteScope 
remote. 

Examples:

➤ The remote shell may not have the correct path set for SiteScope scripts to 
run. The following command will add the directory /usr/local/bin into the 
PATH of the current shell on the remote machine:

➤ The remote shell may not be initializing the pseudo terminal correctly. Type 
the following command to increase the terminal width to 1024 characters:

export PATH=$PATH:/usr/local/sbin

stty cols 1024;${SHELL}
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Note: Commands after a shell invocation will not be executed.

➤ There have been cases where the remote Telnet Server does not echo back 
the command line properly. This may cause strange behavior for monitors 
that rely on this behavior.

Type the following command to force the remote terminal to echo:

➤ Certain UNIX shells have been known to behave erratically with SiteScope. 
This includes bash, ksh, and csh. Type the following command to change 
the shell to sh for the SiteScope connection:

Editing Host Details

You can edit the main host details for one or multiple hosts in the Details 
for Host area on the Hosts page. For each host, you can edit more specific 
details in the host details page.

To edit host details:

 1 Select the desired hosts in the Hosts table. The selected hosts are displayed 
in the Details for host list.

 2 In the Details for host area, you can edit the following settings:

➤ Priority. A rank assigned to the host. The higher the priority you give the 
host, the more likely the host will be allocated to a test. In this case, you 
would set the priority according to the performance of the hosts. You 
assign this value when you add a host, and you can edit it for any host.

➤ State. The state of the host. The possible states are: Operational, 
Unavailable, Resource Failure, and Maintenance. Additionally, temporary 
states of Rebooting, Transferring, or Installing are assigned while a 
machine goes through a rebooting or patch installation process. 

stty echo

/bin/sh
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If the host is in the Resource Failure state, try to fix the problem, then 
change the condition back to Operational.

➤ Pool. The host pool to which the host is assigned. For more information, 
see “Understanding Pool Resources” on page 78.

➤ Comments. Relevant information about the host.

Note: If multiple hosts are selected, Performance Center displays only those 
settings that are identical for all the selected hosts. If settings differ, the box 
remains empty. The More Details link is not available when multiple hosts 
are selected.

 3 Click Save to save changes to the hosts. Performance Center displays a 
message informing you that the details were successfully saved. If you move 
away from the page without saving the changes, the settings are not saved.

 4 To edit more specific details about the host, click the More Details link in 
the Details for host area, or click the name of the host in the Hosts table. For 
more information, see “Managing Host Details” on page 45.

Managing Host Details

You can view and manage details about each host on the Host details page. 

You access the Host details page by clicking on the name of any host in the 
Hosts page.

The Host details page includes the following tabs:

➤ Properties tab. Allows you to view and edit host properties. See “Host 
Properties Tab” on page 46.

➤ Status tab. Allows you to view the host status and to perform host 
connectivity checks. See “Host Status Tab” on page 49.

➤ Processes tab. Allows you to view and end processes on a host. See “Host 
Processes Tab” on page 51.
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➤ Logs tab. Allows you to view detailed information about the tasks 
performed on the host, the action status, and a description of any errors. 
See “Host Logs Tab” on page 52.

➤ Runs tab. Allows you to view runs on a specific host. See “Host Runs Tab” 
on page 53.

Host Properties Tab
The Properties tab provides general information about the host.

 In this tab, you can: 

➤ View and edit the host properties. 

➤ Edit over firewall settings. For load generators that have been configured 
to operate over a firewall, you can edit the agent configuration settings. 
For more information, see “Editing Over Firewall Agent Configuration 
Settings” on page 54.
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 The Host Properties tab displays the following details:

➤ Host Name. The host name that you assign when you add a new host.

➤ Host Logical Name. The logical name given to the host when it was added to 
the system. 

➤ OS Type. The host operating system.

➤ Installation. Indicates whether the host is a standalone load generator.

➤ Purpose. The function the host performs in a test run. You define a host as a 
Controller, Load Generator, Controller + Load Generator, or Data Processor.

➤ Comments. Any relevant information about the host.

➤ Priority. A rank assigned to the host. The higher the priority you give the 
host, the more likely the host will be allocated to a test. 

➤ Location. Location of the host. For example, locations can be defined 
according to physical areas. The location also determines whether the host 
is located over a firewall.

➤ MI Listener. For hosts located over a firewall, the IP address or name of the 
MI Listener that enables data collection.

➤ Host Pool. The host pool to which the host is assigned.

➤ Allocation. The number of timeslot to which the host is allocated. 0 means 
the host is not allocated.

➤ State. The state of the host. The possible states are; Operational, 
Unavailable, Resource Failure, and Maintenance. Additionally, temporary 
states of Rebooting, Transferring, or Installing are assigned while a host goes 
through a rebooting or patch installation process.

➤  Login information.

➤ User Name. The user name of the host. 

➤ Password. The password of the host.

➤ Domain. The host domain.

➤ Installed Components. A list of components installed on the host, including 
version and patches.
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➤ Security Mode. If the host is designated as a load generator, this field 
indicates whether the load generator is located over a firewall and whether 
it is using SSL to communicate with the Controller.

Note: When the load generator is configured to use SSL, it uses SSL to 
communicate with the Controller during run time only. For non run-time 
functionality (including collating results), the load generator does not use 
SSL as the communication protocol.

To edit host properties:

 1 Click the Properties tab, and click Edit. The Properties tab is displayed with 
editable fields.

 2 Edit the desired fields, as described in “Adding Hosts” on page 35.
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Note: For hosts that are located over a firewall, if you change the host 
location to another over-firewall location or modify the MI Listener name, 
these change are automatically updated on the Performance Center agent. 
For more information, see “Editing Over Firewall Agent Configuration 
Settings” on page 54.

 3 Click Save to update the host properties, or click Cancel to disregard any 
changes made.

 4 Click the Hosts link at the top of the page to return to the Hosts page.

Host Status Tab
The Check Host area of the Status tab provides information about the 
connections between the selected host and various machines within your 
system. 

For more information about checking host connections, see “Checking 
Hosts” on page 65.

If SiteScope monitoring is enabled, the SiteScope Data table displays 
detailed information about the host, as collected by the SiteScope monitor. 
For more information, see “Adding Hosts” on page 35 and the HP 
Performance Center System Configuration and Installation Guide. 
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All functions are automatically performed when the tab is opened, the page 
is refreshed, or when you click the Check Host button. 

If you want the selected host to ping a remote site, type the URL address in 
the Ping to URL box and click Check Host. Performance Center displays the 
results in the Ping to URL Status field.

Note: To ping to a host or to a URL, the Performance Center system user 
must have administrator privileges.

Click the Hosts link at the top of the page to return to the Hosts page.
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Host Processes Tab
The Processes tab provides detailed information about the processes and 
resource usage of the selected host. 

To end a process, click the Kill Process button in the process’s Kill column.

Click the Hosts link at the top of the page to return to the Hosts page.

Note: Performance Center is unable to display processes and resource usage 
information for UNIX machines.
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Host Logs Tab
The Logs tab provides detailed information about the tasks performed on 
the selected host, the action status, and a description of any errors. 

You can filter the information by a specific time frame, refresh the table to 
view the most current tasks, and clear the log. 

To view log files for the action, click the error description link.

Click the Hosts link at the top of the page to return to the Hosts page.
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Host Runs Tab
The Runs tab provides detailed information about load test runs performed 
on the selected host. 

You can filter the information by a specific time frame and refresh the table 
to view the most current tasks. You can also sort the information by clicking 
the header of any column in the table.

The Run Details table displays the following details about each test run: 

➤ Run ID. The identification number of the test run. This number is 
automatically generated by the system when the load test starts running.

➤ Date. The start date and time of the test run.

➤ Load Test. The name given to the test when it was created.

➤ Project. The name of the project running the test.

➤ User. The name of the user running the test.

➤ State. The state of the test run. If a test is stuck in a particular state, you can 
change it.

➤ Duration. The time the load test took to run.

Click the Hosts link at the top of the page to return to the Hosts page.
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Editing Over Firewall Agent Configuration Settings

When you designate a load generator to run over a firewall, you configure 
the Performance Center agent on the load generator machine. 

In the Performance Center agent, you define the communication settings 
between the load generator and the MI Listener. This communication is 
necessary for running Vusers over a firewall.

After you have configured the Performance Center agent on the load 
generator machine, you can edit these settings from the Performance Center 
Administration site. 

When you edit these settings in the Administration site, they are 
automatically updated in the Performance Center agent on the load 
generator machine.

Note: For detailed information about configuring your system to work with 
firewalls, refer to the section about working with firewalls in the HP 
Performance Center System Configuration and Installation Guide.

To edit over firewall agent configuration settings:

 1 In the Hosts page, click on the name of the relevant host. The host details 
page opens.

 2 In the Properties tab, click Edit. The Properties tab is displayed with editable 
fields. The following fields affect the agent configuration settings:

➤ MI Listener. The IP address or name of the MI Listener machine. When 
you change the MI Listener name, it is automatically updated on the 
Performance Center agent.

➤ Location. You can select a different location, as long as it is also located 
over a firewall. When you change the location, the Local Machine Key in 
the Performance Center agent is automatically updated according to the 
format hostname_locationname.

 3 Click Save to update the host properties, or click Cancel to disregard any 
changes made.
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 4 To edit the remaining agent configuration settings, click Advanced - Over 
Firewall In the Properties tab.

The Over Firewall - Advanced Configuration dialog box opens, displaying 
communication settings between the load generator and the MI listener.
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You can edit the following settings:

Option Description

Polling Timeout (seconds) To verify the state of the load generator located over 
a firewall, Performance Center checks when last the 
load generator connected to the MI Listener.

If the load generator has not connected to the MI 
Listener machine for a period of time longer than 
the amount of time set in the Polling Timeout, 
Performance Center changes the state of the load 
generator to Resource Failure. 

Notes: 

➤ The Polling Timeout is a Performance Center 
setting. It is not set in the Performance Center 
agent. 

➤ The Polling Timeout needs to be longer than the 
Connection Timeout, described below.

Default value: 60 seconds

This is a required field.

Connection Timeout 
(seconds)

The length of time you want the agent to wait 
before retrying to connect to the MI Listener 
machine. If zero, the connection is kept open from 
the time the agent is run.

Default value: 20 seconds

This is a required field.

MI Listener User Name The user name needed to connect to the MI Listener 
machine.

MI Listener Password The password needed to connect to the MI Listener 
machine.

Connection Type - TCP/
HTTP

Choose either TCP or HTTP, depending on the 
configuration you are using.

Default value: TCP

Connection Type - 
HTTP Proxy Name

The name of the proxy server. This field is 
mandatory if the Connection Type option is set to 
HTTP.



Chapter 2 • Managing Hosts

57

 5 Click Save to save the configuration settings.

 6 Click Close to close the Over Firewall - Advanced Configuration dialog box.

Connection Type -
HTTP Proxy Port

The proxy server connection port. This field is 
mandatory if the Connection Type option is set to 
HTTP.

Connection Type - 
HTTP Proxy User Name

The user name of a user with connection rights to 
the proxy server.

Connection Type - 
HTTP Proxy Password

The password of the user with connection rights to 
the proxy server.

Connection Type - 
HTTP Proxy Domain

The user’s domain if defined in the proxy server 
configuration. This option is required only if NTLM 
is used.

Use Secure Connection 
(SSL)

Enable to connect using the Secure Sockets Layer 
protocol.

Default value: disabled

Use Secure Connection 
(SSL) - Check Server 
Certificates

Authenticates the SSL certificates that are sent by 
the server. Choose Medium to verify that the server 
certificate is signed by a trusted Certification 
Authority. Choose High to verify that the sender IP 
matches the certificate information. This setting is 
available only if Use Secure Connection is set to 
True. 

Use Secure Connection
(SSL) - Private Key 
Password

The password that may be required during the SSL 
certificate authentication process. This option is 
relevant only if the Client Certificate Owner option 
is enabled.

Use Secure Connection
(SSL) - Use Client 
Certificate

Enable to load the SSL certificate (if required by the 
server to allow the connection to be made). This 
option is relevant only if the Use Secure Connection 
option is enabled.

Default value: disabled

Option Description
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Rebooting Hosts

Performance Center enables you to reboot hosts remotely from the 
Administration Site. 

Notes:

➤ You cannot reboot Controller and Load Generator hosts while they are in 
the Running state. You can only reboot these hosts when they are idle.

➤ You cannot reboot a UNIX host.

To reboot hosts:

 1 From the Hosts page, select the hosts you want to reboot.

 2 Click Reboot. The Reboot Hosts window opens.

If Performance Center is unable to reboot the host—for example, because 
the selected host is the Administration Site server or a task is running on the 
host—a message is displayed in the Message column.
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 3 Supply login information for all hosts that should be automatically logged 
on after the hosts reboot. If you leave the boxes empty, you must log on to 
these hosts at startup.

Note: If you supplied login information when the host was configured, it is 
displayed in the appropriate column.

 4 Click Reboot. 

You can follow the progress of the reboot from the Hosts page. During 
reboot, the state of the host changes to Rebooting and the time (MM:SS) 
since the rebooting process started is displayed.

Uploading and Installing Patches

Performance Center allows you to upload a patch to the system and then 
install the patch on the appropriate Performance Center host.

The process consists of two stages: 

➤ uploading the patch

➤ installing the patch.
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Notes:

➤ The Install Patch feature is not available for the Administration Site and 
Database servers.

➤ You cannot use the Install Patch feature on Controller and Load 
Generator hosts if they are in the Running state. You can only install 
patches when these hosts are idle.

➤ You cannot use the Install Patch feature on the File Server if any of the 
load test runs are in the following states: Ready, Collating Results, 
Running, Stopping, Creating Analysis Data, Before Collating Results, or 
Before Collating Analysis Data. You can view the state of a load test run 
on the Test Runs page (Site Management > Test Runs).

➤ You should use this feature to install Performance Center certified 
patches only.

To install patches on hosts:

 1 From the Hosts page, select the hosts on which you want to install patches.

 2 Click Install Patch. The Install Patch - Step 1 dialog box opens displaying 
any patches that were previously uploaded to the File Server.
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 3 If a patch you want to install is not displayed in the Existing Patches list, 
click Browse, select the patch, and click Upload. The patch is added to the 
list.

 4 Select the patches you want to install from the Existing Patches list and click 
Next. The Install Patch - Step 2 dialog box opens.

If Performance Center is unable to install a patch (for example, because the 
selected host is the Administration Site server or a task is running on the 
host), a message is displayed in the Message column. 

 5 Supply the login information for all hosts. 

Note: If you supplied the login information when the host was configured, 
it is displayed in the appropriate column. 
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 6 Click Install. The installation process begins.

You can follow the progress of the patch installation from the Hosts page. 
When the patch is being transferred from the File Server to the host, the 
state of the host is Transferring. During the patch installation, the state of 
the host is Installing. The percentage shows the progress of the patch 
transfer/installation. If the installation fails, select the host’s Log tab and 
click the Fail to create task link to view the log file.

Note: If the log file opens in binary instead of .txt format, you should close 
the file and reopen it using Notepad.

 7 After installation is complete, if a reboot is required Performance Center 
prompts you to reboot the host. 

To uninstall a patch:

 1 From the Hosts page, select the hosts from which you want to uninstall a 
patch.

 2 Click Install Patch. The Install Patch dialog box opens and displays any 
patches that were previously uploaded to the hosts.

 3 Click the Deletebutton at the end of the line for the patch that you want to 
uninstall.

The patch is now removed from the list and deleted from the File Server.
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Understanding Host Allocation

When creating a test, the user specifies the number of hosts required for the 
test, and reserves a timeslot. To successfully reserve a timeslot, the required 
number of hosts needed for the test must be available.

When the user tries to reserve a timeslot, the system uses some of the 
information that is displayed on the Hosts page to determine if the required 
number of hosts, with the proper purposes, are available. If the required 
hosts are found, and are available for the requested time period, the timeslot 
is successfully reserved and the hosts are allocated. If the system cannot find 
suitable hosts to allocate for the requested time period, the timeslot cannot 
be reserved.

Each test requires one host as a Controller, one or more hosts that are load 
generators (it is possible to designate one host as a Controller + Load 
Generator), and one host for data processing. Performance Center uses 
different criteria to allocate hosts for each of these purposes, and out of all 
the hosts that meet the requirements, allocates those with highest priority. 
The two allocation methods are described below.

Allocating Controller and Load Generator Hosts
For load generation, Performance Center uses the following criteria for 
allocating hosts:

➤ Run ID. null means the host is not currently running.

➤ Allocation. 0 means the host is not allocated to the timeslot.

➤ State. Operational.

➤ Purpose. Controller, Controller + Load Generator, or Load Generator as 
indicated.

➤ Pool. The same pool as specified for the project for which the test is being 
run. For each project, Performance Center assigns hosts from a specific pool. 
This pool is specified in the project information page. For details, see the HP 
Performance Center User’s Guide.

➤ Project. Either none or the name of the test’s project for which the test is 
being run. Priority goes to hosts already assigned to the project.
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Allocating Data Processor Hosts
For data processing, Performance Center allocates a host with the following 
values:

➤ State. Operational.

➤ Purpose. Data Processor.

➤ Pool. The same pool as specified for the project for which the test is being 
run.

➤ Allocation. 0 - 5, because one host can be used for up to 5 concurrent 
operations.

Handling Resource Failure

If any of the hosts fail when Performance Center tries to run a test on the set 
of allocated hosts, the condition of the failed hosts changes from 
Operational to Resource Failure, and an error log describing the problem is 
sent to the main site.

You can try to fix the problem according to the description in the error log, 
then change the condition back to Operational. If the host is still not 
operational, the condition automatically returns to Resource Failure in the 
next test run. 

If you are using the Host Checkup Service (enabled from the General 
Settings of the Administration site), Performance Center automatically 
detects host resource failure and attempts to restore the host to the 
Operational state.
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Checking Hosts

You can check the connections between your project’s hosts and the various 
machines within your system. 

To check hosts:

 1 From the Hosts page, select the hosts that you want to check and click the 
Check Hosts button. The Check Hosts dialog box opens displaying the 
selected hosts together with an icon next to the host name indicating the 
host’s purpose. 

By default, all the selected hosts are enabled. If you not do want to check a 
specific host, clear that host’s check box.

Tip: Selecting or clearing the check box in the check box column header 
selects or clears all the check boxes respectively.

 2 If you want the selected hosts to ping a remote site, in the Ping URL column 
header, type the URL address.
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 3 Click Check Hosts. Based on the purpose of the host, Performance Center 
checks one or more of the following connections:

➤ Ping to Host. The Administration Site server pings the selected host.

➤ Over Firewall Status. For load generators over a firewall, Performance 
Center checks that the load generator is connected to an MI Listener.

➤ File Server. The selected host attempts to write, read, and delete from the 
File Server.

➤ Database. The selected host connects to the Database Server.

➤ Ping URL. The selected host pings the listed URL.

Note: To ping to a host or to a URL, the Performance Center system user 
must be a user with administrator privileges.

The Check Hosts table displays the success or failure of the actions.

The following table describes which connections Performance Center checks 
for each type of host. 

 4 Select a host to view the results of the host check. Details for each action are 
listed in the Result Status area.

Host purpose
Ping to 
Host

Over 
Firewall 
Status

File 
Server

Database Ping URL

Regular load generator yes N/A N/A N/A yes

Unix Load Generator yes N/A N/A N/A N/A

Standalone load 
generator

yes N/A N/A N/A N/A

Load generator over 
firewall

N/A yes N/A N/A N/A

Controller host yes N/A yes yes yes

Data processor yes N/A yes yes yes
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 5 Click Close to return to the Hosts page.

Managing Host Locations

The Host Locations page displays the location information about the hosts 
available for load testing. 

When a user creates a load test from the main Performance Center site, the 
user specifies which hosts to use for the test. It is possible for the hosts to be 
located across a wide physical area. The location of the host might be a 
consideration when creating a test.

The Host Locations page also specifies whether a host is over a firewall. This 
information is crucial when assigning a purpose for the host. Hosts over a 
firewall can be designated as load generators only.

To view the Host Locations page:

➤ On the Performance Center left menu, select Resources > Host Locations. 
The Host Locations page opens.
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The page displays the following information about the hosts:

➤ ID. The host location ID number. This is automatically assigned when 
you add a host location.

➤ Name. The name of the location of the host. This is the name that you 
assign when you add a host location. 

➤ Over Firewall. This indicates whether or not the location of the host is 
over a firewall. Hosts that are located over a firewall may be designated as 
load generators only.

To add a host location:

 1 In the Host Locations page, click Add Host Location. The Add Host Location 
dialog box opens.

 2 Type a location name. The name should have a logical connection to the 
location.

 3 Indicate whether or not the location is over a firewall.

 4 Click OK. The location is added to the list of host locations.

To edit a host location:

 1 In the Host Locations page, select the location you want to edit.

 2 In the Edit Location Details area in the lower part of the page, type a new 
name, or indicate whether it is located over a firewall.

 3 Click Save. The host location information is updated.
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Removing Hosts

You can remove a host from the Hosts page. If you remove a host, it is no 
longer available for allocation to a test run, even if the host still has the 
Performance Center software installed.

To remove a host from the Hosts table:

 1 In the Hosts table, select the host you want to delete.

 2 Click Delete. A message appears asking you to confirm this action.

 3 Click OK to confirm. 

The host is removed from the list and is no longer available to the system to 
be used for a test.

Using Hosts to Run Vusers over a Firewall

When you add a Performance Center host (see “Adding Hosts” on page 35) 
you can configure the host as a load generator used to run Vusers over a 
firewall. Before you configure a host to operate as a load generator over a 
firewall, consider the following:

➤ Ensure that you have set up and configured your Performance Center 
system to work with firewalls. For detailed information refer to the section 
about working with firewalls in the HP Performance Center System 
Configuration and Installation Guide.

➤ Ensure that you have specified the details of the MI Listener that will be 
used to run Vusers over the firewall. See “MI Listeners for Running Vusers 
over a Firewall” on page 73.

➤ Ensure that you have configured the Performance Center agent on the load 
generator host machine to communicate with the MI Listener. For more 
information refer to the section about working with Firewalls in the HP 
Performance Center System Configuration and Installation Guide.
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Note: After you have configured the Performance Center agent on the load 
generator machine, you can edit the configuration settings from the 
Administration site. For more information, see “Editing Over Firewall Agent 
Configuration Settings” on page 54.

➤ Part of the process of adding a host involves selecting a location for your 
host. When you are configuring a host to operate over a firewall, you select a 
location that is located over a firewall. Before you configure the host, you 
need to ensure that you have added a location over a firewall. For details 
about adding a host location over a firewall, see “Managing Host Locations” 
on page 67.



71

3
Managing MI Listeners

This chapter describes how to manage MI Listener resources in Performance 
Center.  

This chapter includes:

 ➤  MI Listeners Page on page 72

 ➤  MI Listeners for Running Vusers over a Firewall on page 73

 ➤  MI Listeners for Monitoring Over a Firewall on page 75
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MI Listeners Page

MI Listeners enable running of Vusers over a firewall and collecting server 
monitor data and application diagnostics data over a firewall. You manage 
the MI Listeners from the MI Listeners page (Resources > MI Listeners).

The MI Listeners page comprises the following areas:

➤ Firewall Vusers Communicators. Specify one or more MI Listener machines 
that enable you to run Vusers over the firewall. See “MI Listeners for 
Running Vusers over a Firewall” on page 73.

➤ Firewall Monitoring Communicator. Specify the MI Listener machine that is 
configured to collect server monitor data from over the firewall. See “MI 
Listeners for Monitoring Over a Firewall” on page 75.

➤ Firewall Diagnostics Communicator. Specify the MI Listener machine that is 
configured to collect application diagnostics data from over the firewall. See 
“MI Listeners for Monitoring Over a Firewall” on page 75.
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Note: For detailed information about setting up your Performance Center 
system to work with firewalls, refer to the section about working with 
Firewalls in the HP Performance Center System Configuration and Installation 
Guide.

MI Listeners for Running Vusers over a Firewall

You can specify one or more MI Listeners that will enable running Vusers 
over a firewall. You can specify these MI Listeners in the MI Listeners page, 
in the Firewall Vusers Communicators MI Listeners table. You can add, edit, 
and delete MI Listeners in this table.

The MI Listeners table displays the following details: 

➤ MI Listeners. The IP address or name of the MI Listener.

➤ Comments. Information and comments about the MI Listener.

To add an MI Listener for running Vusers:

 1 From the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.
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 2 In the Firewall Vusers Communicators area, click Add. The Add New 
MI Listener dialog box opens.

 3 In the IP Address / Name box, type the IP address or DNS name of the 
MI Listener.

In some cases, you may want to use two different IP addresses for the same 
MI Listener—one address for internal communication with the Controller 
and a second address for public communication with a Load Generator 
located over a firewall. 

In this case, enter the internal IP address in the IP Address / Name box, and 
the public IP address in the Public IP Address / Name box.

 4 In the Comments box, type any comments that you want to note about the 
MI Listener.

 5 Click OK. The MI Listener is added to the table.

 6 Click Save at the bottom of the page.

To edit an existing MI Listener (running Vusers):

 1 On the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.
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 2 In the Firewall Vusers Communicators area, select an MI Listener in the 
table.

 3 Click Edit. The Edit MI Listener dialog box opens.

 4 Edit the details, and click OK. The changes that you made are updated in the 
table.

 5 Click Save at the bottom of the page.

To delete an MI Listener (running Vusers):

Important: Deleting an MI Listener from Performance Center permanently 
removes it from the system, and may influence hosts that use the 
MI Listener.

 1 On the Performance Center left menu, select Resources > MI Listeners to 
open the MI Listeners page.

 2 In the Firewall Vusers Communicators area, select an MI Listener in the 
table.

 3 Click Delete.

 4 In the message box that opens, click OK to proceed.

 5 Click Save at the bottom of the page.

MI Listeners for Monitoring Over a Firewall

You can specify MI Listeners to collect monitoring or diagnostics data from 
over a firewall.

To specify an MI Listener for collecting server monitor data:

 1 On the left menu, select Resources > MI Listeners to open the MI Listeners 
page.

 2 In the Firewall Monitoring Communicator area, in the IP Address / Name 
box, type the IP address or name of the MI Listener that is configured to 
collect server monitor data from over the firewall. 
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 3 Click Save at the bottom of the page.

To specify an MI Listener for collecting application diagnostics data:

 1 On the left menu, select Resources > MI Listeners to open the MI Listeners 
page.

 2 In the Firewall Diagnostics Communicator area, in the IP Address / Name 
box, type the IP address or name of the MI Listener that is configured to 
collect application diagnostics data from over the firewall. 

 3 Click Save at the bottom of the page.
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4
Managing Host Pools

Host pools are groups of hosts that you define in order to control which 
hosts may be accessed by a particular project. Managing host pools involves 
adding, deleting, editing, and assigning pools to projects.

This chapter includes:

 ➤  Understanding Pool Resources on page 78

 ➤  Assigning Pools to Projects on page 78

 ➤  Understanding the Host Pools Page on page 81

 ➤  Adding New Pools on page 84

 ➤  Editing Pools on page 86

 ➤  Deleting Pools on page 87
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Understanding Pool Resources

A host pool is a single pool made up of multiple hosts. When managing a 
pool, it is important to understand the total available resources. That is, how 
many Controllers, load generators, or other machines are a part of a pool. 

Note: A host can be assigned to a single pool only.

As hosts are added to a pool, the statistics for that pool are increased 
accordingly. Suppose you have a pool named General, and the pool consists 
of one Controller and two load generators. If you assign a new Controller 
host to the pool, the number of Controllers is increased by one, and a 
quantity of two Controllers is displayed.

A quantity is displayed for each type of machine (Controller, load generator, 
Controller + load generator).

Assigning Pools to Projects

You can assign single pools or merged pools to a project. If you assign a 
single pool to a project, the project can use only the machines available in 
that pool. Assigning a single pool limits flexibility in managing the 
Performance Center, and the utilization of shared resources.

When a customer is assigned to a project, he has access only to those pools 
assigned to his projects.

Typically, host pools are divided according to a variety of schemes that 
include geographical location, type of machine, machine properties, and 
software installed on the machine.
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For example, say you have two pools—Pool 1 (machines in New York) and 
Pool 2 (machines in Los Angeles), and two projects—Project 1 and Project 2. 
If you want Project 1 to access only the machines in New York, and 
Project 2 to access the machines both in New York and in Los Angeles, you 
can either:

➤ Split Pool 1 and assign some of its resources to Pool 2. 

Pool 1 is assigned to Project 1, and Pool 2 is assigned to Project 2. 
However, both projects have access to fewer machines, and lose the 
benefit of shared resources.

➤ Merge Pool 1 and Pool 2 into a new pool, Pool 3, and assign it to both 
projects. 

This gives Project 1 access to machines in Los Angeles—which it need 
not have. 



Chapter 4 • Managing Host Pools

80

Assigning Merged Pools to Projects

To increase the flexibility and utilization of Performance Center resources, 
you can assign a merged pool to one project. A merged pool is a logical pool 
that combines the physical resources of existing host pools. This enables the 
project to access and utilize the resources of a number of different pools.

Using the example discussed above, to maximize resource usage, you can 
create a merged pool, Pool 3, that combines the resources of the existing 
host pools, Pool 1 and Pool 2. You can assign Pool 3 to Project 2, allowing 
access to New York and Los Angeles machines, and, at the same time, you 
can assign Pool 1 to Project 1, allowing access to New York machines only.

Merged pools allow projects, and customers working on those projects, to 
access resources from an unlimited number of pools.
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Understanding the Host Pools Page

Host pools are groups of hosts. You define host pools in order to control 
which hosts may be accessed by which projects. You can view a list of host 
pools and merged pools, and their total resources, in the Host Pools page. To 
access the Host Pools page, on the Performance Center left menu, select 
Resources > Host Pools.  

The Host Pools page is comprised of the following areas:

➤ Filter by. Allows you to filter the information displayed in the table.

➤ Host Pools table. Displays information about the host pools in the 
Performance Center system. You can add and delete pools, and merge pools 
that are listed in the table. For more information, see “Host Pools Table” on 
page 82.

➤ Edit Pool Details area. Displays the details of a selected host pool or merged 
pool. 
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Host Pools Table
The Host Pools table displays the following information about the pools: 

➤ Pool ID. The ID that was assigned to the pool when it was created.

➤ Pool Name. The name that was assigned to the pool when the pool was 
created. 

If a pool is a merged pool, you can expand it to see which host pools it 
comprises, and the total physical resources contained in each pool.

➤ Total C. The total number of Controller hosts in the pool.

➤ Total L. The total number of load generator hosts in the pool.

➤ Total C + L. The total number of Controller and load generator hosts in the 
pool.

➤ Merged. Y indicates that the pool is a merged pool—a pool comprised of 
existing host pools. N indicates that the pool is not a merged pool.

➤ Host Count. The total number of machines in the pool.

➤ Description. A description of the pool.
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Sorting and Filtering the Host Pools
You can sort the Host Pools in the table in ascending or descending order by 
clicking the heading of the column by which you want to sort. Click the 
column heading again to reverse the sort order.

You filter the Host Pools using the filter boxes in the Filter by area. 

To filter the Host Pools:

 1 In the Filter by area, enter the relevant values in the filter boxes. 

 2 Click Filter or press ENTER. 

The table displays Host Pools according to the selected filter options.

Note: The filter supports partial text entries. For example, if you entered th, 
the display list might include Seth, Thomas, and Anthony. The filter does 
not support regular expressions.
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Adding New Pools

You can add new pools and create merged pools in the Host Pools page. 

To add a new host pool:

 1 Click Add Pool. The Add New Pool dialog box opens.

 2 In the Pool Name box, type a unique name for the pool. 

The name may contain up to 128 characters, excluding spaces, periods, and 
any of the following characters: : ; * \ / ” ~ & ? { } $ % | < > + = ^ [ ] ( )

 3 In the Description box, type a description for the pool.

 4 Click OK to add the new pool.
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To create a merged pool:

 1 At the bottom of the Hosts Pools table, click the Create Merged Pool 
button. The Create Merged Pool dialog box opens.

 2 In the Pool Name box, type a unique name for the merged pool.

The name may contain up to 128 characters, excluding spaces, periods, and 
any of the following characters: : ; * \ / ” ~ & ? { } $ % | < > + = ^ [ ] ( )

 3 In the Description box, type a description for the merged pool.

 4 Select the host pools to include in the merged pool. To select all the host 
pools at once, select the check box at the top of the check box column.

 5 Click Save to add the merged pool.
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Editing Pools

You edit pools in the Edit Pool Details area of the Host Pools page.

To edit a pool:

 1 In the Host Pools table, select a pool to edit, by clicking on the relevant row 
in the table.

 2 The Edit Pool Details area displays the following:

➤ Pool ID. Identifies the pool.

➤ Included In/Merged Pools.

➤ If you selected a host pool that is included in one or more merged 
pools, then Included In lists those merged pools.

➤ If you selected a merged pool, then Merged Pools list the host pools 
included in the merged pool.

➤ Name. Displays the name of the pool. To rename the pool, type a new 
name. 

➤ In the Description box, edit the description of the pool.

Click Save.

 3 If you are editing a merged pool, to edit the selection of pools included in 
the merged pool:

 a Click the Edit Merged Pool button. The Edit Merged Pool dialog box 
opens. 

 b Select the host pools to include in the merged pool, or clear selected host 
pools if you do not want to include them, and click Save.
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Deleting Pools

You can delete a host pool or merged pool from the Performance Center 
system, provided the pool has no hosts assigned to it.

To delete a pool:

 1 Select the check boxes next to the pools you want to delete.

 2 Click Delete Pool. Performance Center validates whether the pool can be 
deleted.

➤ If the pool is a merged pool, Performance Center deletes the pool.

➤ If the pool is a host pool, Performance Center checks the following:

➤ If the pool has any hosts assigned to it, it cannot be deleted.

➤ If the pool has future timeslots assigned to it, Performance Center 
warns you that if you delete the pool, tests scheduled to use that pool 
will fail.

➤ If the pool is included in any merged pools, it cannot be deleted.
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5
Managing Servers

Servers are configured machines that provide information and resources 
needed for Performance Center functionality. Managing servers involves 
monitoring the server status, editing server information, and checking 
server performance.

This chapter includes:

 ➤  Using the Servers Page on page 89

 ➤  Managing Server Information on page 92

 ➤  Rebooting Servers on page 99

 ➤  Uploading and Installing Patches on page 100

 ➤  Checking Servers on page 104

Using the Servers Page

The Servers page displays information about the Performance Center 
servers. It also enables you to reboot machines, install patches, and check 
server connectivity. 

When performing administrative tasks on the any of the servers, if you are 
prompted for the configuration user credentials, enter them and click OK.

Note: When supplying the credentials of a domain system user, you must 
enter the fully qualified domain name.
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To open the Servers page:

On the Performance Center left menu, select Resources > Servers. The 
Servers page opens. 

The Servers page displays the following information about the servers:

➤ Status. An indicator of the current system performance of the server, 
represented by a color. A combination of the state and the SiteScope 
measurement determines the indicator color. A color other than green is a 
warning that the system performance is less than optimal and warrants 
investigation. The performance is assessed according to four parameters: 
CPU usage, memory usage, disk space, and running services. There is a 
hard-coded threshold for each parameter. If a Performance Center service 
stops for any reason, the machine state turns red (Error). The following table 
lists the possible combinations and the associated indicator color.

Indicator Server State SiteScope Status

 (green) Operational OK

 (yellow) Operational Warning

 (red) Operational Error - Measurement Problem

 (gray) Unavailable Any
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➤ Name. The server name that you assign when you configure a new server. 
You can click the name to view server details. For details, see “Managing 
Server Information” on page 92.

➤ Purpose. The type of servers configured on the machine. A server symbol 
indicates each type of configured server. For more information on 
Performance Center servers, see the HP Performance Center System 
Configuration and Installation Guide.

➤ State. The condition of the server. The possible conditions are:

➤ Operational. The server is working.

➤ Unavailable. The server is not available.

➤ Maintenance. The server is not working.

➤ Rebooting. The server is rebooting and is temporarily unavailable. The 
time (MM:SS) since the rebooting process started is displayed.

➤ Transferring. The installation patch is being transferred from the File 
Server to the host, and the server is temporarily unavailable. The 
percentage shows the progress of the patch transfer.

➤ Installing. The installation patch is being installed on the server, and the 
server is temporarily unavailable. The percentage shows the progress of 
the patch installation.

The various states are descriptive in nature and provide clues as to where a 
problem has occurred. You should try to fix the problem, and then change 
the condition back to Operational. If the system detects that the server is 
still not working, the condition reverts to its prior state.

 (gray) Maintenance Any

 (gray) Operational Not Defined

 (gray) Rebooting Any

 (gray) Transferring Any

 (gray) Installing Any

Indicator Server State SiteScope Status
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In addition, you can perform the following actions from the Servers page:

➤ Reboot. Enables you to reboot server machines remotely from the 
Administration Site. For more information, see “Rebooting Servers” on 
page 99.

➤ Install Patch. Enables you to install patches remotely on servers. For more 
information, see “Uploading and Installing Patches” on page 59.

➤ Check Servers. Enables you to check the connections between various 
servers and machines within your system. For more information, see 
“Checking Servers” on page 104.

To perform actions on all the Performance Center servers, select the check 
box at the top of the check box column. A check is displayed in the check 
box for each server. Click the check box again to clear all the check boxes.

Managing Server Information

You can manage servers by entering the Server details tabs. The tabs enables 
you to view and edit server properties, status, processes, and logs.

To enter the Servers details tabs:

 1 On the Performance Center left menu, select Resources > Servers. The 
Servers page opens.

 2 Click the name of a server to view server details. Server information is 
divided into the following tabs:

➤ Properties tab. Allows you to view and edit server properties.

➤ Status tab. Allows you to view server status and to perform server 
connectivity checks.

➤ Processes tab. Allows you to view and kill processes on a server.

➤ Logs tab. Allows you to view detailed information about the tasks 
performed on the server, the action status, and a description of any 
errors.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Servers - Properties Tab
The Properties tab provides general information about the properties of the 
server. The tab enables you to change a server’s state, add comments, and 
enable SiteScope monitoring. 

➤ Server Name. The server name.

➤ OS Type. The server operating system.

➤ Purpose. The function the server performs. Purposes include: User Site 
Server, File Server, Utility Server, Administration Site Server, and Database 
Server.

➤ Comments. Relevant information about the host.

➤ State. The state of the server. Possible states are: Operational, Unavailable, 
and Maintenance. Additionally, temporary states of Rebooting, 
Transferring, or Installing are assigned while a machine goes through a 
rebooting or patch installation process.

➤ Login Information

➤ User Name. The user name of the server machine.

➤ Password. The password of the server machine.
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➤ Domain. The server machine domain.

➤ Installed Components. A list of components installed on the server 
machine, including version and patches.

To change the server state or enable SiteScope monitoring:

 1 Click the Properties tab, and click Edit. The Properties tab is displayed with 
editable fields.

 2 Select the desired server state. The available states are: Operational, 
Unavailable, and Maintenance.

 3 If you are editing the properties of your database server, the Database 
Instance field is displayed. Type the database instance name.

Note: Do not enter the instance port number as the service name will always 
be the instance name.



Chapter 5 • Managing Servers

95

 4 If you are editing the properties of a UNIX server, the UNIX login 
configuration details are displayed. For more details, see “Configuring 
Remote UNIX Machines” on page 41.

 5 To enable SiteScope monitoring, select Enable SiteScope Monitoring.

Note: 

➤ SiteScope must be installed on a server in the Performance Center 
environment. You can install SiteScope on the same machine as the 
Controller, or on a dedicated server.

➤ Disk performance counters are disabled by default in standard Windows 
2000 installations. To monitor disk drives using the SiteScope Disk 
monitor on machines running Windows 2000, you must enable these 
disk counters. Run the diskperf -y command line on each Windows 2000 
machine for which you want to monitor disk space, then reboot the 
machine. Select the disk drives to monitor from the machine’s Resource 
Status tab.

 6 Click Save. The dialog box closes and the properties are updated.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Servers - Status Tab
The Status tab provides information on the connections between the 
selected machine and various servers and machines within your system. For 
more details on checking connections, see “Checking Servers” on page 104.

All functions are automatically performed when the tab is opened, the page 
is refreshed, or you click the Check Servers button. 

The Status tab displays the following results:

➤ State. Displays the status of the server check (Done, Refreshing, Succeeded).

➤ Ping to Server. Displays the results of the Administration Site server pinging 
the selected server.

➤ File Server. Displays whether the selected server is able to write, read, and 
delete from the file server.

➤ Database. Displays the results of the selected server’s attempts to connect to 
the database server.

➤ Ping to URL. If you want the selected server to ping a remote site, type the 
URL address, and click Check Servers.
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➤ Ping URL Status. Displays the results of the selected server pinging the listed 
URL.

➤ SiteScope Data. Displays detailed information about the server, collected by 
the SiteScope monitor. Information is displayed in this section only if 
SiteScope monitoring has been enabled (see “Servers - Properties Tab” on 
page 93).

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.

Servers - Processes Tab
The Processes tab provides detailed information about the processes and 
resource usage of the selected server. 

To kill a process, click the button in the Kill column for the process.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Server - Logs Tab
The Logs tab provides detailed information about the tasks performed on 
the selected server, the action status, and a description of any errors. 

The tab enables you to filter the information by selecting a specific time 
frame, refresh the table to view the most current tasks, and clear the log.

Click the Error Description link to view log files for the action.

To return to the Servers page:

Click the Servers link at the top of the page to return to the Servers page.
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Rebooting Servers

Performance Center enables you to remotely reboot server machines from 
the Administration Site.

Notes:

➤ The Administration Site and Database servers cannot be rebooted using 
this feature.

➤ You cannot reboot the File or Utility servers if they are in the Running 
state. You can only reboot these servers when they are idle.

To reboot servers:

 1 Select the servers you want to reboot.

 2 Click Reboot. The Reboot Servers dialog box opens.

If Performance Center is unable to reboot the machine (for example, 
because the selected server is the Administration Site server or a task is 
running on the machine), a message is displayed in the Message column.
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 3 Supply login information for all machines you want automatically logged 
on after the reboot. If you leave the fields empty, you must log on to these 
machines at startup.

Note: If you supplied login information when the machine was configured, 
it is displayed in the appropriate fields.

 4 Click Reboot. 

You can follow the progress of the reboot from the Servers page. During 
reboot, the server state changes to Rebooting and the time (MM:SS) since 
the rebooting process started is displayed. 

Uploading and Installing Patches

Performance Center allows you to upload a patch to the system and then 
install the patch on the appropriate Performance Center server machines.

The process consists of two stages: uploading the patch and installing the 
patch.

Notes:

➤ The Install Patch feature is not available for the Administration Site and 
Database servers.

➤ You cannot install patches on the File or Utility servers if they are in the 
running state. You can only install patches when these machines are idle.

➤ You should use this feature to install HP certified patches only.
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To install patches on servers:

 1 From the Servers page, select the servers on which you want to install a 
patch.

 2 Click Install Patch. The Install Patch - Step 1 dialog box opens, displaying 
any patches that were previously uploaded to the File server.

 3 If the patch you want to install is not displayed in the Existing Patches list, 
click Browse, select the patch, and click Upload. The patch is added to the 
list.
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 4 Select the patches you want to install from the Existing Patches list and click 
Next. The Install Patch - Step 2 dialog box opens.

If Performance Center is unable to install the patch (for example, because 
the selected server is the Administration Site server or a task is running on 
the machine), a message is displayed in the Message column.

 5 Type the login information for all machines.

Note: If you supplied login information when the machine was configured, 
it is displayed in the appropriate fields.
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 6 From the Install Patch - Step 2 dialog box, click Install. The installation 
process begins.

You can follow the progress of the patch install from the Servers page. When 
the patch is being transferred from the File server to the host, the server 
state is Transferring. During the patch installation, the server state is 
Installing. The percentage shows the progress of the patch transfer/
installation. If the installation fails, select the Server's Log tab and click the 
Fail to create task link to view the log file.

Note: If the log file opens in binary instead of .txt format, you should close 
the file and reopen it using Notepad.

 7 After installation is complete, Performance Center will prompt you to 
reboot the machine if a reboot is required.

To delete a patch file:

 1 From the Servers page, select the servers from which you want to delete a 
patch.

 2 Click Install Patch. The Install Patch dialog box opens and displays any 
patches that were previously uploaded to the servers.

 3 Click the Delete File button at the end of the line for the patch that you 
want to delete.

The patch is removed from the list and deleted from the File server.
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Checking Servers

You can check the connections between Performance Center servers and the 
File server and Database server. You can also check server connections to 
selected URLs.

To check servers:

 1 On the Servers page, select the servers that you want to check and click 
Check Servers. The Check Servers dialog box opens displaying a check next 
to each server. The icon next to the servers name indicates the purpose of 
the server.

By default, all the selected servers are enabled. If you not do want to check a 
server, clear that server’s check box.

Tip: Selecting/clearing the check box in the column header, selects/clears all 
the check boxes in the column respectively.

 2 If you want the selected servers to ping a remote site, type the URL address.

 3 Click Check Servers. Performance Center performs the following actions:
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➤ Ping to Host. The Administration Site server pings the selected server 
machines.

➤ File Server. The selected servers attempts to write, read, and delete from 
the file server.

➤ Database. The selected servers connects to the database server.

➤ Ping URL. The selected host pings the listed URL.

The Check Servers table displays the success or failure of the actions.

 4 Select a server to view the results of the server check. Details for each action 
are listed in the Result Status area.

 5 Click Close to close the Check Servers dialog box.
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6
Performance Center System User 

The Performance Center Administration Site server is installed with the 
System Identity Utility. Using this utility, you can manage the Performance 
Center system user (by default, IUSR_METRO) for all servers and hosts in the 
Performance Center environment from one convenient centralized location.

This chapter includes:

 ➤  About Performance Center System User on page 107

 ➤  Changing the System User on page 109

 ➤  Verifying System User on Administration Site Server on page 114

 ➤  Checking Host Status on page 117

 ➤  Remote Performance Center Server and Host Administration on page 118

About Performance Center System User

During installation of Performance Center servers and hosts, a default 
Performance Center system user, IUSR_METRO, is created in the 
Administrators user group of the server/host machines.

To prevent security breaches, you can replace Performance Center’s default 
system user by creating a different local system user, or by using a domain 
user. 

For stronger security, you can create a non-administrator Performance 
Center system user in a local group under the Users group. This system user 
has the permissions granted to any user in the Users group with extended 
rights to Web services and the HP file system and registry. 



Chapter 6 • Performance Center System User

108

With these limited permissions, such a system user cannot perform all 
administrative system tasks. You need to specify a configuration user (a user 
with administrative privileges that is defined on all the Performance Center 
servers and hosts) that Performance Center uses when administrative tasks 
are required on the system. After the tasks are complete, the system user 
reverts back to itself, with its limited Performance Center User permissions.

Note: You can save the configuration user in the database so that whenever 
an administrative-level system user is required to perform a task, the system 
automatically uses the configuration user, without asking for its credentials.

The Performance Center Administration Site server is installed with the 
System Identity Utility that enables you to manage the Performance Center 
system user on all servers and hosts in the Performance Center environment 
from one centralized location.

Using this utility, you can periodically update the Performance Center 
system user name and password. For more information, see “Changing the 
System User” below.

For information about troubleshooting the Performance Center system 
identity, see Chapter 33, “Troubleshooting System Identity.”



Chapter 6 • Performance Center System User

109

Changing the System User

You use the System Identity Utility, installed with Performance Center, to 
change the system user for all servers and hosts in the Performance Center 
environment.

When you change the system user, or a user’s password, the System Identity 
Utility updates all the Performance Center servers and host machines. 

Notes: 

➤ When changing the system user Performance Center must be down, that 
is, all users must be logged off the system and no load tests may be 
running.

➤ For Windows 2000, the login user on the Administration Site server must 
have the Act as part of the operating system policy to run this System 
Identity Utility.

Important: In the case of a domain user, when the domain IT team notifies 
you that the password is to be changed, you need to temporarily change the 
Performance Center system user on all the servers and hosts to a different 
user. After the domain IT team has changed the password of the domain 
user and has notified you of this change, you need to change the 
Performance Center system user back to the domain user on all the servers 
and hosts.
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To change the system user:

Note: The following instructions are for Windows 2000. Similar instructions 
apply to other versions of Windows but the paths may differ slightly.

 1 In the Performance Center Administration site server installation’s bin 
directory, open the System Identity Utility (<PC Admin Site Server 
Installation directory>/bin/IdentityChangerUtil.exe).

The System Identity Utility opens and displays the Performance Center 
system user name and status for all server and host machines in the 
Performance Center environment.
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Note: The System Identity Utility does not display UNIX machines, or 
machines that are located over the firewall.

 2 In the Performance Center User area: 

 a Select the type of change that you want to make to the user.

➤ Password Only. Select this option to change the current user’s 
password only. (Regarding change the password of a domain user, see 
the note before this procedure.)

➤ User. Select this option to change the Performance Center system user. 

 b Enter the required information according to the type of change you 
selected.

 c If you are changing the user, you can delete the previous user from the 
computer. To delete the previous user, select Delete Old User. 

Note: You cannot delete a domain user.

 3 In the User Group area, select the type of group to which the user is to 
belong:

➤ Administrator Group. Creates a user in the Administrators group with 
full administrator policies and permissions.

➤ Other. Creates a local group under the Users group, granting User policies 
and permissions as well as other Performance Center permissions.

If you selected Administrator Group, continue with step 5.

 4 If you are creating a non-administrator Performance Center system user, you 
need to configure a configuration user (a system user with administrative 
privileges) that the Performance Center system user can impersonate when 
it needs to perform administrative tasks (see “About Performance Center 
System User” on page 107). 

 a In the Configuration User area, enter the name and password of a system 
user that has administrator privileges on all the Performance Center 
servers and hosts. 
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 b To save the configuration user on the Performance Center database, 
select Save Configuration in Database. If you save the configuration user 
in the database, the Performance Center user automatically impersonates 
this user whenever necessary, without asking for credentials each time.

Note: For the Task Manager to perform IIS Reset, the configuration user 
must be saved in the database. 

 5 Click Apply. The utility updates all the Performance Center servers and 
hosts, starting with the Administration Site server. 

In the lower part of the utility window, the Machines table displays the 
status of each machine during the configuration process:

If the utility is unable to change the user on the Administration Site server, 
it stops the configuration, rolls back the change on that server, and issues a 
message explaining why the change cannot be made. Correct the error and 
click Apply again.

After successful configuration of the Administration site server, if the utility 
is unable to change the user on a particular server, the utilty stops, rolls back 
the change on that server, and issues a message explaining why the change 
cannot be made. Correct the error and click Reconfigure. The utility starts 
running again. 

Status Description

Configuration complete The system user configuration was completed

Needs to be configured The server/host is pending configuration

Displayed only after the Administration Site server 
configuration is complete

Configuring.... The server/host in being configured

Configuration failed The server/host configuration failed

The utility displays the reason for failure together 
with this status
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When configuration completes successfully on all the servers, Performance 
Center proceeds with the configuration of the hosts. The utility attempts to 
configure all the hosts, even if the configuration on one or more hosts is 
unsuccessful. In this case, after the utility has attempted to configure all the 
hosts, correct the errors on the failed hosts, and click Reconfigure. The 
utility runs again on the whole system. 

Note: If the configuration continues to fail, you can configure servers and 
hosts manually. However, all attempts should be made to correct errors that 
cause the configuration to fail. Manual configuration should be left as a last 
resort. For details on configuring servers and hosts manually, see 
Appendix A, “Configuring Performance Center  System User Manually.”

 6 When configuration is complete on all the servers and hosts, close the 
System Identity Utility window. 

In the Performance Center Administration Site, the name of the new user is 
displayed on the General Settings page under the Global settings.

 7 Verify that the system user was changed on the Administrator Site server as 
described in “Verifying System User on Administration Site Server” on 
page 114.

 8 If you changed the system user’s password: 

 a Check the status of all the servers. For details, see “Checking Servers” on 
page 104.  

If a red cross is displayed in the File Server column of a server, reboot the 
server. For details, see “Rebooting Servers” on page 99.

 b Check the status of all the hosts. For details, see “Checking Host Status” 
on page 117.  

If a red cross is displayed in the File Server column of a host, reboot the 
host. For details, see “Rebooting Hosts” on page 58.
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Verifying  System User on Administration Site Server

After changing the system user using the System Identity utility, verify that 
the system user was changed on the Administrator Site server. 

To verify the system user:

 1 Open Internet Information Service Manager.

 2 In the Admin directory, verify that Account used for anonymous access is  
the Performance Center user as follows:

 a Under Default Web Site, right-click Admin and select Properties.

 b In the Directory Security tab, under Anonymous access and 
authentication control, click Edit.

 c Select Anonymous access and next to Account used for anonymous 
access, click Edit.
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 d Verify that the Performance Center system user appears. If not, enter the  
Performance Center system user details.

 e Click OK to close each of the open dialog boxes.

 3 If the User Site is installed on the Admin Site server, in the LoadTest 
directory, verify that Account used for anonymous access is  the 
Performance Center user.

Repeat step 2 above in the LoadTest directory instead of the Admin 
directory.
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 4 (IIS 6.0 only) Check that the application pool identity is the Performance 
Center user.

 a Under Application pool, for each application pool in the table below, 
right-click the application pool and select Properties. 

 b In the Identity tab, under Configurable, ensure that Performance Center 
user details are defined. If not, enter the Performance Center user details.

 c Click OK.

Performance Center Machine Application Pool

Administration Site server AdminAppPool; PCWSAppPool

User Site is on Administration Site 
server

DefaultAppPool
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Checking Host Status

You can check that the system user name and password are properly 
configured on the host machines from the Check Hosts dialog box.

To check the host machines:

 1 On the Hosts page, select the hosts that you want to check and click the 
Check Hosts button. The Check Hosts dialog box opens displaying the 
selected hosts together with an icon next to the host name indicating the 
host’s purpose.  

 2 Click Check Hosts.

If the system user name and password are properly configured, green 
checkmarks are displayed in the File Server, Database, and Ping URL 
columns.

Note: To ping to a host or to a URL, the system user must be a user with 
administrator privileges.
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Remote Performance Center Server and Host 
Administration

To perform administrative tasks on Performance Center servers or hosts 
(such as adding, configuring, or resetting a Performance Center server/host), 
Performance Center must use a user with administrative privileges. This 
must be the Performance Center system user with administrative privileges 
or a configuration user.

When the Performance Center system user has administrative privileges and 
is defined on the remote machine, the task is performed upon request. 

However, in the following cases you are prompted for a configuration user:

➤ If the Performance Center system user has administrative privileges, but 
is not defined on the remote machine

➤ If the Performance Center system user does not have administrative 
privileges, and the configuration user is not saved in the database (see 
step 4 of “Changing the System User” on page 109)

Note: When the configuration user is a domain user, you must supply the 
fully qualified domain name.

After validating the Performance Center system user or configuration user, 
Performance Center can perform the required task. If the Performance 
Center system user is not defined on the remote machine, it is created at 
this point. (If the Performance Center system user is a domain user, the 
required task is performed but the user is not created on the remote 
machine.)



Chapter 6 • Performance Center System User

119

Important: If the Performance Center system user is a non-administrative 
user and the configuration user is not saved in the database, Performance 
Center prompts you for the configuration user credentials every time it 
needs to perform an administrative task. To avoid having to enter the 
credentials each time, save the configuration user in the database as 
described in step 4 of “Changing the System User” on page 109.
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7
Managing Test Runs

You can view all the test runs in the system and monitor their progress.

This chapter includes:

 ➤  About Managing Test Runs on page 123

 ➤  Test Runs Page on page 124

 ➤  Changing a Test Run State on page 128

 ➤  Deleting a Test Run on page 130

 ➤  Deallocating Hosts from a Test Run on page 131

 ➤  Deactivating the Collator Process on page 131

 ➤  Using the Fast Recovery on page 132

About Managing Test Runs

A test run is the actual execution of a load test. You can view all the test runs 
in the system to see when each test is supposed to run, whether it is 
currently running, and to which project it belongs. You can sort and filter 
the test runs according to your preferences.

During a test run, there are several stages, called states. The Test Runs page 
enables you monitor the test runs, and check the state of each run. 
Examples of test run states include Running, Before Collating Results, and 
Finished. You can change the state of a test run where necessary.
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Test Runs Page

The Test Runs page displays the test runs and the run details. To access this 
page, on the Performance Center left menu, select Site Management > 
Test Runs.

The Test Runs page includes the following components:

➤ Test Runs Table (described on page 125)

➤ Test Runs Details Pane (described on page 126)

➤ Test Runs Toolbar (described on page 127)
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Test Runs Table
Each row in the table represents a unique run. You can select the amount of 
runs to be displayed in the displaying <n> items per page list. The total 
number of all runs in the Performance Center database is displayed in 
parentheses next to page heading.

The Test Runs table includes the following columns:

➤ Run ID. The identification number of the test. This number is 
automatically generated by the system when the load test starts.

➤ Test Name. The name given to the test when it was created. 

➤ Project Name. The name of the project running the test.

➤ State. The state of the test run. If a test is stuck in a state, you can change 
it. For details, see “Changing a Test Run State” on page 128.

➤ Vusers. The total number of Vusers used in the run.

➤ User name. The name of the user who ran the test.

➤ Run Date. The date and start time of the test run.

➤ Timeslot. The ID for the test’s timeslot.

Sorting and Filtering Test Runs

You can sort the test runs in the table in ascending or descending order by 
clicking the heading of the column by which you want to sort. Click the 
column heading again to reverse the sort order.

You filter the test runs using the filter boxes below the column headings. 

Note: Sorting and filtering settings are saved per user. The next time the 
same user enters the Test Runs page, the page  displays results based on the 
most recent sort order and filter.
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To filter the test runs:

 1 In one of the filter boxes below the column headings, type the relevant text 
or select a value from the list. Press ENTER. 

The table displays test runs according to the selected filter option.

 2 You can filter these results further by entering additional filter values for 
other columns in the table. 

Notes:

➤ The filter supports partial text entries. For example, if you entered th, the 
display list might include Seth, Thomas, and Anthony. 

➤ The filter does not support regular expressions or the following 
characters: : ; & * \ ' / # ~ , ? { } $ % | < > + = ` ^ [ ] !

Test Runs Details Pane
When you select a test run from the table, the following run details are 
displayed in the details pane on the lower part of the page:

➤ Duration. The duration of the test.

➤ Max concurrent Vusers. The maximum number of concurrent virtual users 
allowed during the test run.

➤ Load Generator (Vusers). A list of the hosts used to run virtual users and the 
amount of vusers that ran on each host.

➤ Results Directory. The directory that stores the test run results. 

➤ Vusers involved. The total number of Vusers used in the run.

➤ Controller machine. The host machine used as the Controller. In the 
Performance Center system, one of the hosts is a Controller, and the others 
are load generators.

➤ Analysis Start Date. The start date and time of the analysis process. (If the 
test results analysis is not complete, the value remains empty.)
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➤ Collator Status. Indicates whether or not the collator is running. The 
collator status is defined as either Active or Inactive.

➤ State. The state of the run. You can use this list to change the run state. For 
example, you can change the state from Before Collating Results to Fatal 
Error. For more information, see “Changing a Test Run State” on page 128.

Test Runs Toolbar
You use the toolbar buttons to perform actions on the selected runs.

Note: You can refresh the data on the page by clicking the Refresh button 
on the top right side of the page. You can also set the auto-refresh frequency 
by selecting the relevant frequency from the Automatic refresh list.

Function Button Enables You To

View event log 
for run

See the Event Log filtered by the Run ID. For more 
information about the event log, see “Managing 
Events” on page 147.

Delete Delete the selected test run. For more information, 
see “Deleting a Test Run” on page 130.

Deallocate 
Host

Detach all hosts that are allocated to a particular test 
run. For more information, see “Deallocating Hosts 
from a Test Run” on page 131.

Deactivate 
Collator 
process

Deactivate the collating process. See “Deactivating 
the Collator Process” on page 131.

Fast Recovery Terminate the test run, free up all the system 
resources, and reset the run state to Before Collating 
Results. For information about when to use this 
option, see “Using the Fast Recovery” on page 132.
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Changing a Test Run State

Changing the state of a test run provides a great deal of flexibility for 
running and processing your tests.

Changing the state of the test run is another way to handle a frozen test. For 
example, if the test is stuck in the Running state, you can change to the 
Before Collating Results state. Since the Before Collating Results state occurs 
after the Running state, by changing the test to this new state, you have 
placed the test at a point beyond the problem. The test restarts and proceeds 
to the end of the test.

To change the state of a test run:

 1 Select the relevant run from the test runs table.

 2 In the details pane, select the appropriate state from the State list.

➤ To revert back to the original state, click Restore.

➤ To save your changes to the state, click Save.

Note: The change state option is not available when the run is in one of the 
following states: Running, Collating, Stopping, Creating Analysis Data, or 
Deleting Temporary Results. 
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Understanding Test Run States

Knowing the flow of states allows you to change a test’s state to the 
appropriate position. Use the following flowchart to study the relationship 
between states. 
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When viewing the flowchart, note the following:

➤ The Active state is a temporary state indicating that the system is 
performing an operation.

➤ The Non-Active state is a static state which only changes when the user 
performs an action.

Deleting a Test Run

You can delete test runs from Performance Center. This is useful for deleting 
old runs that no longer need monitoring. 

The delete option is not available when the run is in one of the following 
states: Running, Collating Results, Stopping, Creating Analysis Data, or 
Deleting Temporary Results. 

To delete a test run:

Select the test run you want to delete, and click the Delete button located in 
the toolbar. The test run is deleted from the database and file server, and is 
no longer displayed in the table.
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Deallocating Hosts from a Test Run

You can detach all the hosts that are allocated to a particular test run. You 
should do this if a host is stuck in the Running status after the test is 
finished.

To deallocate hosts from a test run:

 1 In the test runs toolbar, click the Deallocate Hosts button. The Deallocate 
Hosts dialog box opens.  

 2 Specify the type of host you are deallocating (Load Generator or Analysis) 
and click OK.

 3 A dialog box opens confirming the host’s deallocation. Click Close to close 
the dialog box.

Deactivating the Collator Process

When a run seems to be stuck during collation (for example, if collating the 
run is taking a lot longer than usual) you can manually deactivate the 
collator process. 

Note: The option to deactivate the collator process is only enabled when the 
Collator Status, as indicated in the details pane, is Active.
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To deactivate the collator process for the run:

 1 Select the relevant run from the test runs table.

 2 In the test runs toolbar, click the Deactivate Collator process button. 

The Deactivate Collator dialog box opens.

 3 Click OK to confirm that you want to deactivate the collator process. 

A dialog box opens confirming that the process was deactivated.

 4 Click Close to close the dialog box.

Using the Fast Recovery

Important: The fast recovery option should only be used if the test is frozen 
and unable to continue, for example, if the host connection fails and the 
processing cannot continue for a particular run.

You use the fast recovery option to free up all the system resources, stop the 
test run, and resets the run state to Before Collating Results.

Notes:

➤ To access this option, users need to be assigned with Fast recovery 
permissions.

➤ This option is only enabled when the state of the run, as indicated in the 
details pane, is Running, Stopping, or Ready.

To perform a fast recovery:

 1 Select the relevant run from the test runs table.

 2 In the test runs toolbar, click the Fast Recovery button. 
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8
Managing Timeslots

From the Administration Site, you can monitor timeslot reservations.

This chapter includes:

 ➤  About Managing Timeslots on page 133

 ➤  Understanding the Timeslots Page on page 134

 ➤  Viewing Timeslot Allocations on page 134

 ➤  Viewing Timeslot Availability on page 137

About Managing Timeslots

When a user creates a load test from the Performance Center User Site, the 
user specifies how many hosts the test requires and reserves the necessary 
number of hosts for a specific time period. The availability of the required 
hosts for a specific time period is called a timeslot, and the user is said to 
have reserved a timeslot.

From the timeslots page, you can see details of all timeslot reservations and 
how many hosts remain available for any given timeslot. You can also view 
information about which projects are reserving resources from the same 
host pool. If necessary, you can delete reservations.
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Understanding the Timeslots Page

Select Site Management > Timeslots to open the Timeslots page. The page 
has the following views:

➤ Timeslots Table View. Displays details for currently reserved timeslots. For 
more information, see “Viewing Timeslot Allocations” on page 134.

➤ Resources Availability Table View. Displays the distribution of resources over 
any time period. For more information, see “Viewing Timeslot Availability” 
on page 137.

Viewing Timeslot Allocations

You view information about currently reserved timeslots from the Timeslots 
Table and the Timeslot details sections.

Understanding the Timeslots Table
The Timeslots Table displays details of all reserved timeslots. You use the 
table to see which projects have reserved which timeslots, and how many 
machines and Vusers are reserved for each timeslot.

To specify a date range for which to view timeslots, use the browse buttons 
adjacent to the Show timeslots from and to boxes. Then click Go to update 
the table according to your selection.
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The Timeslots Table displays the following information:

➤ ID. The identification number of the timeslot.

➤ Project Name. The name of the project.

➤ User Name. The name of the user.

➤ From Time, To Time. The start and end times of the timeslot. Due to the 
Autostart feature, the start and end times are displayed in half- and 
whole-hour increments. For details on Autostart, see the section in the HP 
Performance Center User’s Guide that describes viewing Autostart load tests.

➤ Machines. The number of host reserved for the test that runs during the 
timeslot.

➤ Vusers. The number of Vusers reserved for the test that runs during the 
timeslot.

Note: The Vusers column is displyed only if Vuser Scheduling is enabled in 
the General Settings. For details, see Chapter 13, “Configuring General 
Settings.”

➤ Host Pool. The host pool assigned to the project. The project is allocated 
hosts from that pool only. For details, see “Understanding the Host Pools 
Page” on page 81.

➤ Run ID. The ID of the load test using the timeslot. This number is 
automatically generated by the system when the load test starts.

There is also a Delete button displayed for each timeslot. For more 
information, see “Deleting a Timeslot” on page 136
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Viewing Timeslot Details
You view details about reserved timeslots in the Timeslot Details pane. 

When you select a timeslot in the Timeslots Table, the Timeslots details 
pane displays the following information:

➤ Duration. The total length of time (in hours) reserved for the timeslot.

➤ Load Test. The name of the load test.

➤ Post-run Analysis. The post-run analysis option selected in the Options tab 
of the Timeslots page. For details, see the section in the HP Performance 
Center User’s Guide that describes configuring post-run Analysis settings.

➤ Run Vusers on Controller. Specifies whether the load test is configured to 
run Vusers on the Controller machine. For details, see the section in the HP 
Performance Center User’s Guide that describes running Vusers on the 
Controller.

➤ Machines. The names of the hosts assigned to the load test. If no hosts were 
specified when the timeslot was reserved, a message is displayed.

➤ Comments. Users can add comments when they reserve a timeslot. When a 
timeslot is selected, comments for that timeslot are displayed.

You can sort the Timeslots Table according to the values of any column. The 
arrow in the heading displays whether the column is sorted in ascending or 
descending order. Click the column heading to reverse the order.

Deleting a Timeslot
To delete a timeslot reservation, select a timeslot and click the 
corresponding Delete button. The timeslot is removed from the table. 

Note: You can delete future timeslots only.
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Viewing Timeslot Availability

To display the distribution of resources over any time period, you click the 
Switch to Resources Availability Table link at the top of the Timeslots page 
to open the Resources Availability Table.

The table displays how many resources are available to a selected project for 
a specific timeslot.

The Resources Availability table contains the following elements:

➤ Time on Server. The current date and time according to the server.

➤ Total Load Generators in selected project(s). The number of load generator 
hosts available in the selected projects, and therefore, the maximum 
number of hosts that could be available for the project at any one time.

➤ Total Vusers in selected project(s). The number of Vusers available in the 
selected projects, and therefore, the maximum number of Vusers that could 
be available for the project at any one time.

Note: The Vusers column is displyed only if Vuser Scheduling is enabled in 
the General Settings. For details, see Chapter 13, “Configuring General 
Settings.”
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Filtering the Resources Availability Table
You define the date range and projects for which to show timeslots as 
follows:

To filter the Resources Availability table:

 1 Specify the date range for which you want to view resource availability in 
the View availability for dropdown lists. The table provides access to 
timeslot information over a twelve month range (the six previous, and six 
future months).

 2 Select the project for which you want to view resource availability.

 3 Click Go to show available timeslots for the selected filter criteria.

The table is divided into half-hour timeslots displayed over a seven day 
period. Each timeslot is represented by a rectangle. Place the mouse cursor 
over a timeslot for a tooltip that displays exact resource availability details 
for that timeslot.

Resource availability is displayed in the table as follows:

➤ Available. All resources are available for the timeslot.

➤ No resources. There are no resources available.

➤ Reserved (When all projects selected). Some resources for this timeslot 
have been reserved. The tooltip displays the number of remaining 
available resources.

➤ Reserved by this project (When single project selected). Resources for 
this timeslot have been reserved by the selected project. The tooltip 
displays the number of remaining available resources.

➤ Reserved by other projects (When single project selected). Resources for 
this timeslot have been reserved by other projects. The tooltip displays 
the number of remaining available resources.

➤ Reserved by this and other projects (When single project selected). 
Resources for this timeslot have been reserved by the selected project and 
by other projects. The tooltip displays the number of remaining available 
resources.
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Viewing Timeslot Details
You view details about resource and host pool usage for any selected 
timeslot in the Timeslot Details pane below the Resources Availability Table.

The information displayed in the Timeslot Details pane varies, depending 
on whether all projects or a single project is selected in the Resources 
Availability table.

➤ For information on viewing timeslot details for a single project, see 
“Viewing Timeslot Details for a Single Project” on page 139.

➤ For information on viewing timeslot details for all projects, see “Viewing 
Timeslot Details for all Selected Projects” on page 141.

Viewing Timeslot Details for a Single Project

The Timeslot Details pane shows a breakdown of resource and host pool 
status information for the selected project in the Resources Availability 
Table. The information is displayed for the timeslot selected in the Resources 
Availability Table.

The Resource Status Table (Single project selected)

When a single project in selected the Resources Availability Table, the 
Resource Status table displays the following information:

➤ Resource. The resource name.

➤ License Limit. The Performance Center license for the resource.

➤ Project Limit. The maximum number of the resource allowed for the 
selected project as defined in project settings (User Management > Projects). 

➤ Host Pool Limit. The number of machines in the host pool assigned to the 
project.
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➤ Reserved - other projects. The amount of the resource reserved by other 
projects in the system. For Machines, only projects in the same host pool are 
taken into account.

➤ Reserved - this project. The amount of the resource reserved by the selected 
project.

➤ Available to this project. The amount of the resource that is available.

Host Pool Status (Single project selected)

The Host Pool status section of the Timeslot Details pane displays 
information for the host pool assigned to the selected project.

➤ The Total Hosts row displays the number of different host types available in 
the host pool. 

➤ The Reserved Hosts row displays the number of reserved hosts for each type.

The Breakdown per project table displays a list of all projects which are 
using various host pool resources. 
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Viewing Timeslot Details for all Selected Projects

When all projects are selected in the Resources Availability Table, the 
Timeslot Details pane shows a breakdown of resource and host pool status 
information for all the projects in system. The information is displayed for 
the timeslot selected in the Resources Availability Table.

The Resource Status Table (All projects selected)

When all projects in the system are selected in the Resources Availability 
Table, the Resource Status table displays the following information for the 
selected timeslot.

➤ Resource. The resource name.

➤ License Limit. The Performance Center license for the resource.

➤ Reserved - all projects. The amount of the resource reserved by all projects 
in the system. 

➤ Available. The amount of the resource that is available.

Host Pool Status (All projects selected)

The Host Pool status section of the Timeslot Details pane displays 
information for all the projects in the system for the selected timeslot. 

The first row displays the number of different host types available in the 
host pool. The second row displays the number of reserved hosts for each 
type.
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9
Autostart Viewer

The Autostart Viewer provides information about load tests with autostart 
for all projects. Along with the general information provided in the main 
table, you can access status reports on tests that have run, and cancel tests 
that are scheduled to run. 

The Autostart Viewer gives information about tests scheduled to autostart. 
The actual scheduling of the autostart is done in the Timeslots page, while 
the configuring of the test is done when you create a new load test. For 
details on scheduling and configuring the autostart, see the HP Performance 
Center User’s Guide.

This chapter includes:

 ➤  The Autostart Viewer at a Glance on page 144

 ➤  Viewing Autostart Load Test Reports on page 146
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The Autostart Viewer at a Glance

To open the Autostart Viewer, On the Performance Center left menu, select 
Site Management > Autostart Viewer. The Autostart Viewer opens.

The Autostart Viewer displays a table of information on all tests scheduled 
to autostart, navigation arrows for the table, and a link to the Autostart Load 
Tests report.

The table supplies the following information:

➤ ID. A unique number identifying the autostart load test.

➤ Date and Time. The date and time of the timeslot you reserve when you 
schedule a test to autostart.

➤ Project Name. The name of the project.

➤ User Name. The name of the user who scheduled the test.

➤ Test Name. The name of the test that is scheduled to autostart. This is the 
same name that was given when the test was created.
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➤ Status. The status of the autostart test. Some of the information (Scheduled 
to run, Failed to Run, Insufficient Resources) is specific for the autostart 
status, other information describes the tests’ status in the test workflow. For 
more information on the test workflow, see “Changing a Test Run State” on 
page 128. Click an entry in the Status column to open the Autostart Load 
Test Report.

➤ Duration. The duration of the test scheduled to autostart, as defined when 
reserving the timeslot.

➤ Hosts. The number of hosts assigned to the autostart test, as defined when 
reserving the timeslot.

➤ Vusers. The number of Vusers assigned to the autostart test, as defined when 
reserving the timeslot. 

Note: Autostart tests that have not yet started their run can be canceled by 
clicking the X in the Delete column. Deleting an entry from the Autostart 
Viewer report releases the reserved timeslot.

Sorting Tests
When you open the Autostart Load Tests report, the tests are sorted on the 
Date and Time key. You can also sort the tests according to the Project 
Name, User Name, Test Name or # Hosts.
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Viewing Autostart Load Test Reports

The Autostart Load Test report displays an overview of load test performance 
and a table of the autostart actions.

To view the Autostart Load Test report:

In the Autostart Viewer report, click a link in the Status column. The 
Autostart Load Test report for that test opens. 

You can view and access the following information in the Autostart Load 
Tests report:

➤ Load Test performance information. The information includes the start of 
the run, Vuser information, the Controller of the load test, and the names of 
any additional hosts.

➤ Autostart Test actions. This information reports on the autostart aspect of 
the test run, not on the actual running of the load test. The table gives a step 
by step list of the progress of the test. This information includes the start 
time, the initialization time, and the end time of the test.

The Time column supplies the date and time of the action, while the Status 
column supplies a self-explanatory note of the action performed or the 
problem the test encountered.
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Managing Events

In case of an event during a test run, you can see a description of the event 
and its source in the Event Log page. An event can be informational or 
generated by an error. 

This chapter includes:

 ➤  Viewing the Event Log on page 148

 ➤  Filtering and Sorting Events on page 150
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Viewing the Event Log

The Event Log page displays all the events, reporting the source and severity 
of each event, as well as showing which host and test run it occurred on, 
and the time it occurred.

To view events:

On the Performance Center left menu, select Site Management > Event Log. 
The Event Log page opens: 

The following information is displayed for each event:

➤ ID. The identification number of the event.

➤ Time. The time the event was recorded.

➤ Description. A description of the event.

➤ Event. An internal identifier for the event.

➤ Source. The system element where the event originated.
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➤ Severity. The severity of the event (Info, Error, Fatal Error).

➤ Run ID. The identification number of the test run.

➤ Host. The host from which the event was generated.

The page also displays:

➤ Total Events in Database. The total number of events in the system.

➤ Export Event Log. Prepares and downloads a text file of all the events that 
occurred in the past week or of all the events in the log.

To prepare and export an event log:

 1 Click the Export Event Log button. The Export Event Log dialog box opens. 

 2 Choose the desired time period and click OK. The event log is prepared for 
download and the size of the download file is displayed.

 3 Click Download, and choose the location to save the file.

 4 Click Close to close the Export Event Log dialog box.
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Filtering and Sorting Events

You can use the filter lists to display a specified subset of the events. In 
addition, you can sort the events according to the values in any column 
whose heading is underlined.

To filter the display:

 1 From one or more of the filter lists, select filtering options.

➤ Time. Displays only test runs that ran within a specified time period. 

➤ Severity. Displays test runs with specific severity levels.

➤ Host. Displays test runs that were performed on a specified host.

➤ Run ID. Displays test runs with a specific run ID.

 2 Click Go. The table displays test runs specified by the selected filtering 
options.

To sort the events:

➤ Click an underlined column heading of your choice. A downward facing 
arrow is displayed next to the column heading. The events are sorted in 
descending order of the values in that column.

When you click the heading again, the arrow reverses direction, and the 
events are sorted in ascending order of the values in that column.
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11
Introducing System Configuration

You configure and view license key information, general settings, HP 
Diagnostics (J2EE and .NET), server configuration information, server 
authentication details, and email alerts from the System Configuration 
pages of the Performance Center Administration Site.

Important: If you are performing the initial system configuration, the 
Performance Center system user must have administrative privileges. For 
more information on performing the initial system configuration, see the 
HP Performance Center System Configuration and Installation Guide.

➤ License page. You can view your Performance Center and host license 
details in the License page. The Performance Center license, which is 
required for using the entire product and running load tests, provides details 
of your Vuser limit, concurrent runs limit, and expiry date. You can view 
these details, and update your license key number from this page. The 
Performance Center host license allows access to different kinds of protocols 
and monitors.

➤ General Settings page. This page provides information about the system 
configuration. On this page, you can set the time zone, the alert threshold, 
the auto-refresh rate, and the autostart options.

➤ Diagnostics page. Use this page to set up the ERP/CRM and J2EE/.NET 
Diagnostics modules to generate transaction breakdown data for ERP/CRM 
and J2EE/.NET environments. 
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➤ Server Configuration page. This page provides details as to where key 
components of Performance Center are located. 

➤ Authentication Server page. From this page you configure the Performance 
Center server authentication information.

➤ Alerts page. From this page you define alert conditions and set email 
preferences.
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12
Configuring and Viewing License 
Information

You configure and view license key information from the System 
Configuration pages of the Performance Center Administration Site.

This chapter includes:

 ➤  Viewing License Information on page 155

 ➤  License Types on page 159

Viewing License Information

You can view your Performance Center license and host license details, and, 
if necessary, update your license key number from the License page.

The Performance Center License enables you to use the product and run 
load tests. It provides details of your Vuser limit, concurrent runs limit, 
expiry date, and the license key. 

➤ Vuser Limit. The maximum number of Vusers a project can run at once. The 
total number used by all of the project's concurrent load tests must not 
exceed this maximum.

➤ Concurrent Runs Limit. The maximum number of concurrent runs allowed 
within a project.

➤ Valid. Displays the time limitation of the license key.

➤ License Key. The Performance Center license key.
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The Host License allows you to access the Vuser protocols and server 
monitors that are available for the specified host license key. For more 
information on the licenses available for Performance Center, see “License 
Types” on page 159.

To view the License page:

On the Performance Center left menu, select System Configuration > 
License. The License page opens. 
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To update your Performance Center license key:

 1 On the Performance Center Administation Site left menu, select System 
Configuration > License. The License page opens.

 2 Under Performance Center License, click Set New License. The Set License 
dialog box opens. 

 3 Type the new Performance Center license key.

 4 Click OK to set the new license key. Performance Center checks the validity 
of the license key and closes the dialog box.

To verify that the set license action was successful, refer to the log at the 
bottom of the page.
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To update the host license key:

 1 On the Performance Center Administation Site left menu, select System 
Configuration > License. The License page opens.

 2 Under Host License, click Set New License. The Set License dialog box 
opens. 

 3 Type the new host license key.

 4 Click OK to set the new license key. Performance Center checks the validity 
of the license key and closes the dialog box.

Performance Center updates the host license on all the relevant host 
machines. To verify that the set license action was successful, refer to the log 
at the bottom of the page.

The license is not updated on the following machines because they do not 
require a Host license:

➤ Load generators located over a firewall

➤ UNIX machines

➤ Standalone load generators
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License Types

There are two types of licenses available for Performance Center:

➤ Regular. This type of license is limited by time and by the total number of 
concurrent runs and Vusers.

➤ VUD–based. This type of license is limited by the total number of Vusers 
that you can run concurrently during a Virtual User Day (VUD). A VUD 
license enables you to use the product an unlimited number of times within 
a period of 24 hours. After that time, the remaining number of Vusers equals 
the total number of licensed Vusers minus the maximum number of Vusers 
that ran concurrently that day.

For example, a user has a VUD-based license for a total of 1000 Vusers and 
creates a test that uses 200 hundred Vusers and lasts for forty-five minutes. 
The user runs the test at 8:00 AM, 10:00 AM, 2:00 PM, and 4:00 PM. In each 
case, the test finishes before the new one begins. Since there is no 
concurrent use, 200 VUDs are deducted at the end of the day, leaving 800. 

Let’s say however, that the user starts the second run of the day at 8:30 AM. 
In this case, the first test does not complete the run before the second test 
initializes. There are now 400 Vusers running concurrently. At the end of the 
day, 400 VUDs are deducted because that is the highest number of 
concurrent Vusers. The total left for future use is now 600 VUDs.
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13
Configuring General Settings

You view and configure general settings from the System Configuration 
pages of the Performance Center Administration Site.

The General Settings page provides information about the system 
configuration. For example, you can set the time zone, the alert threshold, 
the autostart options, and the Performance Center maintenance services.

This page also provides read-only information, such as the upload directory 
path and the temporary graph directory.

This chapter includes:

 ➤  Viewing General Settings on page 161

Viewing General Settings

To view the General Settings page:

On the Performance Center left menu, select System Configuration > 
General Settings. The General Settings page opens.
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You can view the following General Settings, and update any editable 
settings in the boxes provided.

Global Settings

➤ Upload Directory. Specifies the path to the directory to which virtual user 
(Vuser) scripts are uploaded.

➤ Temporary Graph Directory. Specifies the path to the directory in which 
analysis graphs are stored. 

➤ Time Zone. Specifies the time zone used by the server (default is PST). You 
select the string that you want displayed within the Performance Center 
system.

➤ License VUD Alert Threshold. Specifies the threshold for issuing a VUD 
license alert. A VUD license limits the total number of Vusers that can be 
run concurrently within a period of 24 hours. The default alert setting is 
5000 Vusers. 

➤ PC System User. Specifies the name of the Performance Center user. To 
change the system user, see “Changing the System User” on page 109.

➤ Performance Center Installation Name. (Optional) Specifies the name of the 
Performance Center installation. 

Autostart Settings

➤ Maximum Number of Autostart Retries. Specifies the maximum number of 
attempts allowed by the Autostart mechanism to start a load test in case of 
failure.

➤ Autostart Retries Interval (min). Specifies the interval, in minutes, that the 
Autostart mechanism waits between retry attempts.
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Project Settings

➤ Use Routing. Enables projects to use configured target IPs (which prevent 
targeting load tests outside the run scope). For more information, see “Using 
IP Addresses” on page 277. Select Enable to enable use of target IPs (default) 
or select Disable to disable their use. 

➤ Vuser Scheduling. Enables users to schedule and reserve Vusers in the 
Timeslots page. Select Enable to enable use of Vuser Scheduling, or select 
Disable to disable use. By default, Vuser Scheduling is set to Enable.

When Vuser scheduling is disabled, Performance Center  validates each 
Vuser as it starts running in a load test. When you enable Vuser scheduling, 
you improve load test performance because the Vusers are validated before 
the load test and Performance Center does not need to validate the Vusers 
during the run. 

Note: If you attempt to change this setting, Performance Center performs a 
test to see if there are any autostart tests scheduled or future timeslots 
reserved. If there are, Performance Center displays an alert that you must 
delete all autostart tests and cancel all future timeslots before changing this 
setting.

➤ Collate Timeout. Specifies the maximum length of time (in minutes) to wait 
for collating results. Performance Center issues an error message about the 
timeout, and recommends that you increase the timeout value.

➤ Diagnostics Collate Timeout. Specifies the maximum length of time (in 
minutes) to wait for collating diagnostics results. Performance Center issues 
an error message about the timeout, and recommends that you increase the 
timeout value.

➤ Delete Temporary Results. Enables automatic deletion of temporary result 
files from the load generator and controller after a successful collation and/
or analysis. This option is selected by default.
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System Check Settings

➤ Host Checkup Service. Enables Performance Center to detect hosts in the 
Resource Failure state and, if possible, recover them to Operational. Select 
Enable to enable use of the Host Checkup Service (default), and to specify 
the checkup service frequency and the number of consecutive host resource 
failures before the service is discontinued, or select Disable to disable use. 

Note: Host recovery currently supports only Controllers and load generators 
installed on Windows machines for an English environment, and only load 
generators installed on Windows machines for a non-English environment.

➤ IIS Maintenance Service. Enables Performance Center to verify that IIS is 
operational and to restart IIS if necessary. Running tests are unaffected when 
IIS is restarted. It also restarts Performance Center when its memory limit is 
reached. Select Enable to enable use of the IIS Maintenance Service (default) 
and to specify the service frequency and Application Memory limit, or select 
Disable to disable use. 

➤ Restart IIS Daily. Enables Performance Center to restart IIS at a set time every 
day. Restarting IIS increases Performance Center stability and is highly 
recommended. Running tests are unaffected when IIS is restarted, and users 
can reconnect to tests and view progress. Select Enable to enable use of 
Restart IIS Daily (default) and to specify restart time, or select Disable to 
disable use.
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14
Configuring Server Information

You supply, view and edit Server details from the Performance Center 
Administration Site.

This chapter includes:

 ➤  About Server Configuration on page 167

 ➤  Viewing and Editing Server Configuration Information on page 167

About Server Configuration

The Server Configuration page provides details as to where key components 
of Performance Center are located. You can use the Server Configuration 
page for mapping information, to establish where information should be 
stored and from where it should be retrieved.

The first time you log on to the Administration Site, you are automatically 
redirected to this page.

Viewing and Editing Server Configuration Information

You can view and edit server configuration information at any time from 
the Server Configuration page. 
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Note: To perform server configuration, the Performance Center system user 
must have administrative privileges. 

To view and edit server configuration information:

 1 On the Performance Center left menu, select System Configuration > 
Server Configuration. The Server Configuration page opens. The first time 
you log on to the Administration Site, you are automatically redirected to 
this page.
 

The Database information and File Server name are supplied during the 
product installation and are displayed as read-only. 

You can click Test Connection to test the connection to the database.
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Important: For all servers that you specify in the following steps, it is 
recommended to provide the name of the machine, rather than the IP 
address.

 2 In the Utility Server box, enter the name of the Utility Server machine.

 3 In the User Site Servers section, in the first Name box, enter the name of the 
User Site server machine. 

If you want to balance the load on your Performance Center system, you 
can enter the name of additional User Site servers in the remaining Name 
boxes.

 4 If you want use SiteScope to monitor your Performance Center resources, 
enter the relevant values for the SiteScope server.

➤ SiteScope Server. Enter the name of the SiteScope server.

➤ SiteScope Port. Enter the SiteScope port (default:8888).

➤ Use HTTPs. Select this option to use a Secure HTTP connection.

➤ Use Account. By default, Performance Center connects to SiteScope using 
the default SiteScope Administrator user. If the default SiteScope 
Administrator password was changed, or if you want to connect using a 
different SiteScope user, select this option. Enter the account name, and 
the user name and password defined to log in to the relevant SiteScope 
account. 

Note: The administrator account name is administrator. For details about 
how to identify other SiteScope account names, see “Identifying the 
SiteScope Account Name” on page 170.

 5 Click Save to save the server configuration settings.

To update the server connections, click Reset.
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Identifying the SiteScope Account Name
This section describes how to identify the Sitescope account name for a 
particular SiteScope user.

To identify a SiteScope account name:

 1 Log on to SiteScope as follows: <SiteScope server>:8888/sitescope.

 2 Click the Preferences button, and then select the Users link.

 3 The User Profiles page shows a table that displays the Login URL associated 
with each user name. Inside the Login URL you can identify the account 
name. In the above example, the account name for the user, TestUSer is 
login1.



171

15
Configuring Diagnostics

You configure and view HP Diagnostics from the System Configuration 
pages of the Performance Center Administration Site.

This chapter includes:

 ➤  Setting Up Diagnostics Modules on page 171

 ➤  Configuring ERP/CRM Mediators on page 172

 ➤  Setting Up the HP Diagnostics (J2EE & .NET) Environment on page 174

Setting Up Diagnostics Modules

You set up the Performance Center J2EE/.NET and ERP/CRM diagnostics 
modules from the Diagnostics page of the Administration Site.

You configure the ERP/CRM Diagnostics modules by defining the mediators 
that communicate with the Load Testing Server. For more information, see 
“Configuring ERP/CRM Mediators” on page 172.

You configure the J2EE/.NET Diagnostics module by defining the J2EE/.NET 
Diagnostics server environments. For more information, see “Setting Up the 
HP Diagnostics (J2EE & .NET) Environment” on page 174.

Before setting up the diagnostics modules, if you are monitoring over a 
firewall, make sure that you perform the following:

➤ Install an MI Listener on a machine outside of the firewall. For 
installation instructions, see the HP Performance Center System 
Configuration and Installation Guide.
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➤ Define the MI Listener in the MI Listeners page. For information on 
defining MI Listeners, see Chapter 3, “Managing MI Listeners.”

Note: MSXML 3.0 (this is included in Internet Explorer 6.0) should be 
installed on the client. You can install MSXML 3.0 from the Microsoft 
MSDN Web site (http://msdn.microsoft.com/library/default.asp?url=/downloads/
list/xmlgeneral.asp).

Configuring ERP/CRM Mediators

To generate Siebel/Oracle/SAP diagnostics data, you must set up the Siebel/
Oracle/SAP diagnostics module to communicate with the mediators. 

Before setting up the Siebel/Oracle/SAP Diagnostics modules make sure that 
you have installed an ERP/CRM mediator in the same LAN as the monitored 
Siebel/Oracle/SAP server. For installation instructions, see the HP 
Performance Center System Configuration and Installation Guide. 

http://msdn.microsoft.com/library/default.asp?url=/downloads/list/xmlgeneral.asp
http://msdn.microsoft.com/library/default.asp?url=/downloads/list/xmlgeneral.asp
http://msdn.microsoft.com/library/default.asp?url=/downloads/list/xmlgeneral.asp
http://msdn.microsoft.com/library/default.asp?url=/downloads/list/xmlgeneral.asp
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To set up the ERP/CRM mediators:

 1 On the Performance Center left menu, select System Configuration > 
Diagnostics. The Diagnostics page opens.

 2 To add a new mediator to the Mediators list, click Add Mediator. The Add 
Mediator dialog box opens.
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Type the name of a new mediator.

If you are monitoring over a firewall, select Enable Firewall. 

Note: Before you can add a mediator over the firewall, you need to define an 
MI Listener in the MI Listeners page. For details, see “MI Listeners for 
Monitoring Over a Firewall” on page 75.

 3 Click OK. The new mediator is added to the list of mediators and the 
following properties are displayed: 

➤ Name. The name of the mediator used to collect and process the 
diagnostics data.

➤ Over Firewall. Yes denotes that monitoring over firewall is enabled. No 
denotes that monitoring over firewall is not enabled.

➤ Status. The connection status between the Web server (Admin) and the 
mediator. The possible statuses are: Test passed, Test failed, and Testing 
connection. 

 4 To test the connection between the Web server (Admin) and the mediator, 
select a mediator and click Test. The Web server attempts to connect to the 
mediator. The connection status is displayed.

If the test fails, the Error Details button is displayed. Click the button for 
details of the error.

 5 To delete a mediator, select it in the list of mediators and click Delete.

Setting Up the HP Diagnostics (J2EE & .NET) Environment

You can view or edit information about the HP Diagnostics (J2EE and .NET) 
application host from the Diagnostics page. 

Before you can use HP Diagnostics with Performance Center, you need to 
ensure that you have specified Diagnostics Server details on the Diagnostics 
page in the Performance Center Administration Site. 
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Adding Diagnostics Servers to Performance Center
You can specify any number of Diagnostics Servers in Performance Center. 

When you design a Performance Center project to work with HP 
Diagnostics, you assign one of these Diagnostics Servers to the project. For 
more information see “Managing Project Information” on page 274.

To add the details of a Diagnostics Server:

 1 On the Performance Center left menu, select System Configuration > 
Diagnostics. The Diagnostics page opens.

 2 In the Setting J2EE/.NET Environment section near the bottom of the  page, 
click Add diagnostics server.

 3 Enter the details for the Diagnostics Server in Commander mode.

➤ Alias. Provide an alias for the Diagnostics Server.

➤ Host Name. Enter the name of the machine that is host to the 
Diagnostics Server.

➤ Port Number. Enter the port number used by the Diagnostics Server. The 
default port number is 2006.

➤ User Name. Enter the user name with which you log on to HP 
Diagnostics. The default user name is admin.

➤ Password. Enter the password with which you log on to HP Diagnostics. 
The default password is admin.

The user name that you specify should have view, change and execute 
privileges. For more information about user privileges, see the HP 
Diagnostics Installation and Configuration Guide.

➤ Use SSL. If Performance Center is communicating with Diagnostics 
through SSL, select this option.

 4 Click OK. The  Diagnostics Server is added to the Diagnostics page.

 5 To test the connectivity of the Diagnostics Server, select it in the list and 
click Test. The connectivity status is displayed in the Status column.
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To edit Diagnostics Server details:

 1 On the Performance Center left menu, select System Configuration > 
Diagnostics. The Diagnostics page opens.

 2 In the Setting J2EE/.NET Environment section near the bottom of the  page, 
select the Diagnostics Server to edit and click Edit.

 3 Edit the details and click OK. 

 4 To test the connectivity of the Diagnostics Server, select it in the list and 
click Test. The connectivity status is displayed in the Status column.
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16
Configuring Server Authentication

This chapter describes configuring authentication details for logging on to 
Performance Center. When you install Performance Center, the default 
authentication details required to log on to Performance Center are those of 
a Performance Center user. 

To log on to Performance Center through an LDAP or SSO server, you need 
to configure the appropriate authentication details.

This chapter includes:

 ➤  LDAP Server Authentication on page 178

 ➤  SSO Server Authentication on page 183

 ➤  Restoring Default Performance Center Server Authentication on page 191
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LDAP Server Authentication

When you install Performance Center, the default authentication required is 
that of a Performance Center user. To log on to Performance Center through 
an LDAP server, you need to configure the LDAP server authentication 
details in Performance Center. After configuring these details, the next time 
you log on to Performance Center, you provide the LDAP user credentials 
instead of Performance Center user credentials.

Before you begin, you must obtain the LDAP server authentication details 
from the LDAP system administrator. 

Configuring the LDAP server authentication details in Performance Center 
is described in the steps below.

Note: If the LDAP server is configured to run in secure mode, you need to 
install the SSL certificate on the Performance Center Web servers—both on 
the Administration site and User site servers. 

➤ Install the certificate in the Certificates Console of the local computer, 
under the Trusted Root Certification Authorities category.

➤ When configuring the LDAP server authentication below, the LDAP 
server name must be identical to the LDAP server name in the 
certificate’s Issued To field.
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Step 1: Create a Performance Center user that is identical to a 
valid LDAP user.

Ensure that there is Performance Center user whose user name matches that 
of a valid LDAP user. The Performance Center user must be an active 
(non-expired) user, and must have the following permissions:

➤ Manage Servers 

➤ Create/Edit/Delete Users

➤ Create/Edit/Delete Roles

➤ Assign Users to Roles 

➤ Remove User from Roles

Note: Contact the LDAP system administrator to obtain the name of a valid 
LDAP user. 

If there is no user in Performance Center that matches a valid LDAP user, 
you need to create one. To create a Performance Center user, see “Adding 
Performance Center Users” on page 242.
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Step 2: Configure the LDAP server authentication.

Configure the LDAP server authentication in Performance Center. 

Note: You must obtain the LDAP server authentication details from the 
LDAP system administrator before you begin this procedure. 

After configuring Performance Center to use LDAP server authentication, 
when you log on to Performance Center, enter the LDAP user credentials.

To configure Performance Center to use LDAP server authentication:

 1 On the Performance Center left menu, select System Configuration > 
Authentication Server. The Authentication Server page opens.

 2 Select LDAP Server Authentication. 

 3 In the LDAP Server and Port boxes, type the LDAP server name and port 
number.

Note: When connecting to the LDAP server in secure mode:

➤ The LDAP server name must be identical to the LDAP server name in the 
SSL certificate’s Issued To field

➤ The Port must be a secured port

 4 Select the name of the LDAP Server vendor: Sun One or Active Directory.

➤ If the vendor is Sun One:

In the Base Distinguish Name box, type the full base distinguished name 
of the root directory on the LDAP server where all the LDAP users that 
need to access Performance Center are maintained. 

For example: 

ou=People,dc=mercury,dc=co,dc=il
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➤ If the vendor is Active Directory:

In the Users’ AD Domain box, type the fully qualified domain name on 
the LDAP server where all the LDAP users that need to access 
Performance Center are maintained. 

For example: 

Important: The LDAP users that need to access Performance Center must all 
be defined under the same Sun One tree or in the same Active Directory 
domain. Otherwise they are not recognized and Performance Center returns 
an error when attempting to log on.

 5 In the Unique User Attribute box, type the unique user attribute defined on 
the LDAP server—for example, uid or cn.

If the LDAP vendor is Active Directory, continue with step 7.

 6 If the LDAP vendor is Sun One, you need to select a user that can perform 
any type of search on the LDAP server. Depending on the configuration of 
the LDAP server, select one of the User for LDAP Search options, as follows:

➤ Use anonymous user. This can be any anonymous user. An anonymous 
user can run a search on the LDAP server only if the LDAP server is 
configured to allow this.

➤ Use other user. This must be a specified LDAP user who has search 
privileges on the LDAP server. When a search is requested on the LDAP 
server, only the user specified here can perform the search. 

Type the full base-distinguished user name and password for this LDAP 
user, and confirm the password by typing it in again.

 7 If you want to connect to the LDAP server in secure mode, select Enable SSL.

Note: If you enable SSL, the LDAP port must be a secured port.

DEVLAB.AD.HP
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 8 The Local PC Username list displays of all the active, non-expired 
Performance Center users. 

 a Select the user that matches a valid LDAP user. If there is no such user in 
this list, you must create one, as described in Step 1 of this procedure 
on page 179.

 b In the Local PC Password box, type the password of the selected 
Performance Center user.

 9 Click Save to save the LDAP authentication details.

➤ If the details provided are validated, Performance Center logs off and 
displays the login page. When you log on to Performance Center again, 
use the LDAP authentication details.

➤ If the details provided are invalid, Performance Center displays an error 
and the configuration is not saved. Try to configure the authentication 
again. If the configuration does not succeed, contact the LDAP system 
administrator.

Step 3: Enter the LDAP users into the Performance Center 
Database.

After logging on to Performance Center through the LDAP server, all the 
LDAP users that need to access Performance Center must be added to the 
Performance Center database. Add the users in the Users page, as described 
in “Adding Performance Center Users” on page 242. The login user names 
given to the users must be identical to the login user names on the LDAP 
server.

Note: When you add LDAP users to the Performance Center database, the 
Password and Confirm Password fields are disabled. All users with Locked 
status become Active.
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SSO Server Authentication

When you install Performance Center, the default authentication 
credentials required to log on to the system are those of a valid Performance 
Center user. To log on to Performance Center through an SSO server, you 
need to configure SSO server authentication details in Performance Center. 
After this configuration, the next time you log on to Performance Center, 
you must provide the SSO user credentials.

Note: Performance Center supports SSO server authentication for SSO 
systems that allow all characters in HTTP requests—that is, if the SSO 
server’s CSSA feature has not been enabled.

Configuring the SSO server authentication details in Performance Center is 
described in the steps below.

Step 1: Configure the SiteMinder Policy Server and WebAgents.

Set up the SiteMinder Policy Server to communicate with the IIS Web servers 
where the Performance Center Administration and User sites are installed. 

To set up the Policy Server:

 1 In SiteMinder, set up the Policy Server for the installation of the WebAgent 
clients.

 2 Install the WebAgent clients on the IIS Web servers where the Performance 
Center Administration and User sites are installed. 

 3 On the Policy Server, configure the Web Agent details. 

 4 On the Policy Server, define the security policies for the Performance Center 
Administration site and User site resources.

In SiteMinder, these security policies are called realms and should be 
defined for each Performance Center server as follows:
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➤ Administration site server resources:

➤ User site server resources:

 5 In the LogoffURI field, enter the URL to which to direct the browser when 
logging off Performance Center. Enter the URL as follows:

➤ If all the SSO system servers are set up with a specified logoff URL, enter 
this URL in the LogoffURI field for the Performance Center 
Administration site server, and for each of the Performance Center User 
site servers.

Resource Filter Authentication Scheme
Default Resource 
Protection

/Admin HTML Form Template Protected

/Admin/Include/GetSession HTML Form Template Unprotected

/Admin/MemorySize HTML Form Template Unprotected

/Admin/Include/
ASPXSessionBridge 

 HTML Form Template Unprotected

/Admin/General/ASPNetBridge  HTML Form Template Unprotected 

/Admin/Include/SetSession  HTML Form Template Unprotected

Resource Filter Authentication Scheme
Default 
Resource 
Protection

/Loadtest HTML Form Template Protected

/Loadtest/Include/GetSession HTML Form Template Unprotected

/Loadtest/RequestDispatcher Basic Template Protected

/Loadtest/MemorySize HTML Form Template Unprotected

/Loadtest/Include/
ASPXSessionBridge 

 HTML Form Template Unprotected

/Loadtest/General/ASPNetBridge  HTML Form Template Unprotected 

/Loadtest/Include/SetSession  HTML Form Template Unprotected
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➤ If Performance Center is to use an internal logoff URL:

➤ If the Administration and User sites are installed on different servers, 
then for each server in the LogoffURI field, enter SSOLogoutPage.asp.

➤ If the Administration and User sites are installed on the same server, 
then in the LogoffURI field, enter:  

Step 2: Log on to Performance Center and configure the SSO 
server authentication settings in Performance Center.

When the WebAgents are installed on the Performance Center server, 
logging on to Performance Center requires the single-sign-on credentials. 

To log on to Performance Center and configure the SSO server 
authentication:

 1 Navigate to the Performance Center site. Because of the security policies you 
defined in Step 1 above, the SSO server login page opens, requesting the 
SSO credentials.

 2 Enter the SSO credentials, as provided by the SiteMinder administrator. The 
Performance Center Administration site login page is displayed. 

Note: At this point the Policy Server creates a cookie with the SSO 
credentials and sends it back to local drive where it is saved. 

The cookie remains valid for a period of time defined in the Policy Server 
configuration. While it is valid, any time you try to access one of the 
Performance Center resources in the domain, the relevant WebAgent checks 
for the valid credentials in the cookie and allows you to access the resources 
without requesting authentication credentials.

After this period, the cookie is erased from your local drive, and you must 
enter the SSO authentication credentials again.

 3 Log on to the Performance Center Administration site using the 
Performance Center user’s login credentials. 

/Admin/SSOLogoutPage.asp
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 4 Ensure that there is a Performance Center user whose user name matches 
that of a valid SSO user. The Performance Center user must be an active 
(non-expired) user, and must have the following permissions:

➤ Manage Servers 

➤ Create/Edit/Delete Users

➤ Create/Edit/Delete Roles

➤ Assign Users to Roles 

➤ Remove User from Roles

Note: Contact the SSO system administrator to obtain the name of a valid 
SSO user. 

If there is no user in Performance Center that matches a valid SSO user, you 
need to create one. To create a Performance Center user, see “Adding 
Performance Center Users” on page 242.

 5 On the Performance Center left menu, select System 
Configuration > Authentication Server. The Authentication Server page 
opens. 

 6 Scroll down the page, and select SSO Server Authentication.

 7 In the Login Parameter box, enter the HTTP header that contains the user’s 
mapping key (see step 9 below).



Chapter 16 • Configuring Server Authentication

187

 8 In the Logout URL box, enter the URL to which to direct the browser when 
logging off Performance Center. Enter the URL as follows.

➤ If all the SSO system servers are set up with a specified logoff URL, in the 
Logout URL box enter the fully qualified name of that URL you entered 
in the LogoffURI field in the SiteMinder configuration (in Step 1 of this 
procedure above).

➤ If Performance Center is to use an internal logoff URL:

➤ If the Administration and User sites are on different servers, in the 
Logout URL box enter the default logoff URL, SSOLogoutPage.asp.

➤ If the Administration and User sites are on the same server, in the 
Logout URL box enter

 9 Under User’s Mapping select one of the following: 

➤ Map users according to user's login name. Maps the user login name in 
Performance Center to that on the SSO system server.

➤ Map users according to user's custom field. Maps the user’s custom field 
in Performance Center to the same field on the SSO system server. 

If you select this option, enter the following parameters to create an 
initial link between the Performance Center database and the SSO system 
server:

➤ Local PC Username. Select a Performance Center user from the list. 

The Performance Center user must be an active (non-expired) user, 
and must have the following permissions:

➤ Manage Servers 

➤ Create/Edit/Delete Users

➤ Create/Edit/Delete Roles

➤ Assign Users to Roles 

➤ Remove User from Roles

http://<machine_name/Admin/SSOLogoutPage.asp
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Important: The login name of the selected Performance Center user 
must be identical to the login name of a valid SSO user. If it does not 
match a valid SSO user, Performance Center displays an error. 

To configure a valid user, you must log on to the Performance Center 
server using the default Performance Center authentication and 
reconfigure the SSO server authentication. To do this, you need to 
restore the default authentication. For details, see “Restoring Default 
Performance Center Server Authentication” on page 191.

➤ Local PC Custom Field. Enter the custom field value of the matching 
SSO user.

For example, if you selected the user’s email address to be the 
mapping field (in the Login Parameter box—step 7 above), enter the 
email address of the SSO user that matches the Performance Center 
user that you selected here. 

 10 Click Save to save the SSO authentication details. Performance Center 
automatically closes.

Step 3: Log on to Performance Center.

Open Performance Center. The non-expired cookie containing the SSO 
credentials allows you to go straight into the Performance Center sites, 
without requesting authentication credentials.

Step 4: Add the SSO users to the Performance Center database.

All the SSO users that need to access Performance Center must be added to 
the Performance Center database. 

Add the users in the Users page, as described in “Adding Performance Center 
Users” on page 242.
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Important: 

➤ If, when defining the SSO Authentication Server details above, you 
selected Map users according to user's login name, enter the exact SSO 
user (login) name into new Performance Center user’s User Name box.

➤ If, when defining the SSO Authentication Server details above, you 
selected Map users according to user's custom field, in the User 
Information (Add mode) form a new mandatory field, Custom Field, 
appears. This field constitutes the mapping field between the user in the 
Performance Center database and the SSO user. The Custom Field value 
that you enter for the new Performance Center user must be identical to 
value defined for that user on the SSO server. 
For example, if you selected the user’s email address to be the mapping 
field (in the Login Parameter box—step 7 above), enter the email address 
of the SSO user in the Custom Field box.

Note: When you add SSO users to the Performance Center database, the 
Password and Confirm Password fields are disabled. All users with Locked 
status become Active.
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Connecting to Performance Center in SSO Authentication 
Mode from a Standalone Application
When you are working with a standalone application, and you want to 
connect to Performance Center in SSO authentication mode, you need to 
log on with valid SSO credentials. The SSO server authenticates the user, 
creates a cookie, and sends the cookie back to the standalone application 
host where it is saved. Then the user is authenticated by Performance 
Center. 

The SSO server creates an SSO cookie when: 

➤ The user is authenticated by SSO and by Performance Center

➤ The user is authenticated by SSO, but not in Performance Center (user 
not active, user expired, and so on)

The cookie that is saved on the host of the standalone application remains 
valid as long as the application is running. As soon as the application is 
closed, the cookie is removed.

Important: To log on to Performance Center with a different user name, you 
need to close the standalone application and re-invoke it. As mentioned 
above, closing the application removes the SSO cookie from the 
application’s host. This prevents a user mismatch when you try to log in 
with a different user name.
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Restoring Default Performance Center Server 
Authentication

When Performance Center is configured for LDAP or SSO server 
authentication, you can revert back to the default Performance Center 
authentication at any time, or you may be forced to restore the default 
authentication due to connection problems.

Reverting to Default Authentication
You can revert back to default Performance Center server authentication 
from the Authentication Server page. 

To revert back to the default server authentication:

 1 On the Performance Center left menu, select System Configuration > 
Authentication Server.

 2 Select PC Server Authentication, and click Save.

Note: Reverting back to the default Performance Center server 
authentication through the Authentication Server page resets all the users’ 
passwords to welcome.
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Restore Default Authentication Method Utility
If you are experiencing problems logging on to Performance Center with the 
LDAP or SSO server authentication configuration, you need to restore 
Performance Center authentication using the Restore Default 
Authentication Method utility, provided on the Performance Center 
installation disk. After restoring default authentication, you can log on to 
Performance Center using default Performance Center authentication 
credentials, and reconfigure the relevant server authentication.

To run the Restore Default Authentication Method utility:

 1 From the root folder of the Performance Center installation disk, copy 
\Additional Components\Unlock Utility\PCAuthentciationModeUtility.exe 
to a local drive on your computer.

 2 Run PCAuthentciationModeUtility.exe from the local drive.

The Restore Default Authentication Method utility opens. 

 3 Enter the Database Server name.

 4 Enter the type of Database Server—MS-SQL or Oracle.

 5 Enter the Database Server login credentials. You can accept the default 
credentials, or enter customized credentials. 

To customize the Database Server login credentials, select Customized 
Database Login, and enter the user name and password of the Performance 
Center database user.

Note: The Performance Center database user must have admin privileges.

 6 Click Restore Default Authentication Method. The Performance Center 
server authentication is restored. 
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17
Configuring Alerts

You configure and view email alerts from the System Configuration pages of 
the Performance Center Administration Site.

Performance Center uses alerts to let you know when server performance 
problems occur during a load test. The alerts provide real-time information 
about your server performance. Alerts are triggered whenever one of the 
measurements monitored by SiteScope is out of the defined range (memory, 
CPU, or disk space), or when a service that is supposed to run is not 
running. 

When configuring SiteScope, you specify the frequency at which alerts 
should be sent when an event is detected, and the email addresses to which 
the alert is to be sent. In addition, a warning that system performance is less 
than optimal or that not all services are running is indicated by a colored 
light (other than green) in the Hosts/Servers page. You define alert 
frequency and email preferences from the Alerts Configuration page. 

Note: You must configure the SiteScope server on the Server Configuration 
page before you can configure an alert. For more information, see 
Chapter 14, “Configuring Server Information.”
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To configure email alerts:

 1 On the Performance Center left menu, select System Configuration > 
Alerts Configuration. The Alerts Configuration page opens.

 2 Select one of the following Alert Frequency options: 

➤ Once. This sends an alert once, after the event occurs.

➤ Every X time(s) that event occurs. Type the number of times that the 
event must occur before sending an alert. This sends an alert after the 
event has occurred the specified number of times.

➤ Each time that event occurs. This sends an alert each time the event 
occurs.

➤ Never. An alert is never sent.

 3 Under Initial Alert trigger, type the number of times an event of this type 
must occur before sending an initial alert.
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 4 Under E-mail Account Configuration, enter the following information:

➤ Alert E-mail Address. Type the email addresses where the alert is to be 
sent. You can enter multiple email addresses, separated by commas.

➤ Mail Server Domain Name. Type the mail server domain name.

➤ Backup Mail Server Domain Name. Type the backup mail server domain 
name. 

➤ From E-mail Address. Type the email address from where the alert is 
generated.

 5 Under Administrator Status Reports, enter the following information:

➤ Administrator E-Mail Address. Type the email address of the 
administrator.

➤ SiteScope Status Messages. You can select the following SiteScope status 
messages:

➤ Daily Status. Provides daily status updates on the SiteScope server.

➤ SiteScope Starts/Restarts. Provides information on the SiteScope 
server starts and restarts.

 6 Click Save to save your settings.
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Understanding Performance Center 
Reports

The Reports section of the Administration Site provides you with an overall 
analysis of Performance Center site users, resource usage, concurrent 
resource usage vs. license limitations, timeslot usage, as well as resource 
usage by duration and runs.

This chapter includes:

 ➤  About Reports on page 199

 ➤  Working With Reports on page 200

About Reports

➤ The Site Users Report provides detailed user information, including the 
projects that each user can access, user privilege levels, user status, and user 
expiration dates. For more information, see Chapter 19, “Site Users Report.”

➤ The Resource Summary Report provides aggregate data regarding the way 
projects used the various resources of the system. For more information, see 
Chapter 20, “Resource Summary Report.”

➤ The Concurrency vs. License Report provides details of concurrent resource 
usage per project, as well as information regarding how resources were used 
within license limitations. For more information, see Chapter 21, 
“Concurrency vs. License Report.”

➤ The Timeslot Usage Report provides information about the reservation and 
usage of resources associated with timeslots. For more information, see 
Chapter 22, “Timeslot Usage Report.”
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➤ The Resource by Duration Report provides details of resource usage on a 
per-project or per-user basis, measured over time. For more information, see 
Chapter 23, “Resource by Duration Report.”

➤ The Resource by Runs Report provides aggregate details of runs on a 
per-project or per-user basis. For more information, see Chapter 24, 
“Resource by Runs Report.”

Working With Reports 

This section describes working with the Performance Center reports.

Setting Report Filter Criteria
In order to display a report, you must first set the filter criteria. The filter 
criteria define which projects are to be included in the report and over 
which time frame to display results.

To set the filter criteria:

 1 Click the browse button adjacent to the Projects box. The project selection 
dialog box opens.

The dialog box displays a list of available projects. By default, all the projects 
are selected. You can filter the list using the filter box above the list. The 
filter supports partial text entries. 
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 2 Use the arrow buttons to select single or multiple projects from the list. To 
select or deselect all the projects simultaneously, you click the double arrow 
buttons.

Note: You must select at least one project to generate a report.

 3 Select the desired time frame from the Time Frame drop down list. In 
addition to the given options, you can set a custom time frame.

Note: The time frames are as follows:

➤ Today. From 00.00 to 23.59 of the current day.

➤ Yesterday. From 00.00 to 23.59 of the previous day.

➤ This week. From Monday to Sunday of the current week.

➤ Previous week. From Monday to Sunday of the previous week.

➤ This month. From beginning to end of the current calendar month

➤ Previous month. From beginning to end of the previous calendar month.

➤ This quarter. The current quarter.

➤ Previous quarter. The previous quarter.

➤ This year. From January to December of the current year.

➤ Previous year. From January to December of the previous year.

 4 Click Generate. The report displays the information for the selected projects 
and time frame.

Note: The project and time range filters do not appear in the Site Users 
Report.
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Exporting Reports
You can export the reports to PDF, or to editable Excel files.

➤ To export a report to a PDF file, click the Export to PDF icon in the upper 
right corner of the report.

➤ To export a report to an editable Excel file, click the Export to Excel icon in 
the upper right corner of the report.
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Site Users Report

The Site Users report displays a complete list of users in the Performance 
Center system. The Site Users report specifies the total number of users in 
the system, and provides information on each user’s project access, privilege 
level, status, and expiration date. 

This chapter includes:

 ➤  Understanding the Site Users Report on page 203

 ➤  Exporting the Report on page 204

Understanding the Site Users Report

The Site Users Report displays information for the total number of users in 
the Performance Center system.

To open the Site Users Report:

On the Performance Center left menu, select Reports > Site Users. The Site 
Users Report opens.
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Select the Include expired Users check box to include expired, as well as 
current users in the report. Then click Generate to update the report.

The Site Users report displays the following information:

➤ Full Name. The user’s real name.

➤ User Name. The user’s Performance Center user name.

➤ E-mail. The users e-mail address.

➤ Container. The container the user is assigned to. For more information on 
Containers, see Chapter 27, “Managing User Privileges.”

➤ Role. The roles required of the user in it’s container. For more information 
on Roles, see Chapter 27, “Managing User Privileges.”

➤ Status. The status of the user in the Performance Center system. The status 
can be Locked, Active or Not Active. A user with a Not Active status cannot 
log on to the system. For information on changing a user’s status, see 
Chapter 25, “User Management.” 

➤ Expires. The user’s account expiration date.

Note: Users that have been assigned more than one role or container appear 
more than once in the Site Users Report. Each role/container combination is 
shown as a separate entry. 

Sorting Results
You can sort the Site Users Report according to the values of any column. 
The arrow in the heading displays whether the column is sorted in 
ascending or descending order. Click the column heading to reverse the 
order.

Exporting the Report

You can export the Site Users Report to a PDF, or to an editable Excel file. For 
more information, see “Exporting Reports” on page 202.
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Resource Summary Report

The Resource Summary Report provides aggregate data regarding the way 
projects used the various resources of the system. You access the Resource 
Summary Report from the Performance Center left menu 
(Reports > Resource Summary).

This chapter includes:

 ➤  Resource Usage by Project Table on page 206

 ➤  Top Projects by Machines Graph on page 207

 ➤  Top Projects by Runs Graph on page 208

 ➤  Top Projects by Vusers Graph on page 209

 ➤  Exporting the Report on page 209
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Resource Usage by Project Table

The Resource Usage by Project table provides information about resource 
usage information for each selected project.

On the Resource Summary Report page, you click the Resource Usage by 
Project tab. The Resource Usage by Project table is displayed.

The table displays the following information:

➤ Project. The project name. Deleted projects are also included in the report.

➤ Tests. The number of load tests in the project.

➤ Runs. The total number of test runs in the project, aggregated over all the 
tests.

➤ Vusers. The total number of Vusers in the project, aggregated over all the 
runs.

➤ Machines. The total number of machines that were used in the project, 
aggregated over all the runs.

➤ Duration. The total time tests were run in the project.

Sorting Results
You can sort the Resource Usage by Project table according to the values of 
any column. The arrow in the heading displays whether the column is 
sorted in ascending or descending order. Click the column heading to 
reverse the order.
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Top Projects by Machines Graph

The Top Projects by Machines graph displays the number of machines used 
per project. 

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same number of 
machines, all these projects are displayed. In that case, more than ten 
projects might be displayed.

On the Resource Summary Report page, you click the Top Projects by 
Machines tab. The Top Projects by Machines graph is displayed.
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Top Projects by Runs Graph

The Top Projects by Runs graph displays the number of test runs per project. 

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same number of 
test runs, all these projects are displayed. In that case, more than ten 
projects might be displayed.

On the Resource Summary Report page, you click the Top Projects by Runs 
tab. The Top Projects by Runs graph is displayed.
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Top Projects by Vusers Graph

The Top Projects by Vusers graph displays the number of Vusers per project. 

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same number of 
Vusers, all these projects are displayed. In that case, more than ten projects 
might be displayed.

On the Resource Summary Report page, you click the Top Projects by Vusers 
tab. The Top Projects by Vusers graph is displayed.

Exporting the Report

You can export the Resource Summary Report to a PDF, or to an editable 
Excel file. For more information, see “Exporting Reports” on page 202.
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Concurrency vs. License Report

The Concurrency vs. License Report provides details of concurrent resource 
usage per project, as well as information regarding how system resources 
were used within license limitations. You access the Concurrency vs. License 
Report from the Performance Center left menu 
(Reports > Concurrency vs. License).

This chapter includes:

 ➤  Concurrency by Project Table on page 212

 ➤  Overall Concurrency Table on page 214

 ➤  Overall License Usage Graph on page 215

 ➤  Top Projects by Runs Graph on page 216

 ➤  Top Projects Vusers Graph on page 218

 ➤  Exporting the Report on page 219
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Concurrency by Project Table

The Concurrency by Project table displays concurrent resource usage 
information for each selected project.

On the Concurrency vs. License Report page, you click the Concurrency by 
Project tab. The Concurrency by Project table is displayed.

The table contains the following information:

➤ Project. The project name. Deleted projects are also included in the report.

➤ Concurrent Runs Max. The maximum number of concurrent test runs for 
the project. For the purposes of this report, a single test run is considered a 
concurrent run.

➤ Concurrent Runs Average. The average number of concurrent test runs for 
the project. For the purposes of this report, a single test run is considered a 
concurrent run.

➤ Concurrent Runs Limit. The maximum number of concurrent runs allowed 
for this project as defined in the project settings (User Management > 
Projects). For the purposes of this report, a single test run is considered a 
concurrent run.

➤ Concurrent Vusers Max. The maximum number of concurrent running 
Vusers in all of the project’s concurrent test runs.

➤ Concurrent Vusers Average. The average number of concurrent running 
Vusers in all of the project’s concurrent test runs.

➤ Concurrent Vusers Limit. The maximum number of concurrent Vusers 
allowed for this project as defined in the project settings (User Management 
> Projects).
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➤ Concurrent Machines Max. The maximum number of concurrent running 
machines (controllers and load generators), in all of the project’s concurrent 
test runs.

➤ Concurrent Machines Average. The average number of concurrent running 
machines (controllers and load generators), in all of the project’s concurrent 
test runs.

➤ Concurrent Machines Limit. The maximum number of concurrent machines 
allowed for this project as defined in the project settings 
(User Management > Projects).

➤ Overall Duration. The total time tests were run in the project. This value 
shows the actual amount on time the system was used to run load tests, and 
not concurrent duration.

Sorting Results
You can sort the Concurrency by Project table according to the values of any 
column. The arrow in the heading displays whether the column is sorted in 
ascending or descending order. Click the column heading to reverse the 
order.
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Overall Concurrency Table

The Overall Concurrency table displays concurrent resource usage 
information aggregated over all selected projects, as well as aggregated over 
all projects in the system.

On the Concurrency vs. License Report page, you click the Overall 
Concurrency tab. The Overall Concurrency table is displayed.

The table contains the following information:

➤ Project. All Projects or Selected Projects.

➤ Concurrent Runs Max (License %). The maximum number of concurrent 
runs. The value in brackets is the maximum number of concurrent runs as a 
percentage of the Performance Center license.

➤ Concurrent Runs Avg (License %). The average number of concurrent runs. 
The value in brackets is the average number of concurrent runs as a 
percentage of the Performance Center license.

➤ Concurrent Runs PC License. The maximum number of concurrent runs 
allowed by the Performance Center license.

➤ Concurrent Vusers Max (License %). The maximum number of concurrent 
running Vusers. The value in brackets is the maximum number of 
concurrent running Vusers as a percentage of the Performance Center 
license.

➤ Concurrent Vusers Avg (License %). The average number of concurrent 
running Vusers. The value in brackets is the average number of concurrent 
running Vusers as a percentage of the project Performance Center license.

➤ Concurrent Vusers PC License. The maximum number of concurrent 
running Vusers allowed by the Performance Center license.
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➤ Concurrent Machines Max (License %). The maximum number of 
concurrent running machines. The value in brackets is the maximum 
number of concurrent running machines as a percentage of the Performance 
Center license.

➤ Concurrent Machines Avg (License %). The average number of concurrent 
running machines. The value in brackets is the average number of 
concurrent running machines as a percentage of the Performance Center 
license.

➤ Overall Duration. The total time tests were run aggregated over all the 
projects.

Overall License Usage Graph

The Overall License Usage Graph displays maximum and average Runs and 
Vuser usage as a percentage of the Performance Center license limitations. 
The usage is aggregated over all selected projects, as well as aggregated over 
all projects in the system.

For example, in the image below, the maximum number of Vusers for all 
projects in the system used just 30.1% of the Performance Center license, 
while the average number of Vusers for all projects used just 3.6% of the 
license. This tells the administrator that a significant portion of the 
Performance Center license is not being used. 
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On the Concurrency vs. License Report page, you click the Overall License 
Usage tab. The Overall License Usage is displayed.

Top Projects by Runs Graph

The Top Projects by Runs graph shows those projects that best used the 
amount of concurrent runs that were designated to them. To display the 
graph, click the Top Projects by Runs tab. The Top Projects by Runs graph is 
displayed.

The graph shows the maximum and average number of concurrent runs per 
project as a percentage of the project limit, which is defined in the project 
settings (User Management > Projects). The projects are displayed in 
descending order according to the maximum amount of concurrent runs.
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For example, in the image shown below, the Max - Runs value for the 
project LR_pro is 30%. This means that the maximum number of concurrent 
runs for this project reached 30% of its limit. The Avg - Runs value for this 
project shows that the average number of concurrent runs reached 12.7% of 
its limit. These values tell the administrator that a significant portion of the 
project’s defined limit of concurrent runs is not being utilized.

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same number of 
maximum concurrent runs, all these projects are displayed. In that case, 
more than ten projects might be displayed.
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Top Projects Vusers Graph

The Top Projects by Vusers graph shows those projects that best used the 
amount of concurrent running Vusers that were designated to them. To 
display the graph, click the Top Projects by Vusers tab. The Top Projects by 
Vusers graph is displayed.

The graph shows the maximum and average number of concurrent running 
Vusers per project as a percentage of the project limit, which is defined in 
the project settings (User Management > Projects). The projects are 
displayed in descending order according to the maximum amount of 
concurrent running Vusers.

For example, in the image shown below, the Max - Vusers value for the 
project proj1 is 10%. This means that the maximum number of concurrent 
running Vusers for this project reached 10% of its limit. The Avg - Vusers 
value for this project shows that the average number of concurrent running 
Vusers reached 8.4% of its limit. These values tell the administrator that a 
significant portion of the project’s defined limit of concurrent running 
Vusers is not being utilized.
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In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same number of 
maximum concurrent running Vusers, all these projects are displayed. In 
that case, more than ten projects might be displayed.

Exporting the Report

You can export the Concurrency vs. License Report to a PDF, or to an 
editable Excel file. For more information, see “Exporting Reports” on 
page 202.
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Timeslot Usage Report

The Timeslot Usage Report provides information about the reservation and 
usage of resources associated with timeslots. You open the Timeslot Usage 
Report from the Performance Center left menu (Reports > Timeslot Usage).

This chapter includes:

 ➤  Timeslot Usage by Project Table on page 221

 ➤  Top Projects by Duration Usage Graph on page 223

 ➤  Top Projects by Vusers Usage on page 224

 ➤  Top Projects by Machines Usage Graph on page 225

 ➤  Exporting the Report on page 225

Timeslot Usage by Project Table

The Timeslot Usage by Project table displays reservation and usage 
information for Duration, Machines, and Vusers per project.

On the Timeslot Usage Report page, you click the Timeslot Usage by 
Projects tab. The Timeslot Usage by Projects table is displayed.
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The table displays the following information:

➤ Project. The project name. Deleted projects are also included in the report.

➤ Duration Reserved. The amount of time reserved for the project.

➤ Duration Used. The amount of time used within the project.

➤ Machines Reserved. The number of machines reserved for the project.

➤ Machines Used. The number of machines used in the project.

➤ Vusers Reserved. The number of Vusers reserved for the project.

➤ Vusers Used. The number of Vusers used in the project.

Sorting Results
You can sort the Timeslot Usage per Project Table according to the values of 
any column. The arrow in the heading displays whether the column is 
sorted in ascending or descending order. Click the column heading to 
reverse the order.
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Top Projects by Duration Usage Graph

The Top Projects by Duration Usage graph displays reservation and usage 
information for timeslot Duration per project. The projects are displayed in 
descending order according to Duration usage.

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same amount of 
Duration usage, all these projects are displayed. In that case, more than ten 
projects might be displayed.

On the Timeslot Usage Report page, you click the Top Projects by Duration 
Usage tab. The Top Projects by Duration Usage graph is displayed.
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Top Projects by Vusers Usage

The Top Projects by Timeslot Usage by Vusers graph displays reservation and 
usage information for timeslot Vusers per project. The projects are displayed 
in descending order according to Vusers usage.

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same amount of 
Vusers usage, all these projects are displayed. In that case, more than ten 
projects might be displayed.

On the Timeslot Usage Report page, you click the Top Projects by Vusers 
Usage tab. The Top Projects by Vusers Usage graph is displayed.
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Top Projects by Machines Usage Graph

The Top Projects by Machines Usage graph displays reservation and usage 
information for timeslot Machines per project. The projects are displayed in 
descending order according to Machines usage.

In most circumstances, the graph displays information for up to ten selected 
projects. If there is more than one selected project with the same amount of 
Machines usage, all these projects are displayed. In that case, more than ten 
projects might be displayed.

On the Timeslot Usage Report page, you click the Top Projects by Machines 
Usage tab. The Top Projects by Machines Usage graph is displayed.

Exporting the Report

You can export the Timeslot Usage Report to a PDF, or to an editable Excel 
file. For more information, see “Exporting Reports” on page 202.
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Resource by Duration Report

The Resource by Duration Report provides general information about the 
usage of your system resources over the selected time frame. You can view 
statistics for total usage by project, or per user within a project. You open the 
Resource by Duration Report from the Performance Center left menu 
(Reports > Resource by Duration).

This chapter includes:

 ➤  Resource Usage by Project table on page 227

 ➤  Resource Usage by User table on page 229

 ➤  Exporting the Report on page 230

Resource Usage by Project table

The Resource Usage by Project table shows resource usage per project over 
the selected time frame.

On the Resource by Duration Report page, you click the Resource Usage by 
Project tab. The Resource Usage by Project table is displayed.
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The Resource Usage by Project table contains the following information:

➤ Project. The name of the project. Deleted projects are also included in the 
report.

➤ Total Active Duration. The total time tests were run during reserved 
timeslots.

➤ Total Reserved Duration. The total time reserved, in the Timeslots page, by 
the project.

➤ Avg Hosts per Active Hour. The average number of hosts used per active 
hour.

➤ Avg Vusers per Active Hour. The average number of running Vusers per 
active hour.

Note: An active hour/duration refers to the actual running time of your tests 
within the selected time frame.

Sorting Results
You can sort the Resource Usage by Project table according to the values of 
any column. The arrow in the heading displays whether the column is 
sorted in ascending or descending order. Click the column heading to 
reverse the order.
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Resource Usage by User table

The Resource Usage by User table shows resource usage per user.

Note: Only users with privileges in selected projects are shown.

On the Resource by Duration Report page, you click the Resource Usage by 
User tab. The Resource Usage by User table is displayed.

The table contains the following information:

➤ Full Name. The name of the user. Deleted users are also included in the 
report.

➤ Total Active Duration. The total time tests were run during reserved 
timeslots.

➤ Total Reserved Duration. The total time reserved, in the Timeslots page, by 
the user.

➤ Avg Hosts per Active Hour. The average number of hosts used per active 
hour.

➤ Avg Vusers per Active Hour. The average number of running Vusers per 
active hour.

Note: An active hour/duration refers to the actual running time of your 
tests.
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Sorting Results
You can sort the Resource Usage by User table according to the values of any 
column. The arrow in the heading displays whether the column is sorted in 
ascending or descending order. Click the column heading to reverse the 
order.

Exporting the Report

You can export the Resource by Duration Report to a PDF, or to an editable 
Excel file. For more information, see “Exporting Reports” on page 202.
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Resource by Runs Report

The Resource by Runs report provides general information about the test 
runs. You can view statistics for total usage by project, or per user within a 
project. You open the Resource by Runs Report from the Performance Center 
left menu (Reports > Resource by Runs).

This chapter includes:

 ➤  Resource Usage by Project Table on page 231

 ➤  Resource Usage by User Table on page 233

 ➤  Exporting the Report on page 234

Resource Usage by Project Table

The Resource Usage by Project table shows test run statistics per project over 
the selected time frame.

On the Resource by Runs Report page, you click the Resource Usage by 
Project tab. The Resource Usage by Project table is displayed.
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The Resource Usage by Project table displays the following information:

➤ Project. The name of the project. Deleted projects are also included in the 
report.

➤ Total Runs. The total number of runs in the project.

➤ Total Vusers Involved. The total number of Vusers in the project.

➤ Avg Vusers per Run. The average number of Vusers used per run.

➤ Total Duration. The total time used by the listed runs.

➤ Avg Duration per Run. The average time used for the listed runs.

➤ Avg Machines per Run. The average number of machines used per run.

Note: Details of all runs with any amount of duration, even retries of a 
single run, are included in the table.

Sorting Results
You can sort the Runs per Project table according to the values of any 
column. The arrow in the heading displays whether the column is sorted in 
ascending or descending order. Click the column heading to reverse the 
order.
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Resource Usage by User Table

The Resource Usage by User table shows test run statistics per user.

Notes:

➤ Runs of users that have been deleted from the system, or no longer have 
any privileges are also included in the table.

➤ Details of all runs with any amount of duration, even retries of a single 
run, are included in the table.

On the Resource by Runs Report page, you click the Resource Usage by User 
tab. The Resource Usage by User table is displayed.

The Resource Usage by User table contains the following information:

➤ Full Name. The name of the user. Deleted users are also included in the 
report.

➤ Total Runs. The total number of runs associated with the user.

➤ Total Vusers Involved. The total number of Vusers associated with the user.

➤ Avg Vusers per Run. The average number of Vusers used per run.

➤ Total Duration. The total time used by the listed runs.

➤ Avg Duration per Run. The average time used for the listed runs.

➤ Avg Machines per Run. The average number of machines used per run.
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Sorting Results
You can sort the Runs per User table according to the values of any column. 
The arrow in the heading displays whether the column is sorted in 
ascending or descending order. Click the column heading to reverse the 
order.

Exporting the Report

You can export the Resource by Runs Report to a PDF, or to an editable Excel 
file. For more information, see “Exporting Reports” on page 202.
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User Management

The User Management module is used for managing user roles and 
privileges, project information, and user-role-project assignments.

➤ The Personal Information page stores all your personal information.

➤ The Users page stores information about all the Performance Center users.

This chapter includes:

 ➤  Understanding User Information on page 238

 ➤  Managing Your Personal Information on page 239

 ➤  Managing User Information on page 240
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Understanding User Information

You view and manage your personal user details and other users’ details in 
the User Management module. User information includes a user’s login 
information, personal details, and other general information.

Detail Description
Lo

g
in

 In
fo

rm
at

io
n

User Name The user’s username for logging on to 
Performance Center.

Password The user’s password for logging on to 
Performance Center.

(Not editable for LDAP/SSO users.)

Account Expiration Date 
(Expires)

The expiration date of the user account.

Pe
rs

o
n

al
 D

et
ai

ls Full Name The user’s full name.

E-mail The user’s email address.

Additional Data Any additional relevant information about 
the user.

G
en

er
al

 In
fo

rm
at

io
n

User Creator The name of the user who created the user 
account in the system. 

This field is automatically filled in when a 
user is added. It cannot be edited.

Status The status of a user can be active or 
non-active. 

(Not editable for LDAP/SSO users.)

Note: A user with a non-active status 
cannot log on to Performance Center.

Creation Date The date (and time) on which the user 
account was created in the system.
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Managing Your Personal Information

You can view and edit your personal user details in the Personal Information 
page.

To view and edit your personal information:

 1 On the Performance Center left menu, select User Management > Personal 
Information. 

 2 You can modify your personal details in the editable boxes.

For more information about the details displayed in the Personal 
Information page, see “Understanding User Information” on page 238.

 3 To revert back to the original details that were displayed before you 
modified them, click Restore.

To save your changes to your personal details, click Save.
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Managing User Information

You manage user information on the Users page. The Users page displays a 
list of all the users in the Performance Center system.

To access this page, on the Performance Center left menu, select User 
Management > Users. 

The Users page includes the following components:

➤ Users table. Each row in the table represents a unique user. The table 
displays information about each user. You can select the amount of users to 
be displayed in the displaying <n> items per page list.

➤ Editable user information pane. Displays the details of the selected user in 
the table and allows you to edit the user information. See “Modifying User 
Information” on page 244.
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➤ Users Toolbar. Provides the options to add a new user or to delete an 
existing user.

You can refresh the data on the page by clicking the Refresh button.

Sorting and Filtering Users
You can sort the users in the table in ascending or descending order by 
clicking the heading of the column by which you want to sort. Click the 
column heading again to reverse the sort order.

You filter the users using the filter boxes below the column headings. 

Note: Sorting and filtering settings are saved per user. The next time the 
same user enters the Users page, the page displays results based on the most 
recent sort order and filter.

To filter the users:

 1 In one of the filter boxes below the column headings, type the relevant text 
or select a value from the list. Press ENTER. 

The table displays users according to the selected filter option.

 2 You can filter these results further by entering additional filter values for 
other columns in the table.

Notes:

➤ The filter supports partial text entries. For example, if you entered th, the 
display list might include Seth, Thomas, and Anthony. 

➤ The filter does not support regular expressions or the following 
characters: : ; & * \ ' / # ~ , ? { } $ % | < > + = ` ^ [ ] !
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Adding Performance Center Users
You add new Performance Center users in the Users page.

Note: To add new Performance Center users, you need to be assigned with 
create user permissions.
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To add a user:

 1 On the Users page, click the Add New User button located in the toolbar. 
The Add New User dialog box opens.

 2 Enter the new user’s details. For more information about the different fields, 
see “Understanding User Information” on page 238.

Note: When adding LDAP or SSO users, the Password and Confirm 
Password fields are not editable. These values are taken from the user’s 
details in the respective system.

 a Enter a user name and password for the new user.

 b Enter the user’s personal details. (Full Name, E-Mail, Additional Data).

 c Select one of the Account Expiration date options:

➤ To set an expiration date for the user account, select the Expires 
option, click the calendar icon and select a future date. 



Chapter 25 • User Management

244

➤ If you want the user account to always remain valid, select 
Never Expires.

 d Select a status for the user—Active or Non Active.

Note: Non-active users cannot log on to Performance Center.

 3 To add the user to the list, click Add. 

To clear all fields, click Clear. 

To return to viewing user information without adding the new user, click 
Cancel. 

Modifying User Information
You modify user details in the user information pane of the Users page.

Note: To modify a user’s details, you need to be assigned with edit user 
permissions.

To modify a user’s details:

 1 On the Users page, select the user whose information you want to modify.

 2 Modify the details in the user information pane. 

For more information about the details displayed in the User Information 
pane, see “Understanding User Information” on page 238.
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 3 To revert back to the original user details that were displayed before you 
modified them, click Restore.

To save your changes to the user details, click Save.

Deleting Performance Center Users
You can delete selected users from Performance Center.

Note: To delete a Performance Center user, you need to have delete user 
permissions.

To delete a user:

 1 Select the user you want to delete, and click the Delete button located in the 
toolbar. 

 2 Click OK to confirm that you want to delete the user.

The user is deleted from the list of users.
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26
Defining User Roles

This chapter describes defining roles in Performance Center. Roles are 
defined groups of permissions that can be assigned to one or many users. A 
role determines which tasks the user can perform, and that information the 
user can access.

This chapter includes:

 ➤  Understanding Performance Center and Project-Related  Permissions 
on page 247

 ➤  Managing Roles in Performance Center on page 255

 ➤  Assigning Roles to Users on page 261

Understanding Performance Center and Project-Related 
Permissions

When creating roles, you select permissions for performing Performance 
Center or project-related tasks in the Performance Center system. 

Some permissions are dependent on other permissions. This means that a 
role containing a permission that has dependants automatically contain the 
dependant permissions too. These permission dependencies are noted in the 
tables described in the sections that follow.
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Performance Center Task Permissions
This section decribes the permissions assignable for Performance Center 
system related tasks.

Project Management and User Permissions

Permission Description

Project Management

Create project Allows the user to create projects

Dependants: 

➤ Edit project

Edit project Allows the user to edit projects

Delete project Allows the user to delete projects

User Management

Create user Allows the user to create Performance Center users

Dependants:

➤ Edit user

➤ Edit user personal information

Edit user Allows the user to edit user details

Dependants:

➤ Edit user personal information

Delete user Allows the user to delete users

Assign user to role Allows the user to assign roles to users

Remove user from role Allows the user to remove user-role assignments

Edit user personal data Allows the user to edit personal information
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Resource Management Permissions

Role Management

Create role Allows the user to create roles

Dependants:

➤ Edit role

Edit role Allows the user to edit role definitions

Delete role Allows the user to delete roles

Copy role Allows the user to copy roles

Dependants:

➤ Create role

➤ Edit role

License Management

Manage License Allows the user to insert or edit a Performance 
Center license or a host license

Permission Description

Host Pool Management

Create pool Allows the user to create host pools

Dependants:

➤ Edit pool

Edit pool Allows the user to edit host pools

Delete pool Allows the user to delete host pools

Permission Description
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Host Management

Add host Allows the user to add hosts

Dependants:

➤ Edit host (all data)

➤ Edit host (partial)

Edit host (all data) Allows the user to edit host details

Dependants:

➤ Edit host (partial)

Edit host (partial) Allows the user to edit the following host details 
only: Priority; State; Pool; Comment

Delete host Allows the user to delete hosts

Host Maintenance

Install patch Allows the user to install patches on Performance 
Center servers/hosts

Dependants:

➤ Reboot machine

Reboot machine Allows the user to reboot Performance Center 
servers/hosts

Check host Allows the user to check the status of Performance 
Center servers/hosts

Kill process Allows the user to end running processes on 
Performance Center servers/hosts

Deallocate host Allows the user to release hosts that are left in 
Running status after a load test has finished running

Fast recovery Allows the user to use the fast recovery option to 
terminate a test run, free up all the system 
resources, and reset the run state to Before Collating 
Results

Permission Description



Chapter 26 • Defining User Roles

251

General Performance Center Permissions

Timeslot Management

Delete timeslot Allows the user to delete a timeslot from the 
Administration site

Run Time Operations

Delete Run Allows the user to delete runs

Permission Description

Manage servers Allows the user to manage configuration on all 
Performance Center servers

Manage diagnostics 
servers

Allows the user to add/edit/delete diagnostics 
servers

Manage MI listeners Allows the user to add/edit/delete MI listeners

Edit alerts Allows the user to edit email alert configuration

Edit general settings Allows the user to edit the Performance Center 
general settings

Permission Description
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Project-Related Task Permissions
This section decribes the permissions assignable for project-related tasks.

Load Testing - Design Permissions

Permission Description

Load Test Management

Create load test Allows the user to create load tests

Dependants:

➤ Edit load test

Edit load test Allows the user to edit load tests

Delete load test Allows the user to delete load tests

Dependants:

➤ Delete run

➤ Delete timeslot

➤ Delete monitor profile

➤ Delete run results

Upload script Allows the user to upload scripts from VuGen

Edit script details Allows the user to edit script details on the User Site 
Vuser Scripts page.

Delete script Allows the user to delete scripts

Monitor Profile Management

Create monitor profile Allows the user to create monitor profiles

Dependants:

➤ Edit monitor profile

Edit monitor profile Allows the user to edit monitor profiles

Delete monitor profile Allows the user to delete monitor profiles
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Dashboard Management

Configure SLAs Allows the user to create and edit service level 
agreements

Delete SLAs Allows the user to delete service level agreements

Publish SLA statutes Allows the user to publish service level agreement 
statuses to the Dashboard

General

Edit user personal data Allows the user to edit personal information

Download applications Allows the user to download applications from the 
Downloads page

Integration with VuGen Allows the user to enable integration with 
Standalone VuGen

Dependants:

➤ Upload scripts

Integration with Analysis Allows the user to enable integration with 
Standalone Analysis

Permission Description
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Resource Management Permissions

Load Testing - Run-Time Permissions

Permission Description

Timeslot Management

Create timeslot Allows the user to create timeslots

Dependants:

➤ Edit timeslot

Edit timeslot Allows the user to edit timeslots

Delete timeslot Allows the user to delete timeslots

Create Autostart Allows the user to configure the Autostart feature

Dependants:

➤ Run load test

➤ Create timeslot

➤ Edit timeslot

Resource Management

Reboot machine Allows the user to reboot Performance Center 
servers/hosts

Check host Allows the user to check the status of Performance 
Center servers/hosts

Kill process Allows the user to end running processes on 
Performance Center servers/hosts

Edit host (partial) Allows the user to change the state of Performance 
Center hosts on the User Site.

Permission Description

Run-Time Operations

Run load test Allows the user to run load tests (create runs)

Stop run Allows the user to stop runs



Chapter 26 • Defining User Roles

255

Managing Roles in Performance Center

Performance Center comes packaged with predefined system roles, called 
canned roles. For example, the Administrator role is a canned role that 
grants a user permission to perform administration-level tasks.

You can also create user-defined roles. 

Roles are assigned to users within Performance Center projects.

This section describes:

➤ “Viewing Roles in Performance Center” below

➤ “Understanding Canned Roles” on page 257

➤ “Creating User-Defined Roles” on page 258

➤ “Editing Roles” on page 259

Delete run Allows the user to delete runs

Dependants:

➤ Delete run results

Manual operation during 
run

Allows the user to change run-time settings during a 
run

Add run notes Allows the user to add summary information about 
a run

Collate/Analyze results Allows the user to collate or analyze run results

Dependants:

➤ Stop run

Upload files to Results 
page

Allows the user to upload files to the Load Test 
Results page

Configure scenario 
schedule

Allows the user to create load test schedules

Delete run results Allows the user to delete load test results

Permission Description
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➤ “Copying Roles” on page 259

➤ “Deleting Roles” on page 260

Viewing Roles in Performance Center
You view roles in the Roles Management page.

To access the Roles Management page, on the Performance Center left menu 
select User Management > Roles.

The left pane of the Roles Management page contains two tabs which 
display the lists of roles. The tabs display:

➤ Performance Center roles. Allow the user to manage Performance Center 
assets—such as projects, users, and roles—and resources—such as hosts 
and servers.

➤ Project roles. Allow the user to manage project-related resources, and 
load test design and run-time settings.

Filtering Roles

To facilitate locating a specific role, you can filter the list of roles by role 
name. 

To filter the list of roles:

 1 Under the relevant roles tab (Performance Center or Project), in the Role 
box, type the name of the role (or part of the name).

 2 Click Filter.

The lists display all the roles whose names contain the string that you 
entered.

Note: The filter is applied in the selected roles tab only.

To clear the filter:

➤ In the Role box, clear the text and click Filter. All the roles are displayed.
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Understanding Canned Roles
The following table describes the canned (predefined) roles that are built 
into Performance Center. These roles cannot be edited or deleted.

Canned Role Description

Administrator
(Performance Center role)

Privileges: Performance Center administration 
privileges—project/user/roles/licence management; 
resource management—hosts and servers, events; 
reports; general settings.

Project Manager
(Project role)

Privileges: Projects and project resources; reports; 
Dashboard; events.

Manages the engagement between the LOB (Life of 
Business) and the COE (Center of Excellence). Does 
not perform any load testing but ensures that the 
project works as planned.

Power Tester
(Project role)

Privileges: Configure and run load tests; share/
import/export assets; publish to Dashboard; reboot 
machines.

Load testing user. Can manage limited resource 
tasks.

Tester
(Project role)

Privileges: Configure and run load tests

Load testing user. No resource management 
privileges.

LT Advisor
(Project role)

Privileges: View run screen, Vuser groups, graphs; 
perform manual operations on Vusers and Vuser 
groups. 

Guest
(Project role)

Privileges: Edit personal details and configure own 
graphs; view run, graphs, Vuser groups.
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Creating User-Defined Roles
If you have at least Create role privileges, you can create user-defined roles. 
You create roles in the Roles page. When you create a role, you give it an 
appropriate name and description, and select the permissions that you want 
to include in the role.

After creating roles, you assign them to users in the Privilege Managements 
page. For more information see Chapter 27, “Managing User Privileges.”

To create a role:

 1 On the Performance Center left menu, select User Management > Roles.

 2 In the Roles Management page, select the type of role you want to create—
Performance Center or Project (see description on page 256).

 3 In the left pane, below the list of roles, click New. 

A new role, New Role <n>, appears in the roles list, and an empty form 
opens in the Role Properties pane.

 4 In the Name box, type an appropriate name for the role. The name may 
include alphanumeric characters, and the following special characters 
only: _ @ # ( ) 

 5 In the Description box, type a description for the role.

 6 Select permissions for the role. For a list of all the task permissions, see 
“Understanding Performance Center and Project-Related  Permissions” on 
page 247.

Tip: To select all the permissions under a specific category, select the 
check box adjacent the category name.

 7 Click Save. The role is saved and a message is displayed in the Messages area 
(below the form).
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Editing Roles
If you have at least Edit role privileges, you can edit user-defined roles. 

Note: You cannot edit canned roles.

To edit a role:

 1 On the Performance Center left menu, select User Management > Roles.

 2 In the Roles Management page, select the type of role you want to edit—
Performance Center or Project.

 3 In the roles list, select the role that you want to edit. 

Tip: To locating the role more easily, you can filter the roles list. 
See “Filtering Roles” on page 256.

 4 Edit the role, and click Save.

The role is saved and a message is displayed in the Messages area below the 
form.

Copying Roles
If you have at least Copy role privileges, you can copy user-defined roles.

To copy a role:

 1 On the Performance Center left menu, select User Management > Roles.

 2 In the Roles Management page, in the list of roles, select the role you want 
to copy.

Tip: To locate the role more easily, you can filter the roles list. See “Filtering 
Roles” on page 256.
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 3 In the left pane, below the list of roles, click Copy. 

A copy of the role, Copy of <copied role>, appears in the list of roles.

 4 Edit the role as described in “Editing Roles” on page 259.

 5 Click Save to save the role.

Deleting Roles
You can delete roles that have no association with any users in the system. 

Note: You cannot delete canned roles.

To delete a role:

 1 In the list of roles, select the role you want to delete.

Tip: To locate the role more easily, you can filter the roles list. See “Filtering 
Roles” on page 256.

 2 In the left pane, below the list of roles, click Delete and confirm that you 
want to delete the role. 

As long as there is no user assigned to the role, the role is deleted.

Note: If there is a user assigned to the role, the role cannot be deleted—a 
notification is displayed.
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Assigning Roles to Users

All Performance Center users are assigned roles which permit them to 
perform tasks in Performance Center. For more information about assigning 
roles to Performance Center users, see Chapter 27, “Managing User 
Privileges.”
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27
Managing User Privileges

The Privilege Manager stores all the project-user-role assignments in the 
Performance Center system.

This chapter includes:

 ➤  About Privilege Management on page 263

 ➤  Accessing the Privilege Manager on page 264

 ➤  Privilege Manager at a Glance on page 264

 ➤  Managing User Privilege Assignments on page 265

About Privilege Management

Privilege Management enables you to assign users with selected privileges to 
manage Performance Center resources and assets or to manage Performance 
Center projects.

After you have defined users, user roles, and projects in Performance Center, 
you use the Privilege Manager to create associations between these elements.

The Privilege Management page lists these associations and is a portal to the 
pages where these associations are managed.
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Accessing the Privilege Manager

You access the Privilege Manager directly from the Performance Center left 
menu or from the Roles Management page.

➤ To access the Privilege Manager from the Performance Center left menu, 
select User Management > Privilege Management. 

➤ To access the Privilege Manager from the Role Management page, below the 
Role Properties pane, click the Assign Project-User-Role button.

Privilege Manager at a Glance

The Privilege Manager displays a list of containers on the left, and the 
User-Roles table on the right. 

A container can be defined as a Performance Center object that contains 
resources, assets, and other containers. Performance Center has two types of 
containers:
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➤ PC. Contains Performance Center resources such as hosts and servers, 
and Performance Center assets such as projects, users, and user roles.

➤ Projects. Contains project-related resources and assets such as load tests, 
scripts, and monitor profiles.

When you select a container, the User-Roles table displays the users assigned 
to that container, and the roles required of them in that container.

In the Privilege Management page, you can do the following:

➤ View all users assigned to a container, and the roles assigned to them in 
that container

➤ Assign users to a container

➤ Modify roles assigned to users

➤ Remove users assigned to a container

Managing User Privilege Assignments

You use the Privilege Manager to manage users and their roles in the 
Performance Center or Performance Center project containers.

This section includes:

➤ “Assigning Users to Performance Center/Project Containers” on page 266

➤ “Modifying User-Role Assignments” on page 268

➤ “Disassociating Users from Containers” on page 270
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Assigning Users to Performance Center/Project
Containers
You use the Privilege Manager to assign users to manage Performance Center 
tasks or project-related tasks.

Assigning users to the Performance Center or All Projects container, or to a 
particular project, involves a two-fold operation: 

➤ You select a container to which to assign the users

➤ You assign roles to users which allow them to perform tasks in the 
selected container

To assign users to the Performance Center or All Projects container:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select PC or All Projects. 

The User-Roles table on the right lists all the user-role assignments in the 
selected container.

 2 Below the User-Roles table, click Assign New User. The Assign New 
User-Role to <PC/All Projects> dialog box opens. 

 3 In the Role list, select a role that you want to assign to users.

Users already assigned this role are displayed in the Assigned to users box.

 4 In the Available users list, select the available users to whom you want to 
assign the selected role.

Tip: You can filter the Available users list by entering a particular user name 
(or part thereof) in the User box, and clicking Filter.

Click the single right-arrow button to move the selected available users to 
the Assigned to users box. Alternatively, to move all of the available users 
simultaneously, click the double right-arrow button.
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 5 Click Apply.

 6 To assign another role, repeat steps 3 through 5.

 7 Click OK. The Assign New User-Role dialog box closes, and the User-Role 
table displays the new user and its assigned roles. 

Note: Roles assigned in All Projects are marked with an asterisk (*).

To assign users to a single project:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select the project to which to assign the 
users. 

The User-Roles table on the right lists all the user-role assignments in the 
selected container.

 2 Below the User-Roles table, click Assign New User. The Assign New 
User-Role to <project> dialog box opens. 

 3 In the Role list, select a role that you want to assign to users.

Users already assigned this role are displayed in the Assigned to users boxes.

➤ Users assigned this role in the selected project are displayed in the Project 
Assignment box. 

➤ Users assigned this role in All Projects are displayed in the All Project 
Assignment box.
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 4 In the Available users list, select the available users to whom you want to 
assign the selected role.

Tip: You can filter the Available users list, by entering a particular user name 
(or part thereof) in the User box, and clicking Filter.

Click the single right-arrow button to move the selected users to the 
Assigned to users box. Alternatively, to move all of the available users 
simultaneously, click the double right-arrow button.

 5 Click Apply.

 6 To assign another role, repeat steps 3 through 5.

 7 Click OK. The Assign New User-Role dialog box closes, and the User-Role 
table displays the user-role assignments. 

Modifying User-Role Assignments
For any user assigned to a container, you can modify the roles assigned to 
the user in that container.

To modify the roles assigned to a particular user:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select the container to which the user is 
assigned. 

Note: Roles assigned to a user in one container can differ from roles assigned 
to the same user in a different container.

 2 In the User-Roles table, select the user whose roles you want to modify.
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 3 Below the User-Roles table, click Change User Roles. 

Note: The Change User Roles button is available when one user only is 
selected in the User-Roles table.

 4 The Change User-Role Assignments in <container> dialog box opens, 
displaying the user that you selected. 

In the Roles table, all the roles available for the selected container are 
displayed, and the roles already assigned to the user are selected.

 5 Select roles to assign to the user and clear the roles that you want to remove 
from the user.

Note: When modifying a user’s roles in a particular project, roles assigned to 
the user for all projects are displayed in read-only format. To modify these 
roles, perform this procedure in the All Projects container (see step 1).

 6 When you are satisfied, click Assign. The Change User-Role Assignments 
dialog box closes, and the modifications are displayed in the User-Roles 
table.
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Disassociating Users from Containers
Using the Privilege Manager, you can disassociate a user from a container. 
When you disassociate a user from a container, all the user-role assignments 
for the user in that particular container removed.

To remove a user from a container:

 1 In the Privilege Management page (User Management > Privilege 
Management), in the container list, select the container from which to 
remove the user.

 2 In the User-Roles table, select the user you want to remove. You can select 
one or multiple users.

Note: If the user has roles that are marked with an asterisk (*), to remove the 
user you must perform this procedure in the All Projects container. 

 3 Below the User-Roles table, click Remove Assignment. 

Note: The Remove Assignment button is available when at least one user is 
selected in the User-Roles table.

 4 In the message box that opens, click OK. 

 5 The user is removed from the User-Roles table.
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28
Managing Performance Center Projects

This chapter describes defining projects in Performance Center. Project 
information includes a project’s name, status, Vuser limit, machine limit, 
and other information about the project. You can view, modify, add, copy, 
move, and delete project information. In addition, you can define IP target 
addresses.

This chapter includes:

 ➤  Understanding Project Information on page 272

 ➤  Managing Project Information on page 274

 ➤  Using IP Addresses on page 277
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Understanding Project Information

You view and manage Performance Center projects in the Projects page. The 
Projects page displays a list of all the projects in the Performance Center 
system. If you have Project Management privileges, you can view and 
manage this information.

Detail Description

Project Name The name of the project.

Project Status The status of the project in the 
Performance Center system. The status can 
be active or non-active. 

Note: If a project is in a non-active state, 
no the users in the project can log on to 
the Performance Center system.

Running Vusers on 
Controller

Enables users to run Vusers on the 
Controller. This provides greater flexibility 
where resources are scarce. 

In Add/Edit mode: Select Enable or 
Disable. To give users more control in 
advanced projects, select Allow project 
users to override this selection. This allows 
project users at the administration level to 
change the Running Vusers on Controller 
setting.

Note: For best results, it is recommended 
to run Vusers on dedicated load generators 
only. Running Vusers on the Controller 
can overload the machine and affect load 
test results.

Vuser Limit The maximum number of Vusers a project 
can run at once. The total number used by 
all the project’s concurrent load tests must 
not exceed this limit.
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Machine Limit The maximum number of host machines a 
project can use at once. The total number 
used by all of the project’s concurrent load 
tests must not exceed this limit.

Concurrent Runs The maximum number of concurrent runs 
allowed within a project.

Host Pool Specification of what class of host 
machines should be assigned to the project 
for load tests. If your privilege level is 
Administrator, you can edit the set of 
possible pools. For details, see Chapter 4, 
“Managing Host Pools.”

Creation Date The date and time the project was created 
in the system.

Expiration Date The date and time the project’s validity 
expires.

In Add/Edit mode: 

➤ If you do not want the project to expire, 
select Never Expires. 

➤ To set an expiry date for the project, 
click the Select expiration date link, 
select the desired date and time from 
the calendar window, and click Set. The 
calendar closes and the date updated.

Use Target IP Definitions Allows the user to define the IP addresses 
to use as targets for load testing. For 
details, see “Using IP Addresses” on 
page 277.

J2EE\.NET 
Diagnostics Server

The J2EE\.NET Diagnostics Server selected 
for the project. For details on adding 
J2EE\.NET Diagnostics Servers to 
Performance Center,  see “Setting Up the 
HP Diagnostics (J2EE & .NET) 
Environment” on page 174.

Detail Description
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Managing Project Information

The Projects page displays a list of all the projects in the Performance Center 
system. 

To access this page, on the Performance Center left menu, select User 
Management > Projects.

The Projects page displays 25 projects in the Performance Center system at a 
time. To see more projects you can scroll down the list, and use the arrow 
buttons above the table to navigate between sets of 25 projects.

To see a particular project’s details, select the project in the list. The Project 
Information section in the lower area of the page displays project 
information for the selected project. For project detail definitions, see 
“Understanding Project Information” on page 272.

If you want to find a particular project, type the name in the Find project 
box and click Find.

If you want to display the complete list of projects, click the Show All 
button. This will expand the list from 25 projects to all projects.
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Tips: 

➤ To search for a specific project or alphabetic string, in the Find project 
box, type the project name (or part thereof), and click Find. Performance 
Center returns the appropriate list.

➤ Entering part of a name returns a list of all the projects that have the 
specified string anywhere in their names. If you entered nn, the display 
list might include wynn, benny_proj, and MG_grow_penn.

➤ Filtering andsorting settings are saved per user. The next time the same 
user enters the Projects page, the page displays results based on the most 
recent sort order and filter.

➤ To view the full list of projects again, click Show All.

Adding a  Project to Performance Center
You add new Performance Center projects in the Projects page.

To add a project:

 1 On the Projects page, click Add New Project. The Project Information area 
switches to Add mode and displays an empty Project Information form.

 2 Enter the project’s details.

For more information about the new projects details, see “Understanding 
Project Information” on page 272.

 a Enter a name for the new project.

 b Select the Project Status, either Active or Non-Active.

 c Select Running Vusers on Controller, either Disable or Enable. To allow 
Vusers to override this selection, select the Allow project users to 
override this selection option.

 d Enter the Vuser Limit, the maximum number of Vusers a project can run 
at once.

 e Enter the Machine Limit, the maximum number of host machines a 
project can use at once.
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 f Enter the Concurrent Runs, the maximum number of concurrent runs 
allowed within a project.

 g Select the Host Pool, a specification of what class of host machines 
should be assigned to the project.

 h Set an expiration date for the project.

Under Account Expiration Date, click the Select expiration date link. A 
calendar window opens. Select the desired date and time, and click Set. 
The calendar closes and the account expiration date is updated.

 i If you select the Use Target IP Definitions option, you  need to define the 
IP addresses to use as targets for load testing. For details, see “Using IP 
Addresses” on page 277.

 j If you are working with HP Diagnostics, select a J2EE\.NET Diagnostics 
Server from the list. For more information about adding Diagnostics 
Servers to Performance Center, see “Setting Up the HP Diagnostics (J2EE 
& .NET) Environment” on page 174.

 3 To add the project to the list, click Add. 

To clear all fields, click Clear. 

To return to viewing project information without adding the new project, 
click Cancel. 

Modifying Project Information
You modify project information in the Projects page.

To modify a project’s details:

 1 On the Projects page, select the project whose information you want to 
modify.

 2 Click Edit. The Project Information area switches to Edit mode. 

 3 Modify the information in the editable fields.

 4 Click Save to save changes to the project’s information.
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Note: As a result of modifying a project’s host pool allocation, reserved 
timeslots may not appear in the Timeslots page.

Deleting Performance Center Projects
On the Project’s page, select the project you want to delete and click Delete. 
Click OK to confirm that you want to delete the project.

The project is deleted from the list of projects.

Using IP Addresses

IP addresses are assigned so that the addresses of all hosts on a given 
network share a common prefix. The common prefix defines the network 
portion of the IP address, and the remainder defines the host portion (also 
referred to as the local portion).

Note that the term "network" in this context refers to a logical network, 
which might span one or more physical networks. The network portion of 
an IP address identifies a site and the local portion identifies a single host at 
that site. 

About Using Subnet Masks 
A site using subnet addressing must specify a 32-bit subnet mask for each 
network. Each bit in the subnet mask is set to 1 if the network treats the 
corresponding bit in the IP address as part of the network address and 0 if it 
treats the corresponding bit in the IP address as part of the host id.

Consider, for example, the subnet mask 11111111 11111111 0000000 
0000000 (or in decimal form, 255.255.0.0). This subnet mask specifies that 
the first two octets identify the network and the last two octets identify the 
host on that network.
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The subnet mask 255.255.255.255 (or in binary form, 11111111 11111111 
11111111 11111111), which you add when defining individual IP addresses, 
specifies that all four octets in the IP address identify the network and host 
as if there were no subnet mask. In practice, this means that null will use the 
exact IP address to target load tests.

Defining Target IP Addresses
If a project is set to Use Target IP definitions, you must define a target IP 
address. The project’s load tests are targeted to these addresses. If no 
addresses are defined, the project’s load tests cannot run.

By default, this option is not selected, and the project can target its tests to 
any IP address.

To limit your load test to one or more individual IP addresses, type the IP 
addresses along with the following mask address: 255.255.255.255. 

To limit your load test to a network of target IP addresses, type the correct IP 
and Subnet mask combination that your network administrator has 
provided for your organization. 

To define target IP addresses for a project:

 1 On the Projects page, select the project from the list. The Project 
Information section displays the selected project’s information.

 2 If the Use Target IP Definitions option has not been selected, click Edit to 
switch the Project Information area to edit mode, and select it. The click 
Save.
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 3 Below the project Information area, click Define Target IP. The Define Target 
IP Addresses for Project dialog box opens.

 4 Under IP Address, enter a target IP address.

 5 To add another IP address, click New Line and enter the address. 

 6 To edit an address, place the cursor in the box you want to edit, and type the 
new address.

 7 To delete an address, click the Delete button for the relevant IP address.

 8 Click Save to save changes and close the dialog box, or Close to close the 
dialog box without saving changes.
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Part VII

Troubleshooting
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29
Troubleshooting Hosts and Servers

This chapter provides information on troubleshooting host-related 
problems.

This chapter includes:

 ➤  Host in Resource Failure on page 284

 ➤  Cannot Add Host as an HP Performance Center Host on page 289

 ➤  Unable to Add a Load Generator Due to High Latency on page 289

 ➤  Problems Changing SiteScope Server in Administration Site on page 290

 ➤  Failure to Add Host on page 292

 ➤  Failure to Reboot Host from Administration Site on page 294
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Host in Resource Failure

Problem description: The host is in Resource Failure status.

Troubleshooting

Option 1: Check the host connections

Check the connections between your project’s hosts and the machines 
within your system using the Check Hosts operation in the Hosts page of 
the Administration Site (Resources > Hosts > Check Hosts) or User Site 
(Project > Hosts > Check Hosts).

➤ If Ping to Host fails:

➤ Make sure the host is up and running, and is connected to the network. 
Check the routing table (netstat –r) and make sure that requests to this 
host are properly routed.

➤ Make sure that the host’s IP address can be properly resolved.

➤ Verify that the ping to the target host from the HP Performance Center 
Web server, utility server, and database is below 20 ms.
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➤ If your firewalls or hosts ignore ICMP requests (pings), use HTTP requests 
to validate response times from the host to the Web server (a simple 
LoadRunner web_url(…) request to http://<server>/loadtest/). 
Alternatively, open a browser and type http://<server>/loadtest in the 
address field.

➤ If the file server fails:

➤ Make sure that the host can ping the file server.

➤ Make sure that the HP Performance Center system user has access to LRFS 
share on the file server. You can verify this in any of the following ways:

➤ In the command line, execute the following: 

➤ Log in to the host machine as the HP Performance Center system user, 
and in the command line, execute the following: 

If the above operation fails, check the error message and resolve the 
problem. Contact your Windows administrator for assistance.

➤ Make sure that the security settings on LRFS share allow the 
HP Performance Center system user full control.

➤ Make sure that the HP Performance Center system user can create, 
update, and delete files from LRFS share.

➤ Make sure that the HP Performance Center Web server can launch 
applications on the host. For more information, see “Troubleshooting 
Web Service Connectivity” on page 307.

➤ If the database fails:

➤ Check the <HP Performance Center>/bin/globals.ini file and make sure 
that the connection string is correct for the database you are using.

➤ See the troubleshooting for “Login to Oracle Database Server Hangs” on 
page 319.

net use \\fileserver\LRFS / user: 
<Performance_Center_user><Performance_Center_user_password>

% net use \\fileserver\LRFS
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➤ Verify ADODB connectivity to the database as described in “Login to 
Database Server Fails” on page 322.

Option 2: Check the HP Performance Center version

Make sure that you are using the same version of HP Performance Center on 
all your host and server machines.

Check the registry entry under 
[HKEY_LOCAL_MACHINE\SOFTWARE\Mercury 
Interactive\LoadRunner\CurrentVersion] for the following variables:

➤ Major

➤ Minor

➤ ServicePack

Note: Any patches applied to one machine must be applied to all machines 
if and when applicable.

Option 3: Launch wlrun.exe manually from the Controller host machine

If the host check succeeds, but the host is still not operational, launch the 
Controller manually from the Controller host machine as follows:

 1 Log in to the host machine.

 2 Configure the wlrun.LrEngine application to run as an interactive user: 

➤ Launch dcomcnfg.exe.

➤ In the Application tab, select wlrun.LrEngine from the list of DCOM 
applications.
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➤ Click Properties to view the properties for wlrun.LrEngine.

➤ In the Identity tab, set the user account to The interactive user.

➤ Click OK and close the DCOMCNFG window.

Note: When you are finished with this step, set wlrun.LrEngine back to 
its original identity. By default, this is This User with the HP Performance 
Center user name and password. If you used a different identity, restore 
it.

 3 Launch the Controller (wlrun.exe) from the <HP Performance Center>/bin 
directory (on the Controller host).

 4 If an error message is displayed during the startup of the Controller, resolve 
the error message before continuing. For HP Performance Center to utilize 
the Controller properly, no error messages should be displayed during 
startup.

 5 Create a new, simple load test and reference the scripts from the LRFS share 
(on the HP Performance Center file server). Run the load test with one or 
two users to verify that the Controller works.

Note: Scripts uploaded to the Performance Center LRFS reside in the 
\\fileserver\LRFS\<ProjectID>\Scripts directory. To obtain the <ProjectID>, 
select User Management > Projects.

The following is an example path to the USR file for a script named MyTest: 
\\myserver\LRFS\2\Scripts\MyTest\MyTest.usr

 6 Close the Controller (wlrun.exe).
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 7 From the HP Performance Center User Site, launch a simple load test.

➤ Check whether the following processes are displayed in the Task Manager 
on the Controller host:

➤ OrchidActiveSession.exe OR ORCHID~1.exe

➤ WLRUN.EXE

➤ Check whether the Controller is displaying a dialog box that requires 
user input before the Controller can proceed with the load test. Address 
the reasons for the dialog box being displayed, and make sure that no 
dialog boxes are displayed when re-running the load test from 
HP Performance Center.

Examples of dialog boxes that may be displayed include License Has 
Expired, Monitor Not Licensed, and Host is Over-Utilized.

If you are unsure how to resolve the problem indicated in the dialog box, 
contact the Customer Support Web site (http://www.hp.com/go/
hpsoftwaresupport) for assistance. 

Note: When you are finished with this step, set wlrun.LrEngine back to 
its original identity. By default, this is This User with the HP Performance 
Center user name and password. If you used a different identity, restore 
it. 

Option 4: Reinstall HP Performance Center host on the host machine

If all of the above steps fail to resolve the problem, reinstall the Performance 
Center host on the host machine.

 1 Uninstall HP Performance Center (Start > Settings > Control Panel > Add/
Remove Programs). (This is really the HP Performance Center host.)

 2 Delete HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive from the 
registry.

http://www.hp.com/go/hpsoftwaresupport
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 3 Re-install the HP Performance Center host. For more information, see the 
HP Performance Center System Configuration and Installation Guide. Make sure 
that you install the same version of HP Performance Center as is installed on 
your Web server.

Note: Do not install an HP Performance Center server (such as a Utility 
Server, Web Server, or File Server) on the same machine as the 
HP Performance Center host (such as a data processor, Controller, or load 
generator).

Cannot Add Host as an HP Performance Center Host

Problem description: When trying to add a host, you receive an error stating 
that HP Performance Center cannot identify the host as an HP Performance 
Center host.

Troubleshooting

Verify that the ManagmentUtil.exe COM object is defined as the 
HP Performance Center system user.

Unable to Add a Load Generator Due to High Latency 

Problem description: You are unable to add a load generator host due to 
high network latency or the network policy.

You may have a problem adding a host to the Performance Center 
Administration Site as a load generator if the host has a ping time greater 
than 50 ms. This applies only to hosts added as load generators.

Troubleshooting

 1 Create a temporary host location over a firewall.

 a On the Host Locations page, click Add Host Location.
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 b In the Host Location field, type TempOverFirewall.

 c Set Located over Firewall to Yes. (By using the Located over Firewall 
option, many checks that are performed on host machines will not be 
performed.)

 d Click OK.

 2 Add a new host to the temporary location.

 a On the Hosts page, click Add Host.

 b In the Name field, type add.

 c In the Purpose field, select Load Generator.

 d From the Location list, select TempOverFirewall.

 e From the Host Pool list, select the correct host pool.

 f Click Save, and then click OK to confirm.

 g Select the host that was added from the host list.

 h Change the location to the correct location. (Placing the host in the over 
firewall location was done just to bypass some checking that 
HP Performance Center does when adding host machines.)

 i Click OK. In the next two message boxes that are displayed, click OK.

 3 Repeat Step 2 for all load generators that have high network latency.

Problems Changing SiteScope Server in Administration Site

Problem description: You are unable to change the SiteScope server details 
on the Server Configuration page in the Administration Site (System 
Configuration > Server Configuration). When you enter a new SiteScope 
server in the SiteScope Server box and click Save, you receive one of the 
following error messages:

➤ Service unavailable

➤ An unspecified error occurred while processing your request. Try to 
refresh your browser or to open another browser instance. 
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Troubleshooting

 1 On the Server Configuration page (System Configuration > Server 
Configuration), clear the contents of the SiteScope Server box and click 
Save.

 2 In the SiteScope Server box, enter the name of the new SiteScope server and 
click Save.

Note: As a result of this action, Performance Center host or server groups 
may have been created on the new SiteScope server. It is recommended to 
remove these groups from the SiteScope server.

 3 Re-enable SiteScope monitoring on the relevant Performance Center hosts 
and servers.

➤ To enable SiteScope monitoring for a host, open the Hosts page 
(Resources > Hosts), and click the relevant host. In the Properties tab, 
click Edit and select Enable SiteScope Monitoring.

➤ To enable SiteScope monitoring for a server, open the Servers page 
(Resources > Servers), and click the relevant server. In the Properties tab, 
click Edit and select Enable SiteScope Monitoring.

 4 Reconfigure the SiteScope alert settings on the Alerts Configuration page 
(System Configuration > Alerts Configuration).
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Failure to Add Host

Problem description: Add host fails. 

Troubleshooting

This may occur as a result of any of the following problems:

➤ System User Passwords Do Not Match

The Performance Center system user credentials on the new host machine 
must be the same as those of the Performance Center system user on the rest 
of the Performance Center system. 

If the system user exists on the host with a different password, Performance 
Center will not add the host to the system. Before attempting to add a host, 
ensure that the credentials match.

➤ . NET Framework

There may be a problem with the .NET Framework installation. 

Repair the .NET Framework installation as follows:

 1 Select Start > Run. 

 2 Enter the following command:

➤ IIS Configuration (Performance Center requests administrator credentials)

There may be a problem with the IIS configuration. In some cases, when you 
try add a host, the Administrator Authentication dialog box opens, 
requesting the administrator credentials. This may also be caused by 
incorrect configuration of IIS.

On the relevant host, the Administration Site server, and the Utility server, 
check the following:

 1 Verify the PCWS folder configuration for the host machine, as follows:

 a Navigate to the following URL: http://<host_address>/PCWS/
ServerManagerWS.asmx

c:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i
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 b Supply the Performance Center system user credentials (by default 
IUSR_METRO) 

 c Click IsAvailable and then click Invoke

 d If the value true is displayed, IIS is configured correctly. 

 e if you could not reach this point, ensure that for the Default Web Site 
virtual directory, TCP Port is set to 80 and IP Address is set to (All 
Unassigned).

 2 If you are using IIS 6.x, check the following:

➤ Ensure that the virtual directory Application Pools > PCWSAppPool 
exists. If not, create it with the default options.

➤ In the properties of the Default Web Site > PCWS virtual directory, ensure 
that the Application Pool selected is PCWSAppPool.

➤ Ensure that the following Web Service Extensions are allowed: Active 
Server Pages, ASP.NET v2.0.50727, and Server Side Includes. If they are 
not, allow them and restart IIS.

 3 If you are using IIS 5.x, ensure that in the properties of the 
Default Web Site > PCWS virtual directory, the Application Protection is set 
to High.
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Failure to Reboot Host from Administration Site

Problem description: When a host is rebooted from the Hosts page of the 
Administration Site, the host has been rebooted, but the host state is not 
updated accordingly.

Troubleshooting

Reset IIS as follows:

➤ Select Start > Run.

➤ Type iisreset.

➤ Press Enter.



295

30
Troubleshooting Accessing the 
Performance Center Sites

This chapter provides information on troubleshooting Web-related 
problems.

This chapter includes:

 ➤  Login Fails on page 295

 ➤  User Site Does Not Exist After Initial Configuration on page 296

 ➤  Uploading a Script from VuGen Fails on page 297

 ➤  Unable to Log In to the Administration/User Site on page 298

 ➤  Administration Site Page Cannot Be Displayed on page 298

 ➤  Cannot Connect to Administration or User Site on page 299

Login Fails

Problem description: You cannot log in to HP Performance Center with any 
user or administrator account.

Troubleshooting

 1 Make sure that you type the correct user name and password. The password 
is case-sensitive. The default administrator account is Admin, Admin.
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 2 There may be a problem with the encryption and decryption of the 
password.

➤ Open Documents And Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys and delete the entry that 
begins with f9416f003254e610da1f9bad8e4c383_.

➤ Restart IIS. Choose Start > Programs > Administrative Tools > Services. 
Select IIS Admin Service and click Restart Service.

 3 Make sure that both the Administration Site and the User Site are configured 
to run with the same account credentials as the HP Performance Center Web 
services virtual directories. For more information about troubleshooting 
Web services, refer to the relevant section in the HP Performance Center 
Administrator’s Guide.

 4 Check that you are able to connect to the database server  from the Utility 
Server and the Web Server. Download the TcIN_AdoDBTester.exe utility 
from the Support Web site (http://www.hp.com/go/hpsoftwaresupport). After 
you log in to the support site, click Self-solve knowledge search, select 
Performance Center, and search for ID39475. 

 5 Make sure that the maximum number of connections to the database server 
has not been exceeded. Run Perfmon.exe or the database server’s 
management tool to verify the number of connections. You should contact 
your database administrator if you need further assistance.

User Site Does Not Exist After Initial Configuration

Error message: ‘Page Not Found’ (displayed in browser).

Problem description: After the initial configuration of HP Performance 
Center (using http://<servername>/admin/initialfs.htm), the HP Performance 
Center User Site is created through the Server Configuration page in the 
Administration Site (System Configuration > Server Configuration). In this 
case, after the User Site (http://<servername>/LoadTest) has been created, it 
does not exist on the HP Performance Center server.

http://www.hp.com/go/hpsoftwaresupport
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Troubleshooting

If the HP Performance Center Web server was corrupted or reinstalled, 
launch Internet Service Manager and check if the LoadTest virtual directory 
is defined.

 1 If LoadTest is defined, but points to the wrong directory, delete the LoadTest 
virtual directory and continue with the following step.

If LoadTest is not defined, log in to the HP Performance Center 
Administration Site and check if an entry exists for User Site Servers on the 
Server Configuration page (under System Configuration > Server 
Configuration). If the name of the server is not displayed under User Site 
Servers, add it and save your changes. Try to log in to the User Site (http://
<servername>/loadtest).

 2 From the User Site machine, connect to the database or user schema using 
Microsoft SQL, Oracle Enterprise Manager, or any SQL client and check the 
Web Server entry in the GlobalData table of the MI_LRDB tablespace/
database. If the Web Server entry contains the name of the server on which 
you want to install the HP Performance Center User Site, remove the server 
name.

 3 Log in to the HP Performance Center Administration Site and define User 
Site Servers on the Server Configuration page (under System 
Configuration > Server Configuration).

Uploading a Script from VuGen Fails

Problem description: Uploading a script from VuGen fails. An error message 
is provided.

Troubleshooting

 1 Make sure the machine is not configured to use a proxy server. If it is, 
disable the proxy server by searching the registry for the ProxyEnable key in 
the Internet Settings folders and setting this key to zero. 
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 2 Check whether there are upload timeouts due to a slow network 
connection. In the <HP Performance Center installation>\dat directory, 
there is a configuration file called OrchidCommUtils.dat that holds the 
integration communication settings. To change the default timeout (60 
sec.), you must enable the http_timeout_secs key and change its value.

 3 If neither of the above troubleshooting options helps, you can create a log 
file that provides more information and send it to Customer Support (http://
www.hp.com/go/hpsoftwaresupport). To create the log file, enable the log_file 
key.

Unable to Log In to the Administration/User Site

Problem description: You are unable to log in to the Administration Site or 
the User Site. The system appears to “spin.”

Troubleshooting

 1 (IIS 5 only) Make sure that both the Administration Site and the User Site are 
set to Application Protection level High (isolated) in the Internet Services 
Manager. For more information, see “Option 1 (IIS 5 only): Set the 
Application Protection level to High (isolated)” on page 319.

 2 Make sure that the permissions level for the IWAM_<SERVER> user is set 
correctly. For more information, see “Option 2: Set the Correct Permissions 
Level for the IWAM_<SERVER> user” on page 321.

Administration Site Page Cannot Be Displayed

Problem description: You receive an error message indicating that the 
Administration Site page cannot be displayed, or the Administration Site is 
not displayed correctly.

Troubleshooting

➤ If the Administration Site is not displaying correctly, recreate the 
Administration Site by running <HP Performance Center installation 
directory>\bin\AdminInstaller.exe1

http://www.hp.com/go/hpsoftwaresupport
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➤ If you receive an error that the page cannot be displayed:

 a Close the current browser. Relaunch the browser and try to open the 
Administration Site again.

 b Choose Tools > Internet Options from the menu. In the General tab, click 
Settings. In the Check for newer versions of stored pages section, make 
sure that the Every visit to the page option is selected.

 c Clear the browser cache and cookies.

 d If the problem is still not resolved, try to open the Administration Site 
from a different machine.

 e Reset IIS by choosing Start > Programs > Administrative Tools > Services, 
locating IIS Admin Service, and clicking Restart Service.

Cannot Connect to Administration or User Site

Problem description: When trying to connect to the Administration or User 
Site Web servers, you receive a Service unavailable or You are not authorized 
to view this page error message.

Troubleshooting

 1 Verify that the Administration Site virtual directory user exists.

 2 Verify that the user has all the required policies.

 3 Verify that the application pool is not locked. If it is, consult the event 
viewer for an explanation.

 4 Verify that the security policy configuration of the customer domain is 
compatible with the the configuration of your HP Performance Center 
environment. 
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31
Troubleshooting Web Problems

This chapter provides information on troubleshooting Web-related 
problems.

This chapter includes:

 ➤  HTTP 500.x – Internal Server Error on page 301

 ➤  Cannot Find Server or DNS Error on page 304

 ➤  Maintenance Service Causes IIS Resets on page 305

 ➤  HTTP/1.1 100 Continue Randomly Appears on page 305

 ➤  Internet Explorer Closes When Selecting Script For Vuser Group on page 306

HTTP 500.x – Internal Server Error

Error message: The page cannot be displayed (HTTP 500.x Internal Server 
Error).
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Troubleshooting

 1 Reset IIS by choosing Start > Programs > Administrative Tools > Services, 
locating IIS Admin Service, and clicking Restart Service.

 2 (IIS 5 only) If you cannot restart IIS, reboot the machine.

Make sure that both the Administrator Site and the User Site are set to 
Application Protection level High (isolated) in the Internet Services 
Manager. To set the protection level, see “Option 1 (IIS 5 only): Set the 
Application Protection level to High (isolated)” on page 319.

 3 Reset the Tomcat service on the User Site server.

 4 Make sure that the anti-virus software is not checking the HP Performance 
Center installation directory and sub-directories and thereby causing the 
error. In addition, make sure that the anti-virus program is not checking the 
file server directory (generally LRFS).

 5 If you are still receiving an error, perform the following steps to see a more 
detailed error:

On the client machine:

 a Open Internet Explorer. 

 b Select Tools > Internet Options. 

 c Click the Advanced tab. 

 d Under the Browsing section, deselect Show Friendly HTTP Error 
Messages.

On the server machine:

 a select Start > Programs > Administrative Tools > Internet Information 
Services Manager to open the IIS manager.

 b Expand Web Sites.

 c Select Default Web Site.

 d Select the virtual directory relevant to the server’s purpose: Admin for 
Administration Site Server, Loadtest for User Site Server.

 e Right click the selected directory and click Properties. The <directory> 
Properties dialog box opens.
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 f Click Configuration. The Application Configuration dialog box opens.

 g Click the Debugging tab.

 h Select Send detailed ASP error messages to client.

 i Click OK to close the Application Configuration dialog box.

 j Click OK to close the <directory> Properties dialog box.

 k Restart IIS by right clicking the server’s name in the tree. Select All tasks > 
Restart IIS.

At this point you should have a different, more detailed error message. 
Try to address the problem indicated in the message, or contact HP 
Customer Support with this message and all information related to the 
problem.
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Cannot Find Server or DNS Error

Error message: The page cannot be displayed (Cannot find server or DNS 
Error).

Troubleshooting

 1 Make sure that you entered the correct URL address.

 2 Verify that you have access to the Web server.

➤ Use the ping command if you do not have a firewall blocking ICMP 
requests to your Web servers.

➤ From a command prompt, execute: ping <Web server>

➤ From a command prompt, execute: ping <IP Address of Web server>
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 3 On the Web server, verify that IIS is up and running:

 a Choose Start > Programs > Administrative Tools > Services.

 b Make sure that IIS Admin Service is Started and that Startup type is set to 
Automatic.

 c Make sure that World Wide Web Publishing Service is Started and that 
Startup type is set to Automatic.

 4 Reset IIS by choosing Start > Programs > Administrative Tools > Services, 
locating IIS Admin Service, and clicking Restart Service.

Maintenance Service Causes IIS Resets

Problem description: IIS is reset every 10 minutes by the maintenance 
service. The maintenance service log shows that the HTTP call to 
MemorySize.asp had a timeout (60 sec.) and after three retries, the service 
reset IIS (as it was designed to do).

Troubleshooting

Make sure that the Utility Server is not configured to work through a proxy 
that might block the HTTP call. To disable the proxy setting, search the 
registry for the key ProxyEnable in the Internet Setting folders and set this 
key to zero.

HTTP/1.1 100 Continue Randomly Appears

Problem description: The message HTTP/1.1 100 Continue randomly 
appears in the middle of a response stream.

Troubleshooting

If you installed the User Site server or Administration Site server on a 
Windows Server 2003 SP1 machine, download the Microsoft patch from the 
the Microsoft Support site (http://support.microsoft.com/kb/898708). This 
patch addresses a known Microsoft issue, when running IIS 6.0 on a 
Windows Server 2003 machine.

http://support.microsoft.com/kb/898708
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Internet Explorer Closes When Selecting Script For Vuser 
Group

Problem description: When trying to select a script for a new Vuser group, 
Internet Explorer closes.

Troubleshooting

When you are designing Vuser groups, there must always be at least one 
available script in the Scripts list. If you try to select a script and the list is 
empty, it triggers a known defect in IE7 [version 0.5730.13CO], causing the 
browser to close.

Ensure that at least one Vuser script has been uploaded to the current 
project. 
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32
Troubleshooting Web Services

This chapter provides information on troubleshooting Web service-related 
issues.

This chapter includes:

 ➤  Troubleshooting Web Service Connectivity on page 307

 ➤  Testing Web Service Connectivity on page 308

Troubleshooting Web Service Connectivity

This section provides troubleshooting for Web service connectivity issues. 

Important: The following troubleshooting tips apply to the Web service 
requester agent machine.

After each troubleshooting attempt described below, you can test your Web 
service connectivity using the test described in “Testing Web Service 
Connectivity” on page 308.

To troubleshoot Web service connectivity:

 1 Verify that the PCWS virtual directory exists in IIS.

 2 If you are using IIS 6, verify that the ASP.NET V2.0 extension was installed 
and allowed in IIS.

 3 If you are using IIS 6, verify that the PCWSAppPool application pool is not 
locked. If it is locked, you can consult the event viewer for an explanation. 
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 4 If you are using IIS 5, grant full access permission for 
IWAM_<Machine_name> in the <Windows directory>\temp directory.

 5 Verify that the HP Performance Center system user exists on the machine.

 6 Verify that the following policies are defined for the HP Performance Center 
system user:

➤ Batch logon rights

➤ Service logon rights

➤ Access this computer from the network

Testing Web Service Connectivity

After you troubleshoot Web service connectivity, you can test your Web 
service connectivity by trying to access the HP Performance Center 
ConfigWS Web services on the requester agent machine.

To test Web service connectivity:

 1 On the requester agent machine, enter the following URL: 

 2 In the Enter Network Password box, enter your HP Performance Center 
system user login details.

http://<provider agent machine>/PCWS/ConfigWS.asmx
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The ConfigWS Web service page opens. 

Note: If this page does not open, there is still a problem with the Web 
service connectivity and you should continue to troubleshoot this issue.

 3 Click the IsAvailable operation.

 4 On the IsAvailable operation page, click Invoke.
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If this action returns a value of True, the Web service connectivity is 
operational.
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33
Troubleshooting System Identity

This chapter provides information on troubleshooting system 
identity-related issues.

This chapter includes:

 ➤  Administrator Account Requested on page 311

 ➤  Error in Adding Permissions to Folder/Registry on page 312

 ➤  Identity References Cannot Be Translated on page 312

 ➤  Server/Host Configuration Problems on page 313

 ➤  Admin Tasks Take a Long Time/Time-Out/ ThreadAbortException 
on page 313

 ➤  Conflicting Credentials when Changing Users on page 313

 ➤  Oracle Database – Cannot Change System User to  Non-Admin User 
on page 314

 ➤  Remote Management Agent Service Disabled After  Changing System User 
on page 315

 ➤  Load Generator Standalone Limitations on page 316

Administrator Account Requested

Problem description: An administrator account is requested even if the 
HP Performance Center system user is an administrator.

Troubleshooting

 1 Verify that you can access the Web service using the browser. 
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 2 Verify that the system user exists on the machine.

 3 Check whether the ASP.NET V2.0 extension was installed and allowed in IIS. 

 4 Verify that you have the PCWS virtual directory.

Error in Adding Permissions to Folder/Registry

Problem description: You receive an error when adding permissions to one 
of the file/folders or registry keys. 

Troubleshooting

 1 Try to reconfigure the use case again (by clicking the Reconfigure button in 
the System Identity utility).

 2 Reboot the machine and click the Reconfigure button in the System Identity 
utility. 

 3 Clean out all the unrecognized users from the folder/registry. 

Identity References Cannot Be Translated

Error message: Some or all identity references could not be translated.

Problem description: You receive the above error in trying to configure the 
system. 

Troubleshooting

 1 Verify that the configuration user is not the same user with which you are 
logged in to the system. If you are logged in to the system with the 
configuration user, log off and then log in again with a different user. 

 2 Reset IIS on the machine on which you received the error.
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Server/Host Configuration Problems

Error message: System.Web.Services.Protocols.SoapException: Server was 
unable to process request. Unable to generate a temporary class.

Problem description: This error can occur when trying to configure a server 
or host using the System Identity utililty. 

Troubleshooting

Grant full access permission for the IWAM_<Machine_name> user in the 
<Windows directory>\temp directory.

Admin Tasks Take a Long Time/Time-Out/
ThreadAbortException

Problem description: When the system user is a non-administration user 
(lock down mode), changing the system user or adding a host takes a long 
time, or a time-out event or ThreadAbort exception occurs.

Troubleshooting

Try to configure the system user again (click Reconfigure). 

If the problem persists:
In “lock-down mode,” permissions are granted to specific directories, files, 
and registry keys that HP Performance Center requires in order to run. 
Check the Security tab of these resources for deleted users/groups (SIDs). 
These deleted SIDs increase the time it takes to perform tasks such as 
granting permissions to a resource. To reduce the performance time for these 
tasks, clean out all the deleted SIDs. 

Conflicting Credentials when Changing Users

Error message: The credentials supplied conflict with an existing set of 
credentials.

Problem description: This error can occur when using the System Identity 
utility to change the system user. 
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Troubleshooting

Verify that the configuration user is not the same user with which you are 
logged in to the system. If you are logged on to the system with the 
configuration user, log off and then log on again with a different user. 

Note: This problem may be caused due to a Microsoft limitation. For more 
information, see the Microsoft TechNet Web site (http://www.microsoft.com/
technet/
prodtechnol/windows2000serv/reskit/w2000Msgs/3860.mspx?mfr=true).

Oracle Database – Cannot Change System User to 
Non-Admin User

Problem description: When working with an Oracle database, you cannot 
change the system user to a non-administrative system user.

Troubleshooting

Before changing the system user to a non-administrative user, you need to 
disable the Oracle Client’s SQLNET Authentication Services option on each 
of the HP Performance Center servers and hosts. 

To disable the SQLNET Authentication Services option:

 1 Open the <Oracle installation directory>\network\admin\sqlnet.ora file 
and locate the following line:

 2 At the beginning of this line, insert a # symbol.

 3 Save the file.

SQLNET.AUTHENTICATION_SERVICES = (NTS)

http://www.microsoft.com/technet/prodtechnol/windows2000serv/reskit/w2000Msgs/3860.mspx?mfr=true
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Remote Management Agent Service Disabled After 
Changing System User

Problem description: After you change the system user to a 
non-administrative system user, the Remote Management Agent service is 
disabled.

Troubleshooting

You need to remove the service and restart it with the new Performance 
Center system user’s credentials. 

 1 Restart the machine.

 2 Run the Remote Management Agent service using the following command:

where username and password are those of the Performance Center system 
user.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 
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Load Generator Standalone Limitations

This section specifies a number of scenarios of changing the system user, 
and the load generator standalone limitations associated with each scenario.

Scenario 1

➤ You changed the system user for all servers and hosts in the Performance 
Center environment.

➤ You did not add the changed user manually to Load Generator machine.

➤ The default Performance Center system user, IUSR_METRO, exists on the 
Load Generator machine. 

Scenario 2

➤ You changed the system user for all servers and hosts in the Performance 
Center environment.

➤ You added the changed user manually to the Load Generator machine.

➤ The default Performance Center system user, IUSR_METRO, exists on the 
Load Generator machine. 

Feature Availibilty

Sitescope monitoring Works with IUSR_METRO credentials

Default load test monitoring Does not work

Remote management 
(reboot and install patch)

Works with IUSR_METRO credentials (enter 
username and password upon request)

Feature Availibilty

Sitescope monitoring Works with IUSR_METRO credentials

Default load test monitoring Works with changed user credentials

Remote management
(reboot and install patch)

Works with IUSR_METRO credentials (enter 
username and password upon request)



Chapter 33 • Troubleshooting System Identity

317

Scenario 3

➤ You changed the system user for all servers and hosts in the Performance 
Center environment.

➤ You added the changed user manually to Load Generator machine.

➤ You removed the default Performance Center system user, IUSR_METRO, 
from the Load Generator machine. 

Feature Availibilty

Sitescope monitoring Does not work

Default load test monitoring Works with changed user credentials

Remote management

(reboot and install patch)

Does not work

Workaround: Remove service and reinstall 
service with changed user credentials. For 
details, see “Remote Management Agent 
Service Disabled After  Changing System User” 
on page 315.
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34
Troubleshooting Databases

This chapter provides information on troubleshooting problems that occur 
with database in the Performance Center system.

This chapter includes:

 ➤  Login to Oracle Database Server Hangs on page 319

 ➤  Login to Database Server Fails on page 322

 ➤  Database/User Schema Creation Fails on page 324

 ➤  Warning Message Received During MS-QL Database Migration on page 325

 ➤  Conflict Warnings Received During Database Migration on page 325

Login to Oracle Database Server Hangs

Error message: Trying to log on to database server.

Troubleshooting

➤ Option 1 (IIS 5 only): Set the Application Protection level to High (isolated)

Make sure that the Application Protection level is set to High (isolated) in 
the Internet Services Manager in both the Administration Site and User Site. 
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To set the application protection level: 

 1 Select Start > Programs > Administrative Tools > Internet Services Manager. 
The Internet Information Services dialog box opens.

 2 In the Tree directory, expand Default Web Site and right-click Admin. Click 
Properties to open the Admin Properties dialog box.

 3 Click the Virtual Directory tab.
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 4 In the Application Protection box, select High (Isolated).

 5 Repeat steps 2 through 4 for the User Site. In step 2, right-click LoadTest 
instead of Admin.

Option 2: Set the Correct Permissions Level for the IWAM_<SERVER> user

Problems with loggin on might be caused by a permissions level problem 
with the IWAM_<SERVER> user. By default, this account is set to the Guest 
permissions level. However, the IWAM_<SERVER> user must have read/
execute privileges on the Oracle home directory and all of its sub-directories.

To set the correct permissions level: 

 1 In Windows Explorer, right-click the Oracle home directory and select 
Properties.

 2 Click the Security tab.

 3 Click Add and add the IWAM_<SERVER> user.

 4 Check Read & Execute.

 5 Click OK.
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Login to Database Server Fails

Error message: Operation terminated. Error description: Login to the 
database server failed. Check if user name and password are correct.

Troubleshooting

 1 Verify that the database server host name, type, user name, and password 
are correct. Consult your database administrator if you are unsure. 

 2 Check whether you can connect to the database server from the 
Administration Site server using the command line SQL client:

➤ For MS SQL Server:

For example:

If your Microsoft SQL Server is configured with integrated security, make 
sure that the Microsoft SQL Server has an operating system account for 
IUSR_METRO (password: MIOrchid#1), and is allowed access to the 
database. IUSR_METRO is the default account under which the 
HP Performance Center Web server runs.

➤ For Oracle Server:

For example:

If the above command fails, check your TNS entry in the <Oracle 
installation directory>\network\admin\tnsnames.ora file.

% osql –U <username> -P <password> -S <serverID>

% osql –U sa –P manager –S DBSERVER\LRTCDB

% sqlplus <username>/<password>@<connect_string>

% sqlplus system/manager@LRTCORA
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An example of a TNS entry is shown below:

 3 Test the ADODB connectivity to the database  by downloading the 
TcIN_AdoDBTester.exe utility from the HP Software Support site. After you 
log in to the support site, click Knowledge Base, select LoadRunner 
TestCenter, and search for ID39475. 

 a Update the username, password, and server fields in the connection 
string:

➤ For MS SQL Server, use the Provider=SQLOLEDB.1;… connection 
string.

➤ For Oracle Server, use the Provider=MSAORA.1;… connection string.

 b Set a valid SQL statement (based on current database tables).

 c Execute the statement and check the response. If an error occurs, address 
the error message appropriately.

 4 If you are working with Oracle Server, check that Oracle Client is installed 
properly:

 a Check whether the ORACLE_HOME registry entry under 
[HKEY_LOCAL_MACHINE\Software\Oracle] is correct. It should be 
pointing to the Oracle Client installation.

 b Remove SQLPLUS.EXE from the <HP Performance Center installation 
directory>\DB directory.

 5 Verify that the MDAC version is 2.8 SP1. 

LRTCORA =
(DESCRIPTION =
      (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = TCDBSERVER)(PORT 1521))
      )
(CONNECT_DATA =
            (SERVICE_NAME =LRTCORA)
)

)
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 6 Verify that the database or user schema was actually created by checking 
whether the db_results.txt file exists in the %temp% directory of the 
Administration Site server. Note that this file is available only after system 
configuration. In addition, you can check whether the MI_LRDB database or 
user schema exists by logging in to the database/user schema.

Note: If you are able to log on to the User Site after system configuration, 
the database or user schema was most likely created properly.

Database/User Schema Creation Fails

Problem description: You cannot create an HP Performance Center database 
or user schema.

Troubleshooting

Try to create the database or user schema by running the SQL files located in 
the DbSetup directory of the Administration Site server.

➤ For MS SQL Server, run TestCenter.sql to create the database and 
InitDefinitions.sql to initialize the tables.

➤ For Oracle Server, run TC_oracle.sql to create the user schema and 
InitDataOracle.sql to initialize the tables.
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Warning Message Received During MS-QL Database 
Migration

Problem description: The following warning message appears in the log file 
<DB_Migration_directory>\PC_V9_1.log when performing an MS-QL 
database migration:

Troubleshooting

This message is related to a size limit that is related to the Project Options. 
Since this size limit will not be utilized, you can disregard this message.

Conflict Warnings Received During Database Migration

Problem description: The following messages might appear in the log file 
<DB_Migration_directory>\PC_V9_0.log when performing a database 
migration:

Troubleshooting

These messages appear when performing database migration of Performance 
Center 8.14 and earlier. These warnings relate to features that are no longer 
relevant in the current version of Performance Center. You can disregard 
these messages.

Warning: The table 'Companies' has been created but its maximum row size (8227) 
exceeds the maximum number of bytes per row (8060). INSERT or UPDATE of a row in 
this table will fail if the resulting row length exceeds 8060 bytes.

DELETE statement conflicted with COLUMN REFERENCE constraint 
'FK_ResultTransactions_RunPublishedResults'.
The conflict occurred in database 'MI_LRDB', table 'DashboardResultTransactions', 
column 'RunResultId'.

DELETE statement conflicted with COLUMN REFERENCE constraint 
'FK_GoalTransactions_TestGoals'. 
The conflict occurred in database 'MI_LRDB', table 'DashboardGoalTransactions', 
column 'TestGoalId'.
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A
Configuring Performance Center 
System User Manually

This appendix provides instructions for manually configuring the 
Performance Center system user on the Performance Center servers and 
hosts.

Note: Try to configure the Performance Center user using the System 
Identity Utility (see Chapter 6, “Performance Center System User”). Use 
these instructions as a last resort only.

Manual configuration of the Performance Center user on the various servers 
and hosts involves granting the required Performance Center policies, 
updating the Performance Center user, and, for a non-administrative 
Performance Center user, granting the required Performance Center 
permissions. 

Follow all the procedures carefully, noting which procedures are relevant for 
all Performance Center servers and hosts and which for specified machines 
only.

This appendix includes:

 ➤  Required Policies for the Performance Center System User on page 330

 ➤  Performance Center User Configuration on page 331

 ➤  Performance Center User Permissions (Non-Administrative  User Only) 
on page 337
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Required Policies for the Performance Center System User

Note: This section applies to:

➤ An administrative or non-administrative Performance Center user

➤ All Performance Center servers and hosts

Grant the Performance Center user all the required policies as follows:

 Policy Operating System Reason

Act as part of the 
operating system 

 Win2000 For impersonation (required for 
Performance Center system user 
and for the user that runs the 
System Identity Utility)

Create global object Win2000/2003 For Autolab running Vusers on 
the Controller 

Batch logon rights Win2000/2003 The minimum policies required 
to run Web application 

Service logon rights Win2000/2003 The minimum policies required 
to run Web application 

Access this computer 
from the network 

Win2000/2003 The minimum policies required 
to run Web application 

Log on locally Win2000/2003 Required by infra services (for 
instance after reboot it does login 
with Performance Center system 
user) 
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Performance Center User Configuration

Note: This section applies to:

➤ An administrative or non-administrative Performance Center user

➤ All Performance Center servers and hosts

Configuring the Performance Center user includes the following procedures:

➤ “Defining Performance Center User as Admin or Non-Admin User” on 
page 331

➤ “Configuring IIS Settings” on page 332

➤ “Changing Application Pool Identity” on page 334

➤ “Configuring COM Object Identity” on page 336

➤ “Resetting Services” on page 336

Defining Performance Center User as Admin or 
Non-Admin User
The Performance Center system user can have administrative or 
non-administrative permissions. You define what type of user it is by adding 
it to the relevant local user group on the server or host.

To add the Performance Center user to a local user group:

 1 Open the Computer Management (Control Panel > Administrative Tools).

 2 Add the user to the appropriate user group. 

Select System Tools > Local Users and Groups > Users.

➤ If the Performance Center user is to be an administrative user: 

Double-click the Performance Center user, and click the Member of tab. 
If Administrators is not listed, click Add, select Administrators, and click 
OK.
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➤ If the Performance Center user is to be an non-administrative user:

Double-click the Performance Center user, and click the Member of tab. 
Change the Performance Center user to belong only to the Users group.

Windows 2003 only: Add the Performance Center user to the Distributed 
Com Users group.

Configuring IIS Settings
This section applies to the Administration Site and User Site (Web) servers 
only. 

➤ When changing the IIS on the Administration Site server, work in the 
Admin virtual directory.

➤ When changing the IIS on the User Site servers, work in the LoadTest 
virtual directory.

To change the IIS settings:

 1 Open Internet Information Service Manager.

 2 In the relevant virtual directory (Admin or LoadTest as mentioned above), 
change the Anonymous user to the Performance Center user as follows:

 a Under Default Web Site, right-click the relevant virtual directory and 
select Properties.

 b Click the Directory Security tab.

 c Under Anonymous access and authentication control, click Edit.
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 d Select Anonymous access and next to Account used for anonymous 
access, click Edit.

 e Change the user to the Performance Center user.

 f Click OK.

 g Click Apply.

 h In the dialog box that opens, select all the virtual directories to apply the 
Anonymous user to all of them.

 3 Change the Connect As user.

 a For each virtual directory under the top virtual directory (that is, under 
Admin or LoadTest), right-click the directory (for example, \Graphs) and 
select Properties.

 b Next to Network Directory, click Connect As.

Note: This option is available when A share located on another 
computer is selected.
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 c Enter the name and password of the Performance Center user, and click 
OK.

Changing Application Pool Identity

Note: This section is relevant for IIS 6.0 only.

For all Performance Center servers and hosts, you need to change the 
application pool identity to the Performance Center user. The following 
table lists which application pool’s identity to change per server or host:

Performance Center Machine Application Pool

Administration Site server AdminAppPool; PCWSAppPool

User Site (Web) servers DefaultAppPool; PCWSAppPool

File server PCWSAppPool
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To change the application pool identity to the Performance Center user:

 1 Open the Internet Information Services Manager.

 2 Under Application pool, right-click the relevant application pool (see the 
table above) and select Properties. 

Note: For the Administration and User site servers, you need to repeat this 
procedure for both application pools listed.)

 3 In the Identity tab, select Configurable, and enter the user name and 
password of the Performance Center user.

 4 Click OK.

Utility PCWSAppPool

Hosts PCWSAppPool

Performance Center Machine Application Pool
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Configuring COM Object Identity
For all Performance Center servers and hosts, you need to change the 
identity of the COM objects to the Performance Center user.

For all the COM objects listed in the 
<Performance Center installation>\bin\MiDCOM.ini file, configure the 
identity to be the Performance Center user as follows:

 1 Run dcomcnfg.

 2 For each COM object, under Properties > Identity, select This user and enter 
the Performance Center user details.

Resetting Services
This section describes resetting services on the servers and hosts. 

For all Performance Center Servers and Hosts

Reset alagentservice as follows:

➤ Reinstall alagentservice using the following commands:

where username and password are those of the Performance Center user.

For Utility Server Only

Reset TaskManagerService:

 a Run services.msc.

 b In the Services folder, right-click Performance Center TaskManager, and 
click Properties.

 c In the Log On tab, select This Account and enter the Performance Center 
user name and password. 

 d Click OK.

%installation folder%\al_agent\bin\alagentservice.exe -remove 

%installation folder%\al_agent\bin\alagentservice.exe -install username password 
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 e In the Services folder, right-click Performance Center TaskManager 
again, and click Restart.

For Performance Center Hosts Only

Reset magentservice:

➤ Reinstall magentservice using the following commands:

where username and password are those of the Performance Center user.

Performance Center User Permissions (Non-Administrative 
User Only)

Note: This section is relevant when configuring a non-administrative 
Performance Center user only.

When configuring a non-administrative Performance Center system user, 
you need to grant it additional Performance Center permissions.

This section describes:

➤ “Configuring Permissions on the Administration Site  Server” on page 338

➤ “Configuring Permissions on the User Site (Web) Servers” on page 339

➤ “Configuring Permissions on the File Server” on page 342

➤ “Configuring Permissions on the Utility Server” on page 344

➤ “Configuring Permissions on the Performance Center Hosts” on page 347

%installation folder%\launch_service\bin\magentservice.exe -remove 

%installation folder%\launch_service\bin\magentservice.exe -install username 
password
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Configuring Permissions on the Administration Site 
Server
Grant the following permissions to the non-administrative Performance 
Center user on the Administration Site server:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ The Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP
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Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

Configuring Permissions on the User Site (Web) Servers
On the User Site (Web) servers, grant the following permissions to the 
non-administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO



Appendix A • Configuring Performance Center  System User Manually

340

Change permissions of the Crypto key:

 1 Open C:\Documents and Settings\All Users\Application Data\Microsoft\
Crypto\RSA\MachineKeys.

 2 Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties.

 3 Click the Security tab.

 4 Add the Users Group and grant it full control.
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Add permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ The Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP

Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Configuring Permissions on the File Server
On the File server, grant the following permissions to the 
non-administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ The Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP
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Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

Add full access for the Performance Center user to LRFS security:

 1 In the Performance Center installation directory, double-click LRFS and click 
the Sharing tab.

 2 Click Permissions and give the Performance Center user full control.

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Configuring Permissions on the Utility Server
On the Utility server, grant the following permissions to the 
non-administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon
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Change permissions of the Crypto key:

 1 Open C:\Documents and Settings\All Users\Application Data\Microsoft\
Crypto\RSA\MachineKeys.

 2 Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties.

 3 Click the Security tab.

 4 Add the Users Group and grant it full control.
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Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ The Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ %windir%\mercury.ini. If this file does not exist, create it and give the 
user full access.

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP

Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Configuring Permissions on the Performance Center 
Hosts
On the Performance Center hosts, grant the following permissions to the 
non-administrative Performance Center user:

Change registry permissions:

 1 Open the Registry Editor (regedt32).

 2 Give the Performance Center user full access to:

➤ HKEY_LOCAL_MACHINE\Software\Mercury Interactive

➤ HKEY_CLASSES_ROOT\interface

➤ HKLM\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Perflib 

➤ HKLM\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

➤ HKLM\SOFTWARE\Microsoft\Jet\4.0\Engines\Text (used by Analysis).
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Change permissions of the Crypto key:

 1 Open C:\Documents and Settings\All Users\Application Data\Microsoft\
Crypto\RSA\MachineKeys.

 2 Right-click the f9416f003254e6f10da1f9bad8e4c383 file and select 
Properties.

 3 Click the Security tab.

 4 Add the Users Group and grant it full control.
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Add full control permissions to directories and files:

In the File System folder give the Performance Center user and the 
IWAM_Machine user permissions as follows:

➤ Performance Center user. Grant full control of:

➤ The Performance Center directory (C:\Program Files\HP\Performance 
Center) and all sub-directories

➤ %CommonProgramFiles%

➤ %windir%\TEMP

➤ If the systemroot is on an NTFS partition, grant at least Read access to 
files:

➤ %SystemRoot%\System32\Perfc009.dat

➤ %SystemRoot%\System32\Perfh009.dat

➤ C:\Documents and Settings\Default User\Local Settings\Temp

➤ %windir%\wlrun7.ini.

➤ %windir%\wlrun5.ini.

➤ %windir%\mercury.ini.

➤ %windir%\collate.txt.

If a file does not exist, create it and give the user full access.

➤ IWAM_Machine user. After installing Web services, give Read permissions to 
%windir%\TEMP
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Add permissions to run .NET applications:

Add full control permissions for the Performance Center user to all folders 
needed to run .NET applications (Web services, and so on):

In a command line, go to

and run 

%windir%\Microsoft.NET\Framework\v2.0.50727

aspnet_regiis.exe -ga <MachineName>\IUSR_METRO
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Glossary

This document lists terminology that is used throughout HP Performance 
Center.

Administration Site

The Administration Site provides overall resource management and 
technical supervision of the system. The administrator performs 
functions such as assigning user privileges, creating projects, and 
managing resource usage through the Administration Web site.

Agent

See Performance Center Agent.

alert

A notification that HP Performance Center sends to make designated 
users aware of performance issues. Alerts are sent by e-mail.

Analysis

An HP tool for viewing performance analysis data in reports and 
graphs. 

Analysis Integration

Standalone Analysis integrates with Performance Center to let you 
quickly and easily analyze data collected during a Performance Center 
run. Load test data can be analyzed off-line by connecting to 
Performance Center from Standalone Analysis and downloading 
result and session files. After analyzing the data, you can upload the 
session files and reports to Performance Center. 
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authentication

A process that enables access to resources. To authorize access to 
resources, applications first need to authenticate the source of the 
request. Authentication is the process by which the identity of a 
subject is verified, and must be performed in a secure fashion. 
Authentication typically involves the subject demonstrating some 
form of evidence to prove its identity. Such evidence may be a 
password, fingerprint, or signed data using a private key.

Autostart

A feature that starts a load test run automatically. An Autostart test 
automatically begins the run at the start of the timeslot it is associated 
with.

availability

The percentage of time that a business process, monitored 
infrastructure component, or service is up and running.

business process

A series of steps typically performed in applications, which are 
emulated using scripts recorded with HP recording tools and run by 
the HP Performance Center host machines. For example, load 
generators run scripts that describe the activity that is to be monitored 
on the end-user machines. A script consists of transactions—an action 
or a set of actions that you are interested in measuring. By combining 
several transactions, you can define a business process to provide you 
with data for a complete activity.

CA

Certification Authority – A trusted third-party organization or 
company that issues digital certificates used to create digital 
signatures and public-private key pairs.

certificate

A stream of bytes that represent a signed authorization from a trusted 
source that is used to perform an SSL encryption.
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Citrix Agent

An agent installed on the server machine that enhances VuGen’s 
capabilities in identifying Citrix client objects.

Collation

At the conclusion of the test run, the load generators send the results 
back to the Controller. The Controller merges all the load generator 
results into a single package in a process called "collation".

Command Line

Using the Command Line interface, you can pass arguments to 
instruct the Controller how to behave. This enables you to configure 
load test settings without having to manually define them using the 
UI.

Container

A Performance Center object that contains Performance Center 
resources, assets, and other Performance Center containers. 

Controller

A machine that is used to design and manage a load test. During a 
test, the Controller issues instructions to the load generators 
including which scripts to run, how many Vusers to run per script, 
and Start Vuser timing. At the conclusion of the test run, the 
Controller collates the results. There is only one Controller per load 
test.

Dashboard 

The HP Performance Center Project Dashboard provides an overview 
of your project's status, as well as the drill-down capability to view 
individual load test performance. The status and performance data are 
relative to the target criteria you establish for your application.

Data Processor

A Data Processor machine is used for publishing information to the 
Project Dashboard. Although it is possible to set a machine as a 
Controller and a Data Processor, it is not recommended. 
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Database Server

The database server forms the infrastructure for persistent data within 
Performance Center. The database server holds information on users, 
projects, host information, and load tests. 

Diagnostics

Performance Center's diagnostics modules provide monitors that 
trace, time, and troubleshoot individual transactions that rapidly 
identify and pinpoint performance problems in J2EE, .NET, Siebel, 
Oracle, and SAP environments. These monitors help you to maximize 
business process performance, scalability, and efficiency.

EJB

Enterprise JavaBeans™ – A component architecture for the 
development and deployment of object-oriented, distributed, 
enterprise-level applications. Applications written using the Enterprise 
JavaBeans architecture are scalable, transactional, and secure. 

File Server

The file server forms the infrastructure for persistent data within 
Performance Center. The file server holds the test scripts and test 
results.

granularity

Determines how many measurement samples the HP Performance 
Center displays in reports. By default, reports are limited to a 
maximum of 31 samples. Thus, for example, if you select the Day time 
range and the minutes granularity, since there are 1,440 minutes in a 
day and a maximum of 31 samples on a graph, the granularity ranges 
from every 47 minutes (1440/31=46.4, rounded up to 47) to every 59 
minutes (above 59 minutes, you use the hour granularity unit).

Additional examples:

If you select the Day time range and a granularity of every 1 hour, HP 
Performance Center displays the report using 24 samples 
(1 hour x 24 = 1 day).

If you select the Month time range and a granularity of every 1 week, 
HP Performance Center displays the report using 4 samples 
(1 week x 4 = 1 month). 
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GUI Vuser

GUI Vusers operate graphical user interface (GUI) applications. These 
applications can run in a Microsoft Windows environment. Each GUI 
Vuser that you develop emulates a real user by submitting input to, 
and receiving output from, GUI applications. GUI Vusers are created 
using HP’s GUI testing tools: HP WinRunner (for Microsoft Windows 
applications), and HP QuickTest Professional (for Web applications). 
You can run only a single GUI Vuser on a Windows-based load 
generator. Use terminal sessions to run multiply GUI Vusers.

host

A machine which can be used to control or run Vusers, and process 
collected data. Each host machine can be designated as a Controller, 
load generator, or Data Processor.

Host Checkup Service

The Host Checkup Service detects hosts in the resource failure status 
and recovers them (if possible) to the operational status.

Host License

The HP Performance Center license which is automatically installed 
on the hosts as you add them to the system.

ICF

Windows Firewall, previously known as Internet Connection Firewall 
or ICF. See Personal Firewall.

IIS Maintenance Services

IIS Maintenance Services verify that IIS is operational, performs IIS 
memory checks, and restarts IIS in case of memory leakage or if the 
specified memory limit is exceeded.

IIS Restart

Restarts IIS at a set time every day. Restarting IIS increases 
Performance Center stability and is highly recommended. IIS Restart 
does not affect running tests, and users can reconnect to tests and 
view progress.
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INF file

An information file that opens in the Snapshot Viewer, enabling you 
to view a snapshot of an error from the Vuser log. See also SOE file.

Initialization

The state of preparing Vusers and load generators for a load test run 
("Init"). Initializing Vusers before Start Vuser reduces CPU 
consumption and helps provide more realistic results. The length of 
the initialization state varies between Vusers.

IP address

A unique address that identifies a host on a network. It identifies a 
computer as a 32-bit address that is unique across a Transmission 
Control Protocol/Internet Protocol (TCP/IP) network. An IP address is 
usually represented in dotted-decimal notation, which depicts each 
octet (eight bits, or one byte) of an IP address as its decimal value and 
separates each octet with a period. For example, 172.16.255.255.

IP Spoofing

A feature that enables Vusers running on a single machine to be 
identified by many IP addresses. The server and router recognize the 
Vusers as coming from different machines and as a result, the testing 
environment is more realistic. 

J2EE

Java 2 Enterprise Edition – The J2EE platform manages the 
infrastructure and supports the Web services to enable development 
of secure, robust, and interoperable business applications.

J2EE application

Any deployable unit of J2EE functionality. This can be a single module 
or a group of modules packaged into an .ear file with a J2EE 
application deployment descriptor. J2EE applications are typically 
engineered to be distributed across multiple computing tiers.

JBoss

An Open Source, standards-compliant application server 
implemented in 100% pure Java that is based on the J2EE 
specification.
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JDBC

Java Database Connectivity – An industry standard for 
database-independent connectivity between the Java platform and a 
wide range of databases. The JDBC interface provides a call-level API 
for MS SQL-based access.

JNDI

Java Naming and Directory Interface – A standard extension to the 
Java platform, providing Java technology-enabled applications with a 
unified interface to multiple naming and directory services in the 
enterprise. 

JSP

Java Server Page™ – An extension to the Java servlet technology 
developed by Sun.

Layer

A layer is defined as the generic term given to signify J2EE resources 
that can be grouped together for meaningful analysis, and for display 
in the Diagnostics pages. Examples of layers: entity beans, servlets, 
JDBC, and so forth; classes that inherit from a common ancestor; 
components that adhere to a specific API; classes that provide a 
common service; and custom classes with a common significance.

load generator

A machine on which Vusers are run during a load test. There can be 
any number of load generators for a given load test. Load generators 
are configured inside a Host Pool with other load generators and at 
least one Controller.

Load Preview

Displays a graph of the load behavior you defined in the Scheduler. 
See also Scheduler.

measurement

A data unit that measures performance.



Glossary

358

HP Virtual User Generator

A tool for recording virtual user (Vuser) scripts. VuGen creates a Vuser 
script by recording the actions that you perform on a client 
application. When you run the recorded script, the resulting Vuser 
emulates the user activity between the client and server. Vuser scripts 
include functions that measure and record system performance 
during load-testing sessions. During a load test run, you can monitor 
application performance. 

monitor 

A component used by HP Performance Center to collect data.

Monitor Profile

The server resource monitoring settings for a load test that can be 
used by any test in your project. A monitor profile includes the type of 
monitors to run, the servers whose resources you want to monitor, 
and the measurements you want to monitor on each server. 

MI Listener

A component that serves as router between the Controller and the 
Performance Center Agent. The MI Listener receives data from the 
Performance Center Agent at regular intervals. During the course of 
the load test, the Controller solicits the data from the MI Listener to 
process as run-time data. 

Monitor Over Firewall machine

Used to monitor the servers that are located over a firewall. The 
Performance Center Agent runs on the Monitor Over Firewall 
machine and reports its information to the MI Listener either directly 
or through a proxy server, depending on the system configuration.

Monitor Server

The application under test (AUT) server that you are monitoring.
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Net use trust

To monitor the application under test (AUT), you must have a trust 
between the Utility server\Host and the AUT, otherwise you won’t be 
able to take measurements and create a monitor profile. This trust is 
provided by the user supplying an administrator user name and 
password on the AUT.

node

In Dashboard, an entry in a hierarchical tree in the Dashboard, 
representing a group, subgroup, monitor, transaction, and so forth.

Patch

A modification or update to Performance Center that contains bug 
fixes or feature enhancements.

Performance Center Agent

The Performance Center Agent runs on the load generator machines 
and Monitor Over Firewall machines and enables communication 
between the Controller, load generators, Monitor Over Firewall 
machines and MI Listeners (in firewall configurations). The agent 
receives instructions from the Controller to initialize, run, pause, and 
stop Vusers. At the same time, the agent also relays data on the status 
of the Vusers back to the Controller. The Performance Center Agent 
also enables communication between the Controller and terminal 
sessions (if the agent is configured with terminal sessions enabled). 
See also Terminal Session.

Performance Center License

The Performance Center License—a function of your Vuser limit, 
concurrent runs limit, and expiry date—enables you to use the 
Performance Center. You receive the license key when you purchase 
Performance Center, and you enter the license key in the 
Administration Site after installing all Performance Center 
components.
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Personal Firewall 

Windows Firewall, previously known as Internet Connection Firewall 
or ICF, is a built–in basic firewall included as a Windows 2000/
Windows XP networking feature. It is a protective boundary that 
monitors and restricts information that travels between your 
computer and a network or the Internet. Note: HP Performance 
Center supports Windows XP Service Pack 2 provided the firewall is 
turned off (the firewall is turned on by default).

Pop-up Blocker

When you install Windows 2003/XP SP2, Pop-up Blocker is turned on 
in Internet Explorer and set to the medium setting, which blocks most 
automatic pop-ups. If Pop-up Blocker blocks pop-up windows that 
you open deliberately in Performance Center by clicking a link, you 
should turn it off when using Performance Center.

Raw results

The raw results file contains the original raw analysis data which is 
automatically generated by Performance Center during a load test 
run. You cannot delete the raw results file.

Remote Management Agent

The Remote Management Agent enables you to manage remote 
machines from the Administration or User Site (for example, view 
login information, install patches, and reboot hosts/servers). The 
Remote Management Agent is automatically installed when 
performing a Performance Center Server or Host installation.

Rendezvous Points

Rendezvous points instruct Vusers to wait during test execution for 
multiple Vusers to arrive at a certain point, so that they may 
simultaneously perform a task. Rendezvous points are inserted into 
Vuser scripts to emulate heavy user load on the server. 

report

A presentation of data collected by the HP data collectors. HP 
Performance Center reports display a variety of data that enable you 
to track and analyze the performance of monitored applications and 
infrastructure components.
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Run-Time Settings

Settings that enable you to define the way that the script runs, and 
emulate different kinds of user activity. Run-time settings are applied 
to Vusers when a script is run using VuGen or the Controller.

Scheduler

A component that enables you to set the timing aspects of the load 
test run. You can set the start time, the duration of the load test or 
Vuser groups within the load test, and the initialization, start Vuser, 
and stop Vuser times.

script

The actions that a Vuser performs during the load test run are 
described in a Vuser script. An action or a set of actions that you want 
to measure are represented by a transaction. You record and save 
scripts in HP Performance Center recording tools, such as HP Virtual 
User Generator.

session data

Session data is automatically generated by Performance Center and 
displays information and layout settings for the active graphs. You 
can delete or overwrite the session data file.

SiteScope

An HP Performance Center data collector used for collecting 
performance data from network, application, database, and Web 
servers.

SiteScope measurement

A measured SiteScope value. Transaction time, database query time, 
and CPU utilization are all examples of SiteScope measurements.

SiteScope monitor

A set of configurations that enables the collection of data for one 
aspect of the monitored environment (for example, a specific type of 
server). A monitor reports a status of OK, warning, or error, based on 
criteria that you can control.
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Snapshot 

A graphical representation of the Web page, at the point when an 
error occurred during the load test run. If the Vuser log indicates that 
a step has a snapshot, you can view a snapshot of the error from the 
Vuser log, or download the snapshot and view the entire page/
individual frames in the Snapshot Viewer. You can also view an 
individual frame from an active run. See also Snapshot Viewer. 

Snapshot Viewer

The Snapshot Viewer enables you to view snapshot on error pages 
captured from Web Vusers during load test runs. This viewer displays 
snapshots from files of .SOE and .INF extension. The Snapshot Viewer 
can be downloaded from the Download page of the Performance 
Center User Site.

SOE file

A Snapshot On Error (.SOE) file is a GNU-Zipped file containing one 
or more snapshots represented by .INF files. Each snapshot can 
contain several frames and sub-frames, and can be viewed using the 
Snapshot Viewer. 

SSL

Secure Sockets Layer, the leading security protocol that encrypts and 
decrypts a message for online transmission and authentication.

Start Vuser

Settings that define how you start running Vusers within a load test.

Stop Vuser

Settings that define how you stop Vusers within a load test.

System User Account

Performance Center uses the system user to communicate between 
components and activate processes from components on a remote 
machine. The administrator can configure the system user for all 
servers and hosts in the Performance Center environment from the 
General Settings page.
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Terminal Session

A client session on a terminal server. A terminal server client can have 
multiple terminal sessions running simultaneously, thereby 
overcoming the limitation of being able to run only a single GUI 
Vuser on a Windows-based load generator. By opening a terminal 
session for each GUI Vuser, you can run multiple GUI Vusers on the 
same application. You can configure terminal sessions during load test 
configuration or at run time.

Timeslot

A timeslot is used to reserve the hosts and Vusers required to run a 
load test for your application. Reserving a timeslot sets aside resources 
to run a load test.

transaction

Any series of steps that an end user performs in an application, whose 
performance you want to monitor. Transactions are recorded using HP 
Virtual User Generator recording tools and saved in scripts. When 
replayed, transaction response time and availability data is collected. 
You view transaction performance data in HP Performance Center 
reports.

transaction breakdown

A function of HP Performance Center that enables transaction 
response time data to be broken down and viewed according to time 
spent on the network, server, and client.

transaction response time

The time it takes for a prerecorded transaction to be completed.

User Site

The User Site is the window used to design, execute, and monitor load 
tests. The users create tests, reserve resources, run tests, and receive 
analysis information through the User Site.
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User Status

User Status is used to determine user access to Performance Center. A 
user with Active status can log in to Performance Center. A user with 
Non-Active status cannot log in to Performance Center. User Status is 
displayed in the Personal Information and Users page of the Privilege 
Manager.

Utility Server

The Utility server provides a centralized location for specific 
information that can exist only once within the system. The License 
Manager, AutoRun schedules, and Monitor Profiles reside on the 
utility server.

Virtual Load Generator

A Virtual Load Generator is an automatically generated placeholder 
name for an actual load generator that will run the script. When 
creating a load test, you can choose automatic or manual distribution 
of scripts to machines. If you select manual script distribution, you 
choose the actual load generator that you want to assign to each 
virtual load generator at run time.

Virtual User Generator

A tool for recording virtual user (Vuser) scripts. The scripts are run by 
Business Process profiles to emulate end-user experience and monitor 
application performance.

Vusers

Performance Center replaces human users with virtual users or Vusers. 
When you run a load test, Vusers emulate the actions of human users 
working with your application. See also GUI Vuser.

VM

Virtual Machine – A "machine within a machine" that mimics a real 
Java processor, enabling Java bytecode to be executed as actions or 
operating system calls on any processor regardless of the operating 
system. 

Windows Firewall

See Personal Firewall.
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Host Checkup Service 165
host information

managing 45
host pools

adding 84
assigning to projects 78
deleting 87
managing 77, 81

hosts
adding 35
allocating 63
allocating by pool 81
data processor 64
deallocating 131
deleting 69

detaching from test run 131
displaying on Hosts page 28
failure 64
fixing 64
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